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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, 
Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product 
may only be used in accordance with the license agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 5,077,604; 5,267,351; 
5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,568,275; 5,577,190; 5,584,006; 
5,634,020; 5,640,601; 5,644,364; 5,654,737; 5,724,605; 5,726,717; 5,745,637; 5,752,029; 5,754,180; 5,754,851; 5,799,150; 
5,812,216; 5,828,678; 5,842,014; 5,852,435; 5,905,841; 5,929,836; 5,930,445; 5,946,445; 5,986,584; 5,987,501; 6,016,152; 
6,018,337; 6,023,531; 6,058,236; 6,061,758; 6,091,778; 6,105,083; 6,118,444; 6,130,676; 6,134,607; 6,141,691; 6,198,477; 
6,201,531; 6,223,211; 6,249,280; 6,269,195; 6,330,369; 6,353,862; 6,404,435; 6,407,775; 6,426,778; 6,477,271; 6,489,969; 
6,512,522; 6,532,043; 6,546,190; 6,552,731; 6,553,142; 6,570,624; 6,571,255; 6,583,824; 6,618,547; 6,636,869; 6,665,450; 
6,678,461; 6,687,407; 6,704,445; 6,747,705; 6,763,134; 6,766,063; 6,791,556; 6,810,157; 6,813,622; 6,847,373; 6,871,003; 
6,871,161; 6,901,211; 6,907,191; 6,928,187; 7,043,058; 7,081,900; 7,103,231; 7,266,241; 7,280,117; RE40,107; 7,403,561; 
7,433,519; 7,512,885; 7,545,957; 7,671,871; 7,684,096; D352,278; D392,267; D392,268; D392,269; D395,291; D396,853; 
D398,912. Other patents are pending.

Avid products or portions thereof are protected by one or more of the following European Patents: 0506870; 0635188; 
0674414; 0752174; 0857293; 0976108; 0988756; 1068734; 1111910; 1173850; 1629675.  Other patents are pending.

Avid products or portions thereof are protected by one or more of the following United States Patents: 5,267,351; 5,309,528; 
5,355,450; 5,396,594; 5,440,348; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,577,190; 5,584,006; 5,640,601; 5,644,364; 
5,654,737; 5,724,605; 5,726,717; 5,745,637; 5,752,029; 5,754,851; 5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 
5,986,584; 5,999,406; 6,038,573; 6,061,758; 6,069,668; 6,141,007; 6,211,869; 6,532,043; 6,546,190; 6,596,031; 6,636,869; 
6,747,705; 6,763,523; 6,766,357; 6,813,622; 6,847,373; 7,081,900; RE40,107; 7,403,561; 7,433,519; 7,671,871; 7,684,096; 
D352,278; D372,478; D373,778; D392,267; D392,268; D392,269; D395,291; D396,853; D398,912. 
Other patents are pending.

Avid products or portions thereof are protected by one or more of the following European Patents: 0506870; 0635188; 
0674414; 0752174; 1111910; 1629675. Other patents are pending.

This document is protected under copyright law. An authorized licensee of Avid Media ComposerNewsCutterAvid Symphony 
Nitris may reproduce this publication for the licensee’s own use in learning how to use the software. This document may not be 
reproduced or distributed, in whole or in part, for commercial purposes, such as selling copies of this document or providing 
support or educational services to others. This document is supplied as a guide for Avid Media ComposerNewsCutter and 
NewsCutter XPAvid Symphony Nitris. Reasonable care has been taken in preparing the information it contains. However, this 
document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept 
responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change 
without notice.

Copyright © 2010 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING 
THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY 
PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE 
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. 
THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose 
is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of 
the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any 
advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon 
Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.
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IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, 
DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF 
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph 
are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such 
distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the 
University may not be used to endorse or promote products derived from this software without specific prior written 
permission. THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that 
the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to 
distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the 
suitability of this software for any purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this 
entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all 
copies of the supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2006 Nexidia.  All rights reserved.

Manufactured under license from the Georgia Tech Research Corporation, U.S.A. Patent Pending.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.
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The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be 
liable for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or 
operation of reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, 
special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s 
products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates 
has been advised, knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use 
of this software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players 
and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample 
Source Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid 
products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third 
Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in 
connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, 
Assistant Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, 
Avid DNxcel, Avid DNxHD, Avid DS Assist Station, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, 
Avid Mojo, Avid Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, 
Axiom, Beat Detective, Beauty Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Boom, Bruno, C|24, 
CaptureManager, ChromaCurve, ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, 
Command|24, Command|8, Conectiv, Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, Dazzle, 
Dazzle Digital Video Creator, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 003, DigiBase, DigiDelivery, 
Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, 
Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, DPP-1, D-Show, 

http://www.apache.org/
http://jcifs.samba.org/
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DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, EveryPhase, Expander, ExpertRender, 
Fader Pack, Fairchild, Fastbreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko, 
HD Core, HD Process, HDPack, Home-to-Hollywood, HYBRID, HyperControl, HyperSPACE, HyperSPACE HDCAM, 
iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, 
Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, 
Intelli-sat Broadcasting Recording Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, ISIS, IsoSync, iS9, iS18, 
iS23, iS36, ISIS, IsoSync, KeyRig, KeyStudio, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, 
Luna, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, MassivePack, 
Massive Pack Pro, M-Audio, M-Audio Micro, Maxim, Mbox, Media Composer, MediaDock, MediaDock Shuttle, MediaFlow, 
MediaLog, MediaMatch, MediaMix, Media Reader, Media Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, 
MetaSync, MicroTrack, MIDI I/O, Midiman, Mix Rack, MixLab, Moviebox, Moviestar, MultiShell, NaturalMatch, NewsCutter, 
NewsView, Nitris, NL3D, NLP, Nova, NRV-10 interFX, NSDOS, NSWIN, Octane, OMF, OMF Interchange, OMM, OnDVD, 
Open Media Framework, Open Media Management, Ozone, Ozonic, Painterly Effects, Palladium, Personal Q, PET, Pinnacle, 
Pinnacle DistanTV, Pinnacle GenieBox, Pinnacle HomeMusic, Pinnacle MediaSuite, Pinnacle Mobile Media, 
Pinnacle Scorefitter, Pinnacle Studio, Pinnacle Studio MovieBoard, Pinnacle Systems, Pinnacle VideoSpin, Podcast Factory, 
PowerSwap, PRE, ProControl, ProEncode, Profiler, Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, Pro Tools, 
QuickPunch, QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, 
Reprise, Res Rocket Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, 
Scorefitter, ScriptSync, SecureProductionEnvironment, Serv|LT, Serv|GT, Session, Shape-to-Shape, ShuttleCase, Sibelius, 
SIDON, SimulPlay, SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, Solaris, 
SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, 
Strike, Structure, Studiophile, SubCap, Sundance Digital, Sundance, SurroundScope, Symphony, SYNC HD, Synchronic, 
SynchroScope, SYNC I/O, Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, Titansync, Titan, TL Aggro, TL AutoPan, 
TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, 
tools for storytellers, Torq, Torq Xponent, Transfuser, Transit, TransJammer, Trigger Finger, Trillium Lane Labs, TruTouch, 
UnityRAID, Vari-Fi, Velvet, Video the Web Way, VideoRAID, VideoSPACE, VideoSpin, VTEM, Work-N-Play, Xdeck, X-Form, 
Xmon, XPAND!, Xponent, X-Session, and X-Session Pro are either registered trademarks or trademarks of Avid Technology, 
Inc. in the United States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other 
countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other 
countries. All other trademarks contained herein are the property of their respective owners. 

Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
"The Big Swell" — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.
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1 Digital FilmMaking

The oldest, most common, worldwide format in the industry—24-fps film, has been the 
highest resolution master for film production. During the post production process, this film 
reel footage can be scanned to DPX files to preserve the 2K or 4K film resolution, or 
transferred to tape in HD 4:4:4 format.

Modern advances in cinematography, like the digital film cameras from RED® and Arri® , 
are starting to have an impact on the film-creation industry. They allow you to bypass the 
film lab conversion process, and load your footage directly onto your online editing system. 
As a result, films can now be produced digitally from start to end using an all-digital format.

Avid provides an easy and cost-effective way to manipulate high-resolution digital motion 
picture images during the finishing and mastering stages of post production. You can capture 
and edit material directly from file, or perform the offline editing as film-to-tape. Using the 
original high-res media, you can then finish as file-based for the mastering and delivery 
requirements to film (2K+), HD or SD formats.

The following illustration shows the key steps for editing and finishing footage that 
originates either from digital files or from a film reel.

 Avid DS

TELECINE

SCANNER

HD 4:4:4

3 41 ACQUISITION HIGH-RES EFFECTS 
&  FINISHING

OUTPUT & 
DISTRIBUTION

DPX
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CG
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EDITING2
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 MXF 

Link to R3D files

TIF

Avid Unity
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Step 1: Acquisition

If the footage comes from a traditional film reel, it needs to be scanned to DPX files, or 
transferred through Telecine onto tape in a digital HD format. If the footage is already in 
digital file format (originating from digital video cameras, film scanning processes, or CGI 
applications e.g. R3D, ARI, DPX, TIF), the media can be accessed directly by the editing 
system. All source material in digitized form can either be in 2K, 4K, or HD-RGB 4:4:4 
format, which all provide superior image quality.

n This document refers to DPX (Digital Picture eXchange) as it is a common file format used 
to store a single motion picture frame to a file. Other formats such as Cineon are also 
supported.

Step 2: Editing in HD

If you need to work with high-res file formats that cannot be read by Media Composer (such 
as DPX/ARI), start by using Avid MetaFuze to transcode these files into MXF files with an 
HD resolution. MetaFuze merges consecutive single-frame files (with metadata contained as 
part of the format) into an MXF file that can be read by Avid Media Composer®.

Media Composer can link to and output RED footage in HD RGB 4:2:2 or 4:4:4. However, 
if you need to output at a higher resolution, then you should transcode the RED files using 
MetaFuze and do the offline edit using MXF files. When you conform your Media 
Composer sequence in Avid DS, you will be able to link to the original RED footage to do 
the finishing and output.

Step 3: High-Resolution Effects & Finishing

The effects and finishing workflow for high-resolution files can be conducted in either of the 
following ways:

• Doing the offline edit using HD or lower resolution MXF proxies in Avid Media 
Composer, and conforming to Avid DS for finishing and output at high-resolution 
(2K+). To conform in Avid DS, simply import the AFE and connect to the original 
DPX/R3D/TIF files.

or

• Doing all the editing and finishing of the project directly in Avid DS by linking to the 
high-resolution media.

When working with high-resolution media, Avid DS handles the complicated task of 
preserving color settings during the transfer and storage of the media. This is known as color 
management and it is achieved by applying lookup table files (LUTs). For more information 
see “Color Management in Avid DS” on page 121.
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Step 4: Output and Distribution

Universal Mastering in Avid editing applications give you the ability to output the 
film-based sequence to any SD or HD format. In cases where you need a film out, you can 
use Avid DS to easily output to a series of DPX or Cineon™ images (with an appropriate 
LUT) for recording to film.
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2 Film Workflows

When using Avid applications, there are two main ways in which you can work with 
high-resolution media. 

• If you are editing footage that originated on film reel and was transferred to HD tape for 
editing, then refer to “Film Workflows: Editing Footage from Film Reel” on page 15.

• If you are editing high-resolution files generated from digital cameras, film-scanning 
facilities, or CGI applications (e.g. R3D, ARI, DPX, TIF), then refer to “Film 
Workflows: Editing Footage from Digital Files” on page 21.

In addition, you may also want to share media and projects between Avid editing 
applications. If so, make sure that you set up your storage and workstations accordingly.

• If your workstations are sharing projects and media on an Avid Unity, see “Managing 
Shared Storage for Avid Editors” on page 65.

• If your workstations are sharing projects and media in an Avid Interplay environment 
using Avid Unity, then refer to the Avid Editors on Interplay Workflow Guide.

Film Workflows: Editing Footage from Film Reel
When footage is shot on film, it can be digitized in one of two ways. It can be scanned to 
DPX files to preserve the 2K or 4K film resolution, or it can be transferred to tape in HD 
4:4:4 format. Through a telecine transfer to HD digital videotape, Avid editing applications 
capture and store film frames as 24-fps progressive media, or 24p. An important aspect of 
the 24p format is that it lets you output either HD, NTSC or PAL video from the same 
project. Also, since the footage is transferred to videotape, you can retain all the advantages 
of shooting and editing film without incurring the costs of transferring to 2K scans until the 
final finishing and delivery stages.

The scenario below describes how to edit your film projects as efficiently as possible for 
multiple delivery formats. 
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Step 1: Transfer of film to video

The telecine process is the most common practice used for transferring the film dailies to 
videotape. For the offline editing, you may transfer to either SD or HD format. If your final 
delivery is intended for HD or film, it is best to transfer the dailies as 16:9 anamorphic so 
that the conform process will not only be frame-accurate, but also pixel-accurate in the sense 
that the effects will match the same aspect ratio (titles, shapes, etc.). 

During the telecine process, you can take the original sound recordings from the audio tape, 
and synchronize the transfer of both to videotape. For more details on the telecine transfer 
process, see “Transferring Film to Tape” on page 27.

The next phase of the process is to import the film transfer files (FLEx, Evertz, Aaton, ALE) 
into Media Composer project bins and batch capture the footage from the dailies. If the 
audio was not transferred during the telecine process, it can be captured directly from the 
BWF file-based recorder, and synced during the editing process.

Avid 
Media
Composer

Avid DS 

SD/HD/BWF

Avid Pro Tools

ALE

OMFI/AAF

OMFI/AAF2K +

HD RGB 4:4:4

AFE/ALE33

2

1
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Step 2: Retransfer of film to HD video

Once the editing process is complete, you can easily generate a pull list with handles using 
Avid FilmScribe. The pull list provides a concise list of footage to be transferred or scanned, 
thus allowing for an efficient final conform process that minimizes costs in the telecine or 
scanner room. If you are editing on an Avid Media Composer or Symphony, the original 
footage can be transferred to HD format in 4:4:2 YCrCB or RGB 4:4:4. The source 
timecodes and tape name are easily matched using the common denominator which is the 
KeyKode information of the original camera negative. Once the bins are relinked, the 
sequence will point to the newly transferred sources, tape, timecode, etc. From here, the 
video master can easily be output to SD or HD.

Step 3: Retransfer of film to 2K+ files

If you are conforming and finishing on an Avid DS system for HD or film delivery, you can 
scan or telecine the final footage to HD or higher-resolution (2K +) files, and conform the 
offlined sequence into Avid DS using the AFE. 

If you are linking to DPX files, necessary information such as KeyKode (key number) and 
timecode is inserted as metadata into each DPX file during the scanning process. If the DPX 
files do not contain the timecode information, an ALE is required in order to make the 
necessary correspondence to the associated DPX files. The ALE is usually supplied by the 
film-scanning facility or output by MetaFuze or Media Composer.

Final output can be SD, HD or in the case of film out, you can output a series of DPX or 
Cineon images with the proper LUT (look-up table) for the film recorder.

Checklist: Editing Film Reel Footage in Media 
Composer

A 24p or 25p project is one that uses 24p or 25p media, which is created and stored in your 
Avid editing application. In most cases, the source footage is film shot at 23.976 fps, 24 fps 
(for 24p) or 25 fps (for 25p), however new technology is introducing 24p and 25p videotape 
formats, both for cameras and VTRs.

Progressive media is composed of single frames, each of which is vertically scanned as one 
pass. Avid editing applications create 24p media by combining (deinterlacing) two video 
fields into a single full, reconstructed frame. For NTSC film-to-tape transfers, Avid editing 
applications create 24p media by removing the extra fields inserted by the 2:3 pulldown 
process and by creating progressive frames.
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The 25p format is primarily for use in countries where PAL video is standard. When you 
transfer 25-fps film footage to 25-fps PAL video, no modifications are necessary due to 
matching frame rates.

This section outlines the workflows for 24/25-fps film source. Certain steps will have 
differences based on the project format and source footage you are using. Follow these steps 
in the order that they are listed, and return to this checklist each time you complete a step. 

Step Refer to this section

 The telecine process syncs picture and sound to create 
the videotape. The process also creates a shot log that 
will be used during the capture process. 

Transfer the 24-fps film to NTSC or PAL.

“Transferring Film to Tape” on page 27.

 Convert the shot log file with Avid Log Exchange 
(ALE), then import the shot log file into 
Media Composer to create a bin or bins.

 Open a project with the appropriate settings.

n If you are outputting for NTSC HDTV 
broadcast, create a 23.976p SD project.

“Creating a Film-Based Project” on 
page 37.

 Use the ALE to batch capture the footage in an offline 
resolution.

“Selecting a Project Format during 
Capture” on page 39.

 Use the low-res media to edit at 24/25/23.976 fps. “Viewing Video Dailies” on page 35.

“Displaying 24p and 25p Media” on 
page 41.

 If a retransfer is needed, use Avid FilmScribe to 
create an OCN (original camera negative) pull list for 
another telecine process, of the footage used in the 
final edit.

 Perform the offline edit to produce the final sequence. “Editing with High-Resolution Media” 
on page 41.

 (Option) Export an OMFI or AAF file to a Pro Tools 
digital audio workstation to create a final audio mix.

“Transferring Audio Files” in the Help 
for the Media Composer family.

 The telecine process uses the pull list and full 
color-corrected transfer to create HD, NTSC or PAL 
videotape with selects from the original negative 
(picture only). The process also creates a new shot log 
file. Convert the new shot log with ALE and import it 
into the online system.
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 Pack the project information for transfer to the Avid 
Symphony or Avid DS online system. 

 If you will be finishing on an Avid DS system, 
then export an AFE of your final project or 
sequence from Media Composer. (You should 
first make a copy of the sequence, decompose 
it, and then export the bin.) 

“Exporting the AFE File to Avid DS” on 
page 64.

Finishing on Avid Symphony:

 Transfer the project information to the Symphony 
system.

If you are using an Avid Unity shared storage system, 
the project links to the existing media. If you are not 
using Avid Unity, transfer the media for reference.

 (Option) For HD projects being output at 1080p, you 
should open the 24p project and change its format to 
1080p/23.976. 

“Changing the Project Format” on 
page 43.

 Review the offline sequence, then modify the format 
of the sequence to create a new 1080p/23.976 
sequence.

“Changing the Sequence Format” on 
page 44.

 Batch capture in the desired resolution, based on the 
new ALE shot log file. 

 Relink by KeyKode: relink the sequence and clips by 
key numbers (FTFT) and complete any other 
finishing. If necessary, batch capture clips as HD 
media, using an HD resolution.

 Complete any other finishing, using the original 
offline sequence for reference.

 (Option) Import the final audio mix.

 Generate multiple formats. “Selecting a Project Format during 
Output” on page 40.

Step Refer to this section
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Checklist: Editing and Finishing Film Reel Footage 
in Avid DS

The following checklist guides you through the process of editing and finishing 
high-resolution footage from film reels. Follow these steps in the order that they are listed, 
and return to this checklist each time you complete a step. 

Step Refer to this section

 Learn how to set up your workgroup so that you can 
share media between workstations.

“Sharing Media” in the Help for 
Avid DS.

 If you are working with high-resolution media, make 
sure the files reside on a high-capacity storage.

“Placing High-Resolution Media 
on the Storage Device” on 
page 82.

 Make sure that your storage has been configured to have 
read/write access for your high-resolution files.

“Opening the Media Storage 
Configuration Tool outside Avid 
DS” on page 83.

 Open a new film or HD project. “Creating a Film-Based Project” 
on page 37.

 If you are conforming a sequence from Avid Media 
Composer, then open the AFE or EDL, and link to the 
original high-resolution files.

“Conforming a Film Sequence 
using an AFE” on page 92, or 
“Conforming a Film Sequence 
using an EDL” on page 94.

n If you are using DPX files and they do not contain 
the timecode information, then you will also need 
the ALE (either from the film house, MetaFuze or 
Avid Media Composer) to make the necessary 
correspondence to the associated DPX files.

“Linking to High-Resolution 
Files during the Conform 
Session” on page 98.

 If you are starting your project directly in Avid DS, then 
link to your clips and start building your sequence.

“Linking to High-Resolution 
Files” on page 96.

or

If you are working with media from tape, capture your 
HD 4:4:4 footage into Avid DS.

“Capturing High Resolution 
Media from Tape” on page 103.

 Perform the necessary editing of your sequence using 
low-res proxies of your media.

“Film Proxy Mode” on 
page 112.

 Add special effects and do the necessary color correction. Refer to the appropriate sections 
in the Avid DS Help. 
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Film Workflows: Editing Footage from Digital Files

High-resolution media files could originate from digital film cameras, film-scanning 
facilities, or CGI applications. The files include R3D, ARI, DPX, or TIF. The following 
workflow shows you how to edit and finish projects with footage that is already in digital file 
format. 

If you will be delivering the final master in HD format, you can do all your work in Avid 
Media Composer/Symphony. If you need to output to film, you can do your offline editing in 
Avid Media Composer using HD resolution, and then do the finishing at high-resolution 
with Avid DS.

Step 1: Offline editing with low-res media

If you need to work with high-res file formats that cannot be read by Media Composer (such 
as DPX/ARI), start by using Avid MetaFuze to transcode these files to a lower SD or HD 
resolution. MetaFuze merges consecutive single-frame files into an MXF file that can be 
read by Avid Media Composer®. (Any metadata originally contained in the file will also be 
included; or for non-metadata formats like TIF, metadata can be added.)

 Process your sequence. Refer to the Processing section 
in the Avid DS Help. 

 Output your final sequence to tape or file. “Outputting Film Sequences” on 
page 114.

Step Refer to this section
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Media Composer can link to and output RED footage in HD RGB 4:2:2 or 4:4:4. However, 
if you need to output at a higher resolution than HD, you should transcode the RED files 
using MetaFuze and do the offline edit using MXF files. When you conform your Media 
Composer sequence in Avid DS, you will be able to link to the original RED footage to do 
the finishing and output.

n MetaFuze also reads other file types supported third-party parsers.

Step 2: Edit sequence by linking to HD or high-res media

Link directly to your source media (such as RED) to edit your sequence on an Avid Media 
Composer. From here, you can output directly to HD or SD. If you are doing the offline in 
Media Composer and need to finish in Symphony or Avid DS, export the sequence as an 
AFE. 

Step 3: Conform AFE for high-res finishing in Avid DS

On Avid DS, you can conform the AFE and connect to the original DPX/R3D/TIF files.

In the case of DPX files, necessary information such as KeyKode™ (key number) and 
timecode is inserted as metadata into the DPX file during the scanning process. If the DPX 
files do not contain the timecode information, an ALE is required to make the necessary 
correspondence to the associated DPX files. The ALE is usually supplied by the 
film-scanning facility or output by Avid MetaFuze.

n The transcoded MXF file used in Media Composer is not required for the finishing process 
but it could be imported onto a separate video track in Avid DS and used as part of the 
conform check process.

Depending on your system configuration, many high-resolution formats are playable in real 
time—for a specific list of these formats, see the Avid DS support web at  www.avid.com. 
When editing high-resolution projects where real-time playback is not achievable, you can 
use the proxy mode to apply effects and view the results in HD 4:2:2 or HD 4:4:4.

Step 4: Output to tape or file

In Media Composer, you can output any SD or HD formats as required.

In Avid DS, for a film out, you can output the final sequence to master as a series of DPX or 
Cineon™ images (with an appropriate LUT) for recording to film. 

http://aviddssupport.avid.com/index.htm?section=configurations/ds_10_supported_formats.htm
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Checklist: Editing Digital Film Footage in Media 
Composer

The following checklist explains how to link and edit high-resolution RED media in Media 
Composer. Follow these steps in the order that they are listed, and return to this checklist 
each time you complete a step. 

Step Refer to this section

 Create a project. “Creating a Film-Based Project” on 
page 37.

 Begin editing your sequence. “Editing with High-Resolution Media” 
on page 41

 If you are working with media of varying frame sizes 
in your project, then you need to set the formatting 
options on each clip that is of a different frame size 
than the project.

“Modifying the Reformat Attribute for a 
Clip” on page 47.

 If you are editing with RED media, you can link to the 
files via Avid AMA.

“Working with RED Media” on page 48.

This guide contains general procedures 
on editing RED media. For the full set of 
documentation on using AMA, refer to 
the Help for the Media Composer family.

 Connect your RED drive to your system.

 (Optional) Place your RED media on a shared 
storage device such as Avid Unity.

n To get realtime playback of this media 
from your shared storage, you will 
require a 10GB ethernet connection. 
For a list of performance expectations 
refer to the Readme document for your 
Avid editing application.

“Copying RED Files to a FireWire or 
Network Drive” on page 50.

 Link to the source files. “Linking Media with AMA” on page 50.

 Linking to RED files via AMA is both 
processor and storage intensive. If you require 
better performance, you may want to 
transcode your RED media and work with 
low-res proxies.

“Editing with Low-Res RED Media” on 
page 53.
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The following checklist explains how to edit high-resolution files that cannot be read 
directly by Media Composer.

 You may need to change the color values 
(color balance, exposure, and contrast) on 
your RED media.

“Color Management with RED Media” 
on page 56.

“Adjusting RED Source Settings” on 
page 56.

“Adjusting the Source Settings 
Histogram” on page 61.

 If you need to finish your sequence in another editing 
system such as Symphony or Avid DS, export an AFE 
of your final project or sequence from Media 
Composer. 

If your high-resolution media is on a shared storage 
device where Avid DS also has access, Avid DS 
automatically relinks to the files.

n AMA-linked RED clips are not yet supported 
for the conform and relinking process. Refer to 
the checklist below for an alternate workflow.

“Exporting the AFE File to Avid DS” on 
page 64.

 You should first make a copy of the sequence, 
move it to its own bin, decompose it (with 
handles as desired), select ALL master clips, 
and export as ALE with appropriate columns 
visible in the bin.

n If you are working with high-res files, 
do not use the option to extend handles 
beyond the master clip edges.

 Render the effects in your final sequence. “Step 9: Render Effects as Needed” in 
the Help for the Media Composer family.

If you are using RED media, you should render all 
your clips to the final HD quality that you require for 
output.

“Preparing your RED Clip for 
Transcode, Mixdown, or Render” on 
page 62.

 Output the final sequence. “Selecting a Project Format during 
Output” on page 40.

Step Refer to this section
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Checklist: Editing and Finishing Digital Film 
Footage in Avid DS

The following checklist details all the steps required to edit digital film files in Avid DS. 
Follow these steps in the order that they are listed, and return to this checklist each time you 
complete a step.

Step Refer to this section

 Install and use Avid MetaFuze to transcode your 
high-resolution media into MXF files.

n If you are working with ARRI media, you must 
install the ARRI plug-in on the same system 
where MetaFuze is installed.

Refer to the Avid website for more 
information.

 Open Avid MetaFuze, scan your folders, and 
set the necessary options for transcoding the 
files.

“Scanning your Folders” on page 143 
and “Transcoding your Files” on 
page 145.

 If you have multiple MXF files, export an edit 
list of all these clips via an ALE.

“Exporting an ALE from MetaFuze” on 
page 161.

 Import the MXF file(s) into Avid Media 
Composer.

“Importing MXF Files into Avid Media 
Composer” on page 162.

 Edit the sequence. “Editing with High-Resolution Media” 
on page 41.

 If you need to finish your sequence in another editing 
system such as Symphony or Avid DS, export an AFE 
of your final project or sequence from Media 
Composer. 

“Exporting the AFE File to Avid DS” on 
page 64.

If your high-resolution media is on a shared storage 
device where Avid DS also has access, Avid DS 
automatically relinks to the files.

For the workflow on finishing 
high-resolution files in Avid DS, see 
“Checklist: Editing and Finishing Digital 
Film Footage in Avid DS” on page 25.

 You should first make a copy of the sequence, 
move it to its own bin, decompose it (with 
handles as desired), select ALL master clips, 
and export as ALE with appropriate columns 
visible in the bin.
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Step Refer to this section

 Learn how to set up your workgroup so that you 
can share media between workstations.

“Defining your Storage Areas within the 
Media Indexing Service” on page 83.

 If the footage originated on a film reel, the film 
transfer facility will use the film pull list to scan 
the necessary footage to DPX files.

 Make sure all the high-resolution files reside on 
a high-capacity storage.

“Placing High-Resolution Media on the 
Storage Device” on page 82.

n If you are working with different types of high-resolution media (e.g. R3D, ARI, 
DPX, TIF), make sure that they are each placed in different folders.

 If you are using ARRI media, you must install 
the ARRI plug-in.

“Installing and Configuring the ARRI 
Plug-in” on page 82.

 Make sure that your storage has been configured 
to have read/write access for your 
high-resolution files.

“Opening the Media Storage 
Configuration Tool outside Avid DS” on 
page 83.

 Open a new project for film or HD. “Opening a Film-based Project in Avid 
DS” on page 89.

 If you are starting your project directly in 
Avid DS, build your sequence by linking to your 
clips.

“Linking to High-Resolution Files” on 
page 96.

or

If you are conforming a sequence from Avid 
Media Composer, then open the AFE or EDL.

“Conforming a Film Sequence using an 
AFE” on page 92, or 
“Conforming a Film Sequence using an 
EDL” on page 94.

n If you are linking to DPX files and they do not contain the timecode information, 
then you will also need the ALE (either from the film house, MetaFuze or Avid 
Media Composer) to make the necessary correspondence to the associated DPX 
files.

 Perform the necessary editing of your sequence 
using low-res proxies of your media.

“Film Proxy Mode” on page 112.

 Add special effects and do the necessary color 
correction.

Refer to the appropriate sections in the 
Avid DS Help. 

 Process your sequence. Refer to the Processing section in the 
Avid DS Help. 
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Transferring Film to Tape
You have your film rolls from the day’s shooting, and you’re ready to edit on your Avid 
system. To capture that footage into the system, you first need to transfer the film to 
videotape. This process uses a special film projector called a telecine, which is usually part 
of a production system that includes audiotape recorders, a controller, and other equipment. 
The steps in the process will differ, depending on whether you include audio and whether the 
transfer produces NTSC or PAL videotapes.

This section provides some guidelines to ensure that the film shoot and transfer process is 
well-planned for the Avid editing session.

Film Shoot Specifications

Use the guidelines in the following table to help you plan for film shoots that will be edited 
on an Avid.

 Output your sequence to tape or file. “Outputting Film Sequences” on 
page 114.

Step Refer to this section

Element Supported Formats Notes

Film type 16mm Use Standard 16mm or Super 16mm.
Super 16’s aspect ratio closely matches 16:9.

35mm: 2, 3, 4, 8, and 12 perf

65mm: 5, 8, 10, and 15 perf

16mm, 35mm 4 perf, and 35mm 3 perf are 
supported as projects in the Avid system. The 
remaining formats are supported through ink 
numbers and auxiliary ink numbers. For more 
information, see “Film and 24P Settings” in the 
Help for the Media Composer family.

Film wind B-wind Always use camera rolls with key numbers in 
ascending order.

Audio media BWF file-based recorders Use to record digital audio.

Audio timecodes 30-fps drop-frame or non-drop-frame Use for NTSC transfer projects, and for generating 
audio EDLs.

25-fps timecode Use for PAL transfer projects, and for generating 
audio EDLs in the PAL format.
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Film-to-Tape Transfer Guidelines

Observe the following general guidelines when transferring film to tape:

• Instruct the telecine facility to record timecode on the address track.

• Instruct the facility to use only a telecine transfer process when transferring to NTSC 
videotape. Do not use a film chain or any other transfer device.

• PAL transfers do not require pulldown, so you can use either a telecine or a film chain. 
However, quality is much better on a telecine.

• Transfer all of the project’s source film footage to disk or tape by using either the NTSC 
or PAL method. 

- For NTSC projects, you can mix footage transferred at 24 fps (23.976 fps) or 30 fps 
(29.97 fps), and mix sound transferred at 1.0 or 0.99. Do not mix 24-fps and 30-fps 
transfers on the same transfer tape.

- For PAL projects, you cannot mix audio that has been transferred at 4.1 percent 
speedup (PAL Method 1) with audio that has not been sped up (PAL Method 2).

n PAL film-to-tape transfers that use pulldown are not currently supported in Avid editing 
applications.

Sync methods Clapsticks Use for manual syncing of sound with 
picture.

Electronic slate (smart slate) Use for semiautomatic syncing.

In-camera timecode, with audio sync Use for automatic, “slateless” syncing in the 
telecine.

Slate information Camera roll, scene and take, shoot 
date, sound-roll ID

Mark sound-roll ID as a backup.

Sound-roll cues Sound-roll ID, date, start and end 
time-of-day timecode

Include verbal time-of-day cues as a backup.

Element Supported Formats Notes

Project 
Format Source footage During the telecine process

SD 24 fps To create ITU-R 601 video, the telecine process adds 2:3 
pulldown to film footage to create an NTSC videotape, or uses 
4.1% speedup for PAL videotape.
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Film-to-Tape Transfer Quality Options and Production Aids

The quality of the film-to-tape transfers depends upon several options for the telecine 
transfer. The following table describes common transfer-quality options available from a 
telecine facility:

25 fps The telecine process transfers 25-fps film footage at 1:1 (no 
pulldown).

The sound recording can be synchronized as part of the telecine 
transfer. 

n For NTSC output, this method slows the audio by 4 
percent. If you plan to output to both NTSC and PAL, you 
might want to shoot at 24 fps and use 24p instead of 25p.

23.976 fps The telecine process syncs audio and transfers film footage at 1:1 
(no pulldown). 

HD 24 fps The telecine process transfers 24-fps film footage at 1:1 (no 
pulldown). 

It can also transfer the footage at HD 1080p/23.976 video at 1:1. 
This lets you create the project at 24p and later change it to 1080p 
without having to create a new project and sequence. In addition, 
you can keep both offline SD material and online HD material 
available in the same project.

23.976 fps The telecine process syncs audio and transfers film footage at HD 
1080p/23.976 video at 1:1 (no pulldown). 

25 fps For PAL broadcast, transfer film at 1080p/25, edit offline in a 25p 
PAL project, and edit online in a 1080p/25 project.

Project 
Format Source footage During the telecine process

Option Description

One-light This transfer involves a single setting of color correction values, resulting in the 
simplest, fastest, and least-costly type of transfer. One-light transfers are often 
used during offline stages of editing.

Best-light This transfer involves optimum settings of the color-grade controls, but without 
scene-by-scene color correction. Best-light transfers are an intermediate level in 
terms of both quality and cost.
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You can use the film-tape-film-tape feature to perform two separate telecine processes for a 
project:

• Perform a one-light or best-light transfer to obtain the most material for the initial edits.

• After editing is complete, perform a timed, fully color-corrected transfer of the clips that 
will be used in the final cut.

n For more information on the film-tape-film option, see “Relinking Clips by Key Number” in 
the Help for the Media Composer family.

After you perform the final telecine operation, you can capture at a finishing resolution, such 
as 1:1 (uncompressed).

The transfer facility might have available one or more of the production aids described in the 
following table, which you can include in your film-to-tape transfer:

Timed 
(scene-by-scene)

This transfer involves color correcting each scene or shot during transfer. Timed 
transfers are the most expensive and time consuming. This option sets up the 
proper black and white levels so that you can perform a tape-to-tape color 
correction from the source tapes, if needed.

Option Description

Aid Description

Automatic logging Whenever possible, you should instruct the facility to log tracking information directly 
into a computer database program. Logs generated automatically are more accurate 
than manual logs and can be imported easily into the Avid editing system. A log file 
typically indicates the relative timecode, key numbers, and pullin (“A” frames) for 
each clip that will be captured. 

A keypunch at the head 
of each camera roll

Ask the lab or transfer house to keypunch the head of each camera roll at the zero 
frame and give you a list of the corresponding key numbers. After you have captured, 
you can match this list with your captured material to check for potential transfer 
errors.

Burn-in code If the transfer facility is equipped with a timecode or film-code character generator, 
you can instruct the facility to display or “burn-in” tracking codes on the videotape 
transfer. Burn-in code provides visual feedback for logging and tracking footage.

c Burn-in code cannot be removed from the image and should be used only 
for the offline stage of a project.
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Transfer of 24-fps Film to NTSC Video

For an NTSC transfer, the telecine converts your film footage into video running at 
29.97 fps. The video can then be captured and edited at 24 fps in the Avid editing system. 
This approach ensures that all your edits correspond to true film frames so you see an 
accurate representation of the finished film.

If you transfer sound along with picture, your Avid editing application captures audio at the 
slowed-down speed. Then during editing and playback, your Avid editing application speeds 
up the play rate by 0.1 percent to play in sync with the 24-fps video. Audio plays at 
44100 Hz (44.1 kHz) or 48000 Hz (48 kHz).

Transferring Film to Video

Film runs at 24 fps, and NTSC video runs at 30 fps. The difference in frame rates between 
film and video prevents a direct frame-to-frame transfer. To compensate, the telecine process 
creates an extra six frames every second (the difference between 24 and 30). This method of 
creating extra frames is known as pulldown.

At the same time, the telecine slightly reduces the film’s running speed to 23.976 fps. NTSC 
video, the broadcast standard used in the United States, Japan, and other countries, plays at 
an actual rate of 29.97 fps, although it is usually referred to as 30 fps. An accurate 
conversion requires exact adherence to the 4:5 ratio, but this ratio breaks down when you 
compare 24 fps to 29.97 fps. To achieve a true 4:5 ratio, the film frame rate is slowed down 
to 23.976 fps. The telecine process makes this correction automatically, slowing NTSC 
video 0.1 percent from the original film speed, so that the video plays at 99.9 percent of its 
original speed.

The following table describes the film to video ratio:

16:9 wide screen format Your Avid editing application supports the 16:9 wide-screen display format. You can 
either shoot your footage by using a 16:9 lens, or transfer the footage anamorphically 
to display a larger area of the film aspect ratio during offline and online editing. Also, 
this aspect ratio lets you create media that takes advantage of 16:9 monitors that 
conform to SDTV and HDTV standards.

Aid Description

Film Video

24 fps 30 fps

4 frames 5 frames (10 fields)
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During the capture process, your Avid editing application reverses the pulldown procedure 
to capture the film footage at 24 fps. It removes the extra fields added by the pulldown 
process to create full-frame, 24p media. The capture process captures video and audio at the 
slowed-down speed (0.999).

Maintaining Synchronized Sound

In most cases, the sound for your production has been recorded on a digital audio system, 
such as a BWF file-based recorder. You need to synchronize the sound with the picture and 
make sure they are in sync in your Avid editing application. You can take one of three basic 
paths:

• Transfer the original sound recording to mag track, sync the mag track to the film work 
print, and transfer both to videotape through a telecine process.

• Sync the original sound recordings to picture during the telecine process, and transfer 
both to videotape.

• Transfer only the picture through the telecine process, capture picture and sound 
separately, and sync them in your Avid editing application.

If the telecine transfers sound along with picture (one of the first two paths), the sound 
intended to be slowed down for telecine is usually recorded at 48.048 kHz, so that it ends up 
being 48 kHz.

Transfer of 24-fps Film to PAL Video

If you use a PAL transfer, the film-to-video process takes place in two stages:

• Transfer the film to videotape by speeding up the film rate during the telecine process.

• Capture the transferred videotape into the Avid system at the sped-up rate.

There are two approaches to synchronizing sound, which are often referred to as PAL 
Method 1 and PAL Method 2.

PAL Method 1

With PAL Method 1, you synchronize sound with picture during the telecine process. 

23.976 fps (0.999 x 24) 29.97 fps (0.999 x 30)

Film Video
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As with an NTSC film-to-tape transfer, the telecine process creates two video fields for each 
film frame. However, because the film rate of 24 fps is close to the PAL video rate of 25 fps, 
most PAL film-to-tape transfers involve simply speeding up the frame rate. This speedup 
changes the frame rate from 24 to 25 (an increase of 4.1 percent). There is no pulldown that 
creates extra fields.

n Some PAL film-to-tape transfers use pulldown. This method is not currently supported in 
Avid editing applications.

With PAL Method 1, there are two ways to sync sound with picture in the telecine process:

• Transfer the original sound recording to mag track, sync the mag track to the film work 
print, and transfer both to videotape through a telecine process.

• Sync the original sound recordings to picture during the telecine process, and transfer 
both to videotape.

In either case, the telecine process speeds up sound at the same rate as picture: 4.1 percent.

After you receive the PAL transfer tapes, the next step is capturing the footage in a 24p PAL 
project. During the capturing process, your Avid editing application captures the material at 
the PAL rate of 25 fps, capturing every picture frame. It stores the two video fields as a 
single progressive frame, which you edit at 24 fps.

n You must capture audio along with video at the PAL rate of 25 fps if you want to use audio 
that was transferred along with picture during the telecine process. You set the Audio 
Transfer rate as Video Rate (100+%) in the New Project dialog box. For more information, 
see “Audio Transfer Options for 24p PAL Projects” on page 34.

You have the option of playing back the footage at 24 fps or 25 fps. If you select 24 fps, the 
system slows both the picture and the sound by 4.1 percent for playback. This approach lets 
you edit at the original film rate, but the slowdown creates a limitation for audio. Because 
you capture the audio at a rate faster than playback, some audio samples are duplicated 
during playback, and sound quality is compromised.

n Select the Edit Play Rate option in the Film and 24p Settings dialog box. For more 
information, see “Film and 24P Settings” in the Help for the Media Composer family.

If you select 25 fps, there is a different limitation with audio. Because you are playing back 
at the sped-up rate (4.1 percent), the audio pitch rises slightly. This is usually acceptable for 
broadcast, so PAL Method 1 is primarily used for PAL television broadcast.
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PAL Method 2

With PAL Method 2, you capture sound and picture separately using the same telecine 
process for picture (create a video frame of two fields for each film frame, speed up rate by 
4.1 percent). The difference is that you do not synchronize sound as part of the telecine 
process..

n Some PAL film-to-tape transfers use pulldown. This method is not currently supported in 
Avid editing applications.

Here’s an example where you have your picture-only videotapes (at the rate of 25 fps) and 
your source recording tapes. To capture at 24 fps, you need to follow a two-step process:

1. Capture the picture to create 24p media.

2. Capture the sound at the film rate of 24 fps. 

n When you created the project, you set the Audio Transfer rate as Film Rate (100%) in the 
New Project dialog box. For more information, see “Audio Transfer Options for 24p PAL 
Projects” on page 34.

In most cases, you will choose to edit at 24 fps. The sound maintains source quality 
(44.1 kHz and 48 kHz) and plays in sync with 24-fps video.

Audio Transfer Options for 24p PAL Projects

When you create a 24p PAL project, you must specify the appropriate audio transfer rate for 
the project. (This is not necessary for a 25p PAL project because there is no film speedup 
during the transfer.) The New Project dialog box provides Audio Transfer options that lets 
you select either Film Rate or Video Rate. This value is project specific and should not be 
changed after you create the project unless you have a specific element that you need to 
transfer at a different rate.

n The Audio Transfer options are also located in the Film and 24p Settings dialog box and can 
be changed after the project is created. 

n The Info tab in the Project window lets you view the audio transfer rate you selected when 
you created the project. The actual audio transfer rate might be different from the display if 
you used the Film and 24p Settings dialog box to change the audio transfer rate.

The following table describes the Audio Transfer options:
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Viewing Video Dailies

The video dailies method relies on videotape transfers from negative for screening, 
transferring, and creating conformed cuts during editing. 

The advantage of working with video dailies and film negative is that you can avoid the cost 
of work print until the finishing stages, or altogether. The disadvantage is you are limited to 
the aspect ratio, resolution, and contrast range of video previews. For this reason, video 
dailies are preferred for television projects, but you can also use this method to economize 
on a feature film production.

The illustration below describes the video dailies method:

Option Description

Film Rate (100%) Select this option when your 24-fps film footage has been transferred 
MOS (roughly translated as “without sound”) to 25 fps by speeding up the 
film, and the audio comes in separately at 100 percent of the actual speed 
(PAL Method 2).

Video Rate (100%+) Select this option when your 24-fps film footage has been transferred to 
25 fps by speeding up the film, and the audio is synchronized to the video 
picture. This means that the audio speed is increased by 4.1 percent (PAL 
Method 1).
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....................

....................

EDL

2

6

5

1

4

Description

1 Prepare film negative for the circled (selected) takes.

2 Transfer reels of negative synced to audio in telecine. Generate a simultaneous online transfer, or 
create the online transfer from selects after editing the sequence.

3 Screen the videotape dailies before telecine transfer.

4 Import existing key numbers and timecode information into the Avid system, then capture.

You can manually add or change key numbers in the KN Start bin column and manually add 
timecodes in the Aux TC and Sound TC bin columns.

5 Edit using the Avid system.
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Creating a Film-Based Project
When you create a project that uses footage coming either from film reel or high-resolution 
digital files (2K+), the options that you choose for your project should be determined by:

• The acquisition format (high-res digital files, 16mm or 35 mm film, HD video)

• The audio rate (film speed of 48 kHz, or video speed of 48.048 kHz)

• The finishing and output requirements of the project

To create a new film-based project:

1. Start your Avid editing application.

2. In the Select Project dialog box, select the folder in which you want to create the 
project: Private, Shared, or External. 

3. Click New Project.

4. Type the name of your new project in the text box.

5. Click the Format menu and select the most appropriate project type. The format you 
choose must take into consideration both the frame rate at which the film was shot, as 
well as the final delivery format for the production.

6 Record a digital cut to preview the sequence with effects, or generate EDLs for editing the 
videotape transfers. Alternatively, generate a matchback list of selects for printing selects and 
conforming negative.

Description (Continued)

Format Source Output

24p NTSC Film-based or other 24-fps footage transferred to Standard 
Definition NTSC videotape.

Film, 
HD Broadcast, 
Video

23.976 NTSC Film transferred at 23.976 or footage shot at 23.976. Audio 
remains synchronized with video throughout with no 
conversion required.

HD Broadcast, 
NTSC Video

In addition, chose this option if the production was shot with 
a DV (digital video) camera.

24p PAL Film-based or other 24-fps footage transferred to PAL 
videotape. Ideal for a dual system production.

Film, 
HD Broadcast, 
PAL Broadcast, 
PAL Video
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Further options might change depending on the format that you chose.

6. Select Film if your source material originated on film reel.

This will give you access to film options such as Perf Slip and Film and 24p settings.

7. Set the following additional option(s), where applicable:

25p PAL Film-based material or other 25-fps footage shot at 25 fps 
transferred to PAL video.

Film, 
HD Broadcast 
PAL Broadcast, 
PAL Video

1080p/23.976 High-resolution files coming from digital film cameras such 
as RED, film transferred to HD videotape at 23.976 fps, or 
HD-originated 23.976-fps footage. This is the most 
commonly used HD project in NTSC-based countries.

Film,
HD Broadcast, 
NTSC Broadcast

1080p/24 High-resolution files coming from digital film cameras such 
as RED, or HD-video originated production (shot at 24 fps). 
This format is also used if you’re working on older Avid 
systems that do not support the 23.976 frame rate.

Film, 
HD Broadcast

1080p/25 High-resolution files coming from digital film cameras such 
as RED, or HD-video originated production (shot at 25 fps). 
This is the most commonly used HD project in PAL-based 
countries.

Film,
HD Broadcast, 
PAL Broadcast

1080i/59.94 High-resolution interlaced files (shot at 59.94 fps). HD Broadcast, 
NTSC Broadcast

1080i/50 High-resolution interlaced files (shot at 50 fps). HD Broadcast, 
PAL Broadcast

Format Source Output

Option SD (NTSC/PAL) HD and Film

Aspect Ratio Select either 4:3 or 16:9 Only uses the 16:9 aspect ratio.

The project uses the aspect ratio setting to determine the display setting in the 
monitors, and as a factor in determining whether material requires resizing or 
repositioning in sequences.

Raster 
Dimension

N/A The Raster Dimension menu appears only for 
HD projects on a supported system.

Color Space N/A Select RGB 709 to retain the best color quality 
from the film shoot. 
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8. Click OK.

Your Avid editing application creates the new project files and folder, and then returns to 
the Select Project dialog box. The project name is highlighted in the Projects list. 

9. Double-click the project name in the Projects list to open the project or click OK with 
the project name highlighted.

The Project window, the Composer window, and the Timeline open with the User 
settings loaded. The Project window, the Source/Record monitor, and the Timeline open 
with the User settings loaded. The title bar of the Project window contains the project 
name and the user profile selected in the Select Project dialog box.

10. (Option) If your project uses a film project type, set film preferences immediately after 
you create the project.

For more information, see “Film and 24P Settings” in the Help for the Media Composer 
family.

Before you capture or output film reel footage, refer to the following topics—“Selecting 
a Project Format during Capture” and “Selecting a Project Format during Output” in the 
Help for the Media Composer family.

Selecting a Project Format during Capture

Before you capture film reel footage into your editing system, make sure you select the 
correct project format. The following table explains how the Avid system creates the 
digitized media from your source footage.

Film Gauge Available for 23.976p, 24p, 25p, 720p, and 
1080p film projects. If you are using source 
material originating on film reel, click the Film 
button and select a format for film gauge 
tracking from the Default Film Type menu.

Audio 
Transfer Rate

Available for 24p PAL projects where material 
originated from tape.

Matchback Available for 25i PAL, 30i NTSC, 720p, and 1080i Matchback projects only. If you 
are using source material from film reel, select Matchback, then click the Film button 
and select a format for film gauge tracking from the Default Film Type menu. The 
Matchback item appears only if your Avid editing application includes the Matchback 
option

Option SD (NTSC/PAL) HD and Film
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Selecting a Project Format during Output

Before you output your sequences, make sure you select the correct project format. The 
following table explains how the Avid system handles the digitized media during the output 
process.

Project 
Format

Source 
footage During the capture process

SD 24 fps The Avid system removes the 2:3 pulldown and creates 24p media.

25 fps Use a 25p deck if you need to downconvert HDTV to ITU-R 601 video. 
The deck does not need to add pulldown or speed up the audio since the 
footage will remain at 25 fps. The Avid system creates 25p media.

23.976 fps Use a 24p deck if you need to downconvert HDTV to ITU-R 601 SD 
video. The deck adds 2:3 pulldown for video but maintains audio at 48 
kHz. The Avid system removes both normal (2:3:2:3) and advanced 
(2:3:3:2) pulldown types. It maintains audio at 48 kHz, and creates 
23.976p media.

HD All HD footage is captured in its native format. If you need to 
downconvert HD media to an SD format, then refer to the appropriate 
SD rows above.

Project 
Format

Source 
footage During the output process

SD 24 fps For NTSC and PAL, the system reinserts the pulldown or re-creates 
the speedup.

25 fps For NTSC, the system inserts 2:3 pulldown and slows down the 
audio by 4%. No adjustment is needed for PAL. 

23.976 fps For NTSC video, the Symphony system reinserts pulldown. 

HD 24 fps Creates a 24p EDL for use in an online suite.

25 fps Creates a 25p EDL for use in an online suite.

23.976 fps Creates a 24p EDL for use in an online suite. 

Use the Digital Cut tool to output a 1080p/23.976 master tape. Then 
convert the master tape to 720p/59.94 or 1080i/59.94 for broadcast. 
Optionally, use your Avid editing application to crossconvert to 
720p/59.94 or 1080i/59.94 for preview or reference. The HD VTR 
can also create 1080i/50 for PAL broadcast.
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Editing with High-Resolution Media

Your Avid editing system can work directly with film footage that is already in digital file 
format, such as files from digital video cameras or film scanning processes. In fact, media 
from the RED camera can be linked through your Avid editing application to avoid capturing 
these high-resolution files. Audio is included in the RED files, and will display as .wav files 
in the bin.

n If you need to work with other high-res file formats that cannot be read by Media Composer 
(e.g. DPX/ARI), start by using Avid MetaFuze to convert the files into MXF files at an HD 
resolution, and then import this MXF into your Avid editing application for offline editing.

If you need to conform and finish your sequence on another system, then note that 
AMA-linked RED files are not yet supported for the AFE conform. You should first transcode 
the RED files using Avid MetaFuze and do the offline edit with the MXF media.

When film reel footage is transferred from tape, you can capture it at any SD or HD 
resolution. The resolution at which you capture depends on the hardware capabilities of your 
system and the amount of storage space that you have available for the media. Some Avid 
editing applications let you capture HD-RGB 4:4:4 format, which provides superior quality 
for editing and applying effects. Use the resolution that is optimal for your system, and that 
lets you edit your sequences efficiently during the offline process.

To increase your performance when working with high-res media, you can do the offline edit 
with low-res proxy media. If you are working with RED via AMA, see “Editing with 
Low-Res RED Media” on page 53.

If you are in an Avid Interplay environment, you can edit with compressed media and 
recapture the clips at high resolution for final finishing and output. This can be accomplished 
using the Dynamic Relinking feature. For more information, refer to the Avid Editors on 
Interplay Workflow Guide.

Displaying 24p and 25p Media

This section applies to you only if you are working with Standard Definition (SD) formats.

Film 24 fps For conforming film, it creates a 24p cut list.

25 fps For film, it creates a 25p cut list. 

23.976 fps For conforming film, it creates a 24p cut list. 

Project 
Format

Source 
footage During the output process
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When your Avid editing application captures video that has been transferred from film (or 
video shot at 24 fps), it creates 24p media. It creates this media by capturing the video fields, 
by dropping extra pulldown fields (NTSC transfers only), by combining (deinterlacing) two 
fields for each film frame (A1+A2, B1+B2, and so on), and by storing the fields together as 
a full frame. The system always stores media as a fully reconstructed, progressive frame. It 
is the construction of this full frame that gives you the flexibility to create multiformat 
output. 

You typically use 25p media when capturing film or video shot at 25 fps. In this case, the 
system also stores the media as a fully reconstructed, progressive frame. The difference is 
that there is no need for pulldown fields because there is a 1:1 correspondence between the 
source tape and the captured frames.

Displaying Media While Editing

When you click the Play button while editing a clip or a sequence (sometimes referred to as 
Edit Play), the system separates (interlaces) the progressive frames into fields and does the 
following:

• On the Source, Record, Playback, or pop-up monitor, your Avid editing application 
displays the footage at 23.976 fps, 24 fps, or 25 fps, depending on your project and 
editing preference.

n Choose your preference for playback in the Film and 24p Settings dialog box. For more 
information, see “Filtering the Settings List” in the Help for the Media Composer family.

• On an NTSC monitor, the system does one of two things:

- If playing at 23.976 fps (audio pulldown ON), the system performs a 2:3 pulldown 
that replicates the telecine pulldown, and displays the interlaced media at 29.97 fps. 

- If playing at 24 fps (audio pulldown OFF), the system performs a 2:3 pulldown, 
drops every 1000th frame in the Client monitor, and displays the interlaced media at 
29.97 fps.

• On a PAL monitor, the system does one of two things:

- If playing at 24 fps, the system duplicates two fields per second to display the 
interlaced media at 25 fps.

- If playing at 25 fps, the system performs a 4.1 percent speedup, maintains 1:1 
transfer of film frames to video frames, and displays the interlaced media at 25 fps.

For 25p projects, 25 fps is the only playback rate. The playback rate is 1:1 with no speed 
change.
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Displaying Media During a Digital Cut

The Digital Cut tool lets you output multiple formats at various play rates, all from 24p and 
25p media. When you click the Play Digital Cut button, the system displays the sequence as 
described in “Displaying Media While Editing” above, depending on your selection in the 
Digital Cut tool.

For more information, see “Selecting Output and Timecode Formats for 23.976p, 24p, and 
25p Projects” in the Help for the Media Composer family.

Changing the Project Format

Changing formats is especially useful if you are working with downconverted HD material 
in an offline-to-online workflow. Each HD format has an equivalent SD format that you can 
use for offline editing. 

For details, see “Offline Formats for HD” in the Help for the Media Composer family.

The Format tab in the Project window lets you change the format of the project to another 
format that shares the same frame rate. On systems with supported Avid input/output 
hardware, you can also change the raster dimension to improve performance as you edit HD 
projects.
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When you change the project format, the following changes take place:

• The hardware changes to support input and output for the new project.

• The available resolutions and, for some configurations, raster dimensions change to 
those of the new project.

• Any new sequences you create use the format of the new project.

If necessary, you can then modify the format of an existing sequence, see “Changing the 
Sequence Format” on page 44.

To change the project format:

1. Click the Format tab on the Project window.

2. Select the corresponding format for your workflow.

n You can select only projects with the same edit rate.

3. If available, click the Raster Dimension menu and select a raster size.

For information on raster types and raster sizes, see “Raster Dimensions” in the Help for 
the Media Composer family.

Changing the Sequence Format

When your Avid editing application creates a sequence, it uses the format of the current 
project.

You may not always need to change the edit rate of the sequence. For example, you can 
change an NTSC 30i sequence to 1080i/59.94 or to 720p/59.94. In other cases, you do 
change the edit rate, and the modified sequence uses motion adapter effects and contains 
other adjustments necessary to allow the sequence to play at the new edit rate.

n There are special workflows for converting a 23.976p NTSC sequences. See “Converting a 
24p NTSC Sequence to 1080p/23.976” on page 45 and “Converting a 23.976p NTSC 
Sequence to 720p/23.976” on page 46.

To modify the format of a sequence:

1. (Option) Duplicate the sequence. 

2. Select the sequence you want to modify.

3. Select Clip > Modify.

4. Select Set Format from the top list. 

5. Select the format to which you want to convert from the Format menu.

6. Click OK.
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A message box tells you whether the sequence has been duplicated or modified.

Your Avid editing application changes the format of the sequence. In cases where 
timecode needs to be converted, your Avid editing application creates a new sequence 
and unlinks the media. No media is converted. For more information, see 
“Understanding Options for Modifying the Sequence Format” in the Help for the Media 
Composer family. 

You can check the format of the sequence in the Format column of the bin. This column 
displays the format of a clip or sequence as determined by the project type, such as 30i 
NTSC or 1080i/59.94. This is especially useful if you have both SD and HD clips in the 
same bin.

Format column in the bin

Converting a 24p NTSC Sequence to 1080p/23.976

The most efficient offline format for a project that needs to be delivered as 1080p/23.976 is 
23.976p (NTSC). In some cases, however, you might need to edit the offline sequence at 
24 fps — for example, if the offline system does not support 23.976p NTSC projects. To 
convert a 24p NTSC sequence to 1080p/23.976p, you need to take an intermediate step and 
first convert it to 23.976p NTSC.

Several limitations apply to this conversion:

• Audio captured without pulldown (60 Hz) needs to be recaptured with pulldown (NTSC 
reference at 59.94 Hz).

• Media for the new 23.976p sequences and clips is offline. Sequences and clips cannot be 
linked to the original 24p media.

• You need to batch capture and import media. In most cases, you would do this after 
converting the sequence to 1080p/23.976.

The last two limitations also apply to other sequence conversions that create new sequences.
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To convert a 24p NTSC sequence to 1080p/23.976:

1. On the HD online system, open a 1080p/23.976p project or create a new one.

2. Switch the project format to 23.976p NTSC. 

3. Open the bin that contains the original 24p sequence and select the sequence.

4. Select Clip > Modify.

5. Select Set Format from the top list and select 23.976 NTSC from the Format menu.

6. Click OK.

Your Avid editing application creates a new sequence labeled with the extension 
23.976 fps.

7. Switch the project format back to 1080p/23.976p project.

8. Select the new 23.976p sequence.

9. Select Clip > Modify.

10. Select Set Format from the top list and select 1080p/23.976 from the Format menu.

11. Click OK.

12. Batch capture, import graphics, and finish the sequence.

Converting a 23.976p NTSC Sequence to 720p/23.976

Because the source edit rates are different for these formats, you cannot simply change the 
project and sequence format. The following sequence is based on source material shot or 
transferred to 720p/23.976 and edited offline in a 23.976p NTSC project.

To convert a 23.976p NTSC sequence to 720p/23.976:

1. In the 23.976p NTSC project, duplicate the final sequence and move it to a new bin.

2. Decompose the sequence.

3. Select the master clips and export them as a shot log file.

4. Create a 720p/23.976p HD project.

5. Import the shot log file into a bin.

6. Batch capture the clips.

7. Open the SD bin containing the duplicated sequence.

8. Relink the SD sequence to the new HD clips.
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Editing at 60 fps

The project type 720p/59.94 uses a screen resolution of 1280 x 720 at a frame rate of 
60 frames per second. Editing at 60 fps is similar to editing at 24 fps because both 
resolutions are progressive — they use full frames instead of interlaced fields. Note the 
following:

• Single-frame step commands move at 1/60th of a second. Single-field step commands 
are deactivated; if you click a button, your Avid editing application beeps.

• Draft Quality plays back at 30 fps. Full Quality plays back at 60 fps.

• You can mark IN and OUT points at 1/60th of a second increments.

• You can trim at 1/60th of a second increments.

• Transition effects default to one-second duration (60 frames).

• Deck control for capture and digital cut is limited to 30 fps. A message box warns you if 
you try to mark an odd timecode value (such as 01:00:00:03). 

n 1080i/50 and 1080i/59.94 are interlaced resolutions that you edit at 25 frames per second 
and 30 frames per second. 

Modifying the Reformat Attribute for a Clip
Your Avid editing application uses the Reformat attribute of a clip to resize and reposition 
the clip so that it conforms to the current frame size and aspect ratio specified in the Project 
Settings. When you create a clip or subclip, the Reformat attribute is automatically set to 
Stretch. If you are using AMA to link to clips, then the default is set to Center Keep Size.

For a list of these options, see “Reformatting Options Reference” in the Help for the Media 
Composer family.

n If you are working in an Interplay environment, do not change the Reformat attribute from 
the Stretch setting. If you use a different setting, and you then use Interplay Transcode or 
Send to Playback, the results might not be what you expect.

The illustration shows the Reformat bin column and the menu that lets you choose a 
Reformatting Option.
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Changes you make to the Reformat attribute apply only to the selected clip in the bin. You 
can have several subclips derived from the same master clip, and set different Reformatting 
Options on each of them.

When you change the Reformat attribute of a clip, it updates if it is loaded in a Source or 
pop-up monitor, and new edits into a sequence using this clip use the new Reformatting 
Option. However, previous edits using this clip continue to use the old value. If you want to 
update a sequence so that all versions of this clip in a sequence use the current Reformat 
attribute, refresh the Reformatting Options for the sequence. For more information, see 
Refreshing Sequences to Use Current Clip Attributes in the Help for the Media Composer 
family.

To set the Reformat value for an individual clip or subclip:

1. Open the bin containing the clip or subclip you want to modify.

For more information, see Opening and Closing Bins in the Help for the Media 
Composer family.

2. Click the Text tab.

3. (Option) If it is not already visible, display the Reformat bin heading.

For more information, see Using Text View in the Help for the Media Composer family.

4. Click the Reformat field for the clip or sub-clip, and select an option.

Options apply only to clips that do not match the frame size and aspect ratio of the 
project.

For more information, see Reformatting Options Reference in the Help for the Media 
Composer family.

Working with RED Media

Avid Media Access (AMA) is a plug-in architecture that allows you to link directly to clips 
on a storage device without importing the media directly on your system. AMA allows you 
to be more productive by browsing and editing directly from the storage device or volume.
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To link to RED media, you need the RED AMA plug-in installed on your system. You must 
also configure the necessary AMA settings as outlined in “The Avid Media Access (AMA)” 
in the Help.

When you link to RED files, the images are scaled to the frame size of the sequence. 
Assuming that you are working in HD sequences, the images will be scaled to HD frame 
size with a choice of color precision as high as RGB 4:4:4. In addition, you have access to all 
the metadata and color values in the raw RED files as well as any other “look” files 
associated with this media (e.g. RLX, RSX, RMD).

Finally, all rendering or transcoding can be done at full HD-RGB quality. Note that linking 
to RED files via AMA is both processor and storage intensive. Refer to “Feature 
Performance” in the Avid Editing Readme for technical requirements on RED editing via 
AMA.

You may begin editing with the linked RED source material immediately. If the project is 
short, the media management needs of the project are not great, the project does not require 
several streams of video and effect to play concurrently, and the CPU and storage is up to the 
task, the offline process can continue using linked media. Otherwise, it’s best to transcode 
the RED files to a format optimized for the offline workflow such as DNxHD 36. See 
“Editing with Low-Res RED Media” on page 53.

n Important: If you intend to finish on Avid DS at higher-than-HD resolution, then note that 
AMA-linked RED files are not yet supported during the AFE conform. You should first 
transcode the RED files using Avid MetaFuze and do the offline edit using MXF files. When 
you conform your Media Composer sequence in Avid DS via AFE, you will be able to link to 
the original RED footage to do the finishing and output.

Known Limitations for Linking RED Files via AMA
• Dailies that were created in Avid MetaFuze and REDCINE-X will not relink or conform 

to R3D files via Avid AMA.

• Sequences that were edited and moved to and from REDCINE-X and Avid AMA will 
not relink or conform.

• AFE, EDL or XML files generated for conform of sequences with Avid DS and other 
third-party applications, will not relink on files edited via Avid AMA.

• Refer to the “RED AMA Plug-in” document on the Avid web site for other 
late-breaking information.
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Copying RED Files to a FireWire or Network Drive
After you attach the RED drive or insert a REDFlash card, you can copy the RED media to a 
FireWire drive or a network drive and then disconnect the drive. You might find it 
convenient to copy several cards to other drives so you can reuse the cards quickly. 

You can connect a FireWire drive, for example, and store the contents of several cards on it 
so you can keep using the cards in the camera.

To copy the REDFlash cards to another drive:

1. On the drive, set up a folder for each card or drive you want to copy. 

Avid recommends that you do not place the media folder at the top level of the drive.

2. Give each folder a unique name that identifies the card or drive.

The name does not have to be the same as the actual drive or card name.

3. Navigate to the actual drive or card and select the contents of the folder.

You can select the top directory of several RDC folders (containing an R3D file and a 
color metadata file such as RSX or RMD).

4. Do one of the following: 

t Copy and paste the contents of the folder to the folder on the other drive.

t Click the drive or card folder and drag it to the folder on the other drive.

5. Remove the drive.

Linking Media with AMA

If you link to media which originates on a volume (RED, P2, XDCAM EX, XDCAM, or 
GFCAM), use the File > Link to AMA Volume(s) option. If you link directly to the media 
file clip (QuickTime or MXF), use the File > Link to AMA File(s) option.

n For optimum viewing and playing, Avid recommends a single clip length should not exceed 
more than 12 hours.

n The decompose option from the Clip menu is not available with AMA. You do not need to 
decompose clips when you use the AMA method.

To automatically link clips on a volume using AMA:

1. Connect the drive, or card reader through a USB or FireWire port on your computer.

The system scans the device and links the clips into a bin (based on the AMA settings). 
These clips are highlighted in yellow.
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To manually link clips from another volume using AMA:

1. Select File > Link to AMA Volumes.

The Browse For Folder dialog box opens.

2. Navigate to the P2, XDCAM, RED or GFCAM clips, and then click OK. 

For P2, navigate one level above the Contents folder. For XDCAM disks, navigate to 
one level above the Clip folder. For XDCAM EX, navigate to one level above the BPAV 
folder. For RED, navigate to the root directory of the RED card. For GFCAM, navigate 
to the root directory of the GFPAK.

Depending if you are using an existing bin or creating a new bin, the Bin Selection 
dialog box opens. 

3. Select Bin Selection options. 

n If you relink a sequence and the bin that stores the AMA referenced clips is closed, the media 
does not relink. Before you relink, open the bin of the referenced clips.

Option Description

Single Bin Based On Selected Folder Places all linked clips into one default bin.

Single Bin Named Lets you create a new bin and type in a new bin name. 
Places all linked clips into that bin.

Bin(s) Based on Current AMA 
Setting

Places the clips in the bin(s) you set up in the AMA 
Settings Bins tab.

Bin(s) Based on Subfolders Places the clips in bin(s) based on their subfolders.

Top Bin Window Places the clips in the active bin.
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4. Click OK.

The clips appear in the bin or bins depending on the options you selected, they highlight 
in yellow.

To manually link clips from a file with AMA:

1. Select File > Link to AMA File(s).

You can also right-click a bin and select Link to AMA File(s).

n The system ignores the settings you have selected in the AMA Volume Mounting settings.

2. If there is no active bin, a dialog box appears asking you to select a bin.

The Select file(s) for AMA linking dialog box opens.

3. From the AMA Plugin Filter menu, select the type of file.

4. Select the file(s) you want to link. Ctrl+click or Shift+click to select multiple files.

5. Click Open.

The clips appear in the active bin, they highlight in yellow.

If the system cannot link a file, an error message displays informing you to open the 
Console window for more information about the file(s) in error.

If you move the clip from the original drive to another drive on your system, the clip 
displays as offline in your bin.

n If you move a source file from one location to another and then back to the original location, 
you might need to refresh the bin to redisplay the clip. Close and reopen the bin to refresh 
the bin.

Option Description

All AMA Plugins Files Searches and displays all files.

QuickTime Searches and displays only QuickTime files.

MXF Searches and displays only MXF files.

RED R3D Searches and displays only RED files.
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Editing with Low-Res RED Media

AMA offers the advantage of allowing you to transcode material to a lower resolution at any 
stage of the process. At a logical break in the process, such as at the end of the work day, or 
after the rough cut is complete, you simply select AMA-linked clips in the bin and choose 
the ones that need transcoding.

Transcoding to DNxHD 36 is an acceptable quality for editing your sequences. However, if 
you plan on doing finishing work to your sequence, it's advisable to transcode your final 
sequence to DNxHD 145, DNxHD 220, or DNxHD 220x. 

To transcode your RED Media:

1. Create a rough cut of your sequence by linking to the RED clips via AMA.

2. When you are ready to transcode, you can speed up the transcode process by setting a 
lower R3D Source Quality Setting. Select Tools > Media Creation. 

3. Select the Mixdown & Transcode tab of the Media Creation setting.

4. Set the video playback quality from the R3D Source Quality (Debayer) menu to Quarter 
or Eighth. For many offline workflows this is an acceptable quality when transcoding to 
DNxHD 36.

5. Click OK.

6. Transcode your clip or sequence as required.

For more details, see “Using the Transcode Command” in the Help.

7. After the transcode process is complete, new master clips are created in the bin that 
point to the transcoded media.

If you transcoded a clip from within a sequence, the new master clip is automatically 
used in your sequence.

If you transcoded an entire sequence, you have the option of creating a new sequence 
which will use the newly created master clips. If you do not choose to create a new 
sequence, then the existing clips in your sequence will be replaced with the new master 
clips.

n At this point, you can take your original media offline by unmounting the AMA folder 
containing the source RED media. Select File > Unmount.
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To relink to the original media:

1. After the editing process is complete and you are ready to relink to the original media, 
make sure that your original RED media is online. If you un-mounted your RED 
volume, remount it. 

2. In the bin, select the completed offline sequence, and all the original RED master clips. 
The master clips need to be selected so that the original linked path can be restablished.

To alleviate space on your storage, you may delete previously-transcoded media. If you 
do this, then you do not need to also select the original RED master clips. If the relink 
mechanism does not find any other media online, it will automatically revert to the 
originally-linked media.

3. Select Relink from the clip menu, and set the following settings in the Relink window.

a. Choose Relink selected items to: Selected items in ALL open bins.

b. Select Allow relinking of Imported/AMA clips by Source File Name.

c. Select Version Separator, and set the separator to a period (.) .

This may differ depending on how the version is appended to your transcoded clips.
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4. Set any other options as necessary.

5. If you would like to change the any Source Settings to achieve the look or quality to you 
want, you can do so at the clip level, and refresh the sequence to apply the changes at the 
sequence level. 

6. When you are ready for final output, right-click the sequence and transcode to the online 
resolution including handles. This will transcode only the required media.
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Color Management with RED Media

Avid's RED workflow allows you to work with RED .rsx files and .rlx files to manage a 
clip's color. You may also make non-destructive, custom color adjustments to the R3D clip. 
These adjustments can be made at any stage of the process—see “Adjusting RED Source 
Settings” on page 56. 

Color adjustments made after editing has begun will not be automatically applied to 
instances of the source media that have been previously edited into sequences, unless you 
refresh the sequence. For procedures on how to refresh your sequence, see “Refreshing 
Sequences to Use Current Clip Attributes” in the Help.

n Once you start working with offline low-res proxies, any color adjustments you make to the 
transcoded media will not be saved if you decide to link back to the original RED media.

Adjusting RED Source Settings
When you link to R3D (RED) files, the Avid editing system reads each REDCODE RAW 
file directly. You can then change the clip’s color values: color balance, exposure, and 
contrast in the Source Settings window. This color value information is encoded with the 
R3D file through an RLX, RSX or RMD file. These files hold the camera’s original color 
values of your clip. 

n The RLX, RSX or RMD files might be created if you set the color values outside of the Avid 
editing application. These files can be loaded and applied to the associated RED clip 
through the Source Settings window.

When a RED clip displays in the bin, the system displays the metadata columns of the clip’s 
color values. For example: Color Space, Gamma Space, Kelvin, Tint. You can export this 
information to ALE (Avid Log Exchange) and XML (through Avid FilmScribe) for 
downstream use in your workflow.

The Source Settings window also has three color spaces to choose from: REDSpace, Camera 
RGB, and REC.709. You can set up different color options (or presets) in each of these color 
spaces and then apply their color values to multiple clips.

To change the RED source settings:

1. Link the RED clip through the AMA Link to Volume option.

2. Right-click the RED clip in the bin and select Set Source Settings.

The Source Settings dialog box opens. The clip displays in the video area.
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You can choose from the Settings menu to select a camera metadata setting or an RSX, 
RLX or RMD setting (template), or adjust your own custom parameters. This procedure 
details the custom parameters.

3. Drag the video slider to the frame you want to view.

The new frame displays and the histogram updates.

The histogram is a tool that helps you more precisely adjust Source Settings. For more 
information about the histogram, see “Understanding the Source Settings Histogram” in 
the Help for the Media Composer family.

4. Set the appropriate options:

Option Description

Color Space Choose from:
Camera RGB: as close to RAW
REC.709: SMPTE standard color space for HD
REDcolor: newest, more accurate color science from RED
REDSpace (default): based on the camera’s RGB but more saturated
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Gamma Curve Lets you override the gamma curve. Choose from:
REC.709: a REC.709 gamma curve with a linear portion at black and 
a gamma at 2.2 curve
REDLog: maps the 12-bit sensor data on to a 10-bit curve with 
minimal loss
REDSpace: (default) based on REC.709 but with more contrast
REDGamma: gamma curve from RED with a smoother highlight 
rolloff

Kelvin Adjusts the RGB color to compensate for red - blue tinting of the 
scene at different color temperatures of the ambient light while you 
shoot. Common values are 3200 (tungsten) and 5600 (daylight). 
Click and drag the slider from 1700 to 9400. Default is 5600.

Tint Adjusts the RGB color to compensate for yellow - green tinting of 
the scene at different color temperatures of the ambient light while 
you shoot. This is valuable when the ambient light source contains a 
significant amount of yellow or green, such as fluorescent. Click and 
drag the slider from -100 to 100. Default is 0.00.

ISO Allows the ISO level to change from 50 to 2000. Default is 320.

FLUT™ The latest color science developed by RED. Allows you to balance 
your mid-grays in the center of the histogram without pushing 
highlight details over the edge.

Shadow Adjusts the overall black level of the image without affecting the 
white level. Click and drag the slider from 0.00 to 1.00. Default is 
0.00.

DRX Lets you recover potentially lost dynamic range by extending and 
balancing highlights, taking into account the rendering intent of the 
desired Klevin and Tint white balance. Click and drag the slider from 
0.00 to 1.00. Default is 0.00.

Debayer Detail Choose from High (default), Medium, or Low.

Chroma Denoise Choose from Off (default), Minimum, Milder, Mild, Strong, or 
Maximum.

OLPF Controls the optical low-pass filter. Choose from Off (default), Low, 
Medium, or High.

Exposure Allows adjustment to the clip exposure. Click and drag the slider 
from -7.00 to 7.00. Default is 0.00.

Option Description
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5. Click Apply.

The changes apply to your clip. You can continue to make additional changes. 

If the clip is in the Source viewer, the changes are reflected in the Source viewer and in 
the Client monitor (if you have one attached).

If you click Cancel after you click Apply, the Set Source Settings window closes with 
the changes you made.

6. Click OK to save your change and close the window.

The system updates the bin column metadata with the new parameters.

Brightness Adjusts the overall brightness of the image. Lifts blacks without 
affecting the white level. Click and drag the slider from -10.00 to 
10.00. Default is 0.00.

Contrast Adjusts the tonal range of the image, which usually improves 
sharpness and detail. When you increase the Contrast, it increases 
tonal separation between adjacent gray levels but decreases the total 
number of discreet gray levels in the image.
Click and drag the slider from -1.00 to 1.00. Default is 0.00.

Saturation Affects the intensity of the red, green and blue channels. As the value 
increases color saturation increases. As the value decreases, so does 
the color decrease. If the value is set to high, colors might clip. If the 
level is set to 0.00, a monochromatic image with only gray tones 
appear. 
Click and drag the slider from 0.00 to 4.00. Default is 1.00

Red Increases or decreases the camera’s sensitivity to red light by 
amplifying the R channel digital video signal received from the 
sensor. A 0 (zero) no Red is visible, the image has a strong cyan cast. 
Click and drag the slider from 0.00 to 10.00. Default is 1.00.

Green Increases or decreases the camera’s sensitivity to green light by 
amplifying the G channel digital video signal received from the 
sensor. At 0 (zero), no green is visible, the image has a strong 
magenta cast. Click and drag the slider from 0.00 to 10.00. Default is 
1.00.

Blue Increases or decreases the camera’s sensitivity to blue light by 
amplifying the B channel digital video signal received from the 
sensor. At 0 (zero), no blue light is visible, the image has a strong 
yellow cast. Click and drag the slider from 0.00 to 10.00. Default is 
1.00.

Option Description
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n If you make changes in the Source Settings window and then relink the clip through AMA 
again, you still keep all the parameters that you set. 

Applying a Source Setting
To apply a source setting to a RED clip:

1. Right-click a RED clip in the bin (or Shift-click multiple clips), then choose Set Source 
Settings.

The Set Source Settings window opens and your clip displays in the viewer.

2. Select a setting (template) from the Source Settings menu. 

Source Settings vary depending on the files or templates loaded on your system.

3. Click Apply. 

The settings apply to the clip and if the clip is loaded in the Timeline, the video updates 
and displays in a Client monitor (if one is attached) and the Source monitor.

4. Click OK to save your settings and close the window.

The system updates the bin column RED metadata with the parameters.

If you make additional changes after you select a setting, the system creates a Custom 
setting and Custom appears in the Settings list. You cannot make changes to a system 
generated setting, however you can use a system setting and make changes to create 
your own Custom setting.

To import additional source settings:

1. From the Source Settings window, click the Load button.

The Load External Settings window opens.

2. Browse to the Settings file.

Setting Origin

Camera Metadata Settings Default

Default Settings Default

Grade (RSX) Settings RED Alert!

filename RLX Setting RED Alert!

Grade (RMD) Setting REDCINE-X

Custom User created in Avid
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3. Change the filter to display RSX, RLX or RMD files.

4. Select your setting and click OK.

The new source setting appears in the Source Settings menu, and is immediately applied 
to the clip.

Adjusting the Source Settings Histogram

You can adjust the Source Settings Histogram in two ways. You can toggle drawing a 
histogram for an individual color, and you can zoom the vertical axis.

To adjust the Source Settings Histogram:

t Right-click anywhere inside the histogram graph, and then select one of the following 
options.

Option Result

Red
Green
Blue

Enables or disables the histogram display for the selected color. A check mark 
indicates that the histogram for that particular color displays.

Zoom In Zooms in on the lower half of the vertical axis.

Changes the scaling of the vertical axis so that the height is half that of the 
maximum value in the plot. You can zoom in indefinitely to display, for example, 
1/4, 1/8, or 1/16 of the maximum value.

Zoom Out Zooms out of the vertical axis by a factor of two.

Changes the scaling of the vertical axis to be twice that of the maximum value in 
the plot. You can zoom out indefinitely to display, for example, 4, 8, or 16 times 
the height of the maximum value.

Reset Zoom Resets the zoom so that the vertical axis boundary is equal to the maximum value 
in the plot.
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Preparing your RED Clip for Transcode, Mixdown, 
or Render

If you want to take a RED clip and offline it to another application, you can create a different 
resolution RED file, depending on your requirements. This changes the speed and quality of 
the clip, which could affect the playback performance. The higher the video quality the 
slower the process (transcode, mixdown, render). The lower the video quality the faster the 
process. Before you transcode, mixdown or render your clip or sequence, set the appropriate 
quality in the Media Creation dialog box. 

n If you apply any Reformat options (stretch, letterbox, etc.) to your clip, when you perform a 
transcode, the reformatting options will apply.

To prepare your RED clip for transcoding, mixdown or rendering:

1. Before you transcode, mixdown or render, select Tools > Media Creation.

2. Click the Mixdown & Transcode tab or click the Render tab.

3. Select the playback quality from the R3D Source Quality (Debayer) menu. 

t Full 

t Half (Best Quality) 

t Half (Good Quality)

t Quarter

t Eighth 

t Sixteenth

4. Click OK.

5. Transcode, mixdown or render your clip or sequence as required.
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Linking Back to MXF Media on the Avid Offline 
Editing System

You can share MXF master clips captured or generated on Avid DS with other Avid editing 
systems. For HD media, you can share MXF DNxHD media only with other Avid systems 
that support it. To make this media available for use by Avid offline editing systems, you 
need to set up your storage areas accordingly.

To share MXF master clips created on Avid DS, follow this basic workflow:

1. Make sure any storage devices or Avid Unity workspaces are configured correctly.

2. On the Avid DS system:

a. Create a project. In the New Sequence dialog box, select the proper capture settings: 
MXF storages (one for audio and one for video), desired compression, and so on. 
MXF storage can be shared (in an Avid Unity environment) or local (and later 
transferred).

n If you are going to capture audio from a multi-stream file, make sure to select the option 
“Import audio into separate audio tracks” in the New Sequence dialog box.

b. Capture and edit the media.

c. Export an AAF file—see “Outputting a Sequence to Avid Media Composer” in the 
Help for Avid DS.

3. If your media is not on a shared Unity storage, you will need to transfer media to the 
Avid editing system. Do one of the following:

- If you are transferring media over a network, copy the MXF audio storage and the 
MXF video storage to the local drive.

- If you are transferring media on a removable drive, connect the drive. 

4. On the Avid editing system, open a project with a matching frame rate.

5. Import one or more AAF files.

The Avid editing system creates a master clip for each AAF file.

6. Select the new master clips and select Clip > Relink.

The Relink dialog box opens.

7. Deselect the option Relink only to media from the current project, accept the other 
defaults, and click OK.

The master clips are relinked with the MXF media.
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n You can use the Media Tool to create master clips, but this method does not always work, for 
example, when a clip from Avid DS includes alpha.

Media Composer Macintosh systems, and other Macintosh-based Avid editors, cannot use 
MXF media created by Avid DS, due to a 31-character file name limit. This situation occurs 
when an Avid DS system creates a storage on a Unity volume to share with other Avid 
editing systems. This problem does not affect Windows systems.

Exporting the AFE File to Avid DS

Once the edits are completed in the Avid Media Composer, export the sequence as an AFE 
to Avid DS for finishing.

You can import an AFE file into Avid DS v6.0 or later only.

n If you are editing an offline sequence that you want to finish on Avid DS, make sure to 
consult the conform information in the Avid DS documentation, which contains important 
information about the most efficient way of preparing a sequence for the conform process.

To export an AFE from Avid Media Composer to Avid DS:

1. Right-click the sequence and select Send To > Avid DS.

The Send To: Avid DS dialog box opens with the default export template.

2. Optional: Change the file name.

3. Click Set to browse to the driver and folder to which you want to export the sequence, 
and click OK.

4. Select Export Settings 1.

All current settings are displayed in the summary panel below.

5. Click the button after the Export Settings 1, and select Avid DS from the drop-down list.

6. Click the Options button.

 The Export Settings - Avid DS dialog box opens.

7. Select AFE from the Export As drop-down list and click Save.

8. In the Send To: Avid DS dialog box, click OK.



3 Managing Shared Storage for Avid 
Editors

Before you begin working on your projects, you must plan out your storage solutions 
carefully so that you can share media between Avid applications. The topics here provide 
useful information for working with shared bins and projects in Avid Media Composer and 
Symphony.

Avid DS clients require additional configuration of the shared storage and media indexing 
services—see “Setting up Storage and Media for High-Res Projects on Avid DS” on 
page 79.

n For information about sharing bins and projects within an Avid Interplay environment, refer 
to the Avid Editors on Interplay Workflow Guide.

Setting up a Workgroup with Shared Projects and 
Storage

In cases where there is a large need to share projects and media between workstations, the 
media storage can be centralized on an Avid Unity storage. Set up your environment as 
illustrated in the following figure, so that Avid editing systems workstations can access 
media stored on an Avid Unity.
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The Avid Unity storage needs to have a workspace for each editing client. Within the 
workspace, set up separate folders for video and audio, and set the necessary permissions. 
Refer to the documentation that came with the Unity storage.

Avid Media Composer

3

2

Avid DS

1

Avid DS 

Avid DS
Controller

Avid Symphony

Avid Unity

4

Element

1 Avid Media Composer has its own workspace on the Unity.

2 Avid Symphony has its own workspace on the Unity.

3 Each Avid DS client has a workspace on the Unity. The Avid DS Controller indexes 
all DS project and media in an Avid DS workgroup.

4 If Media Composer/Symphony needs to share files with Avid DS, then additional 
workspaces are required for the shared media. The Avid DS Controller indexes these 
workspaces as well.
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Working with Bins and Projects in an Avid Unity 
Environment

Avid Unity MediaNetwork and Avid Unity ISIS let you share bins and projects across the 
network. When you place your bins and projects on Avid Unity workspaces (drive volumes), 
several users can work on the same project at the same time. 

For example, an editor creates sequences in one bin while an assistant recaptures media in 
another bin. At the same time, other users add audio effects or titles to other bins in the 
project.

Each user performs tasks from their own computer. Your Avid editing application provides a 
locking mechanism to help you keep track of who is currently working in a bin. The method 
allows one user to write to a bin; multiple users can read the files in that bin.

c The lock does not prevent you from deleting the media in a locked bin if you have write 
access to the workspace. It ensures only that you do not overwrite changes to the bin. 

In an Avid Unity environment, your Avid editing application creates and stores projects and 
bins on the client’s internal drive. If you move or save these projects and bins to the 
workspace, only one client can work on the project at a time. If two or more users work 
simultaneously on the same project, only one user can update the files. Other users can open 
and play sequences but cannot make any changes to them.

For information on managing workspaces, see the clients’ Quick Start cards. For details on 
Avid Unity, see the Avid Unity MediaNetwork Management Guide or the Avid Unity ISIS 
Administration Guide.

n You can also use an asset manager such as Avid Interplay to collaborate on projects. For 
more details, refer to Working with Avid Interplay from an Avid Editing System in the Help 
for the Media Composer family.
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Sharing Bins and Projects in Avid Unity

Sharing Only Bins

If you share only bins, you store the project on your local system and store bins and media 
files on the shared workspace. This method allows users in a shared environment to share 
only selected bins with other users. The system identifies the shared bins as follows:

• Stores the bin in a Unity Bins folder in the Project window. This folder is similar to the 
Other Bins folder. 

• Displays a second column of information for the bin that identifies the computer that 
currently has the bin locked.

• Uses bold text to identify bins that are locked by another user.

Sharing Both Bins and Projects

If you share bins and projects, you create and store the project folder and bins on the shared 
workspace (or copy an existing project, bins, and the related media files). Your Avid editing 
application identifies information from each computer using the shared workspace as 
follows:

• Creates a project folder for each computer that accesses the project. Your Avid editing 
application adds the computer’s name to the folder name to create a unique name and 
stores any project-specific information in the folder. This prevents users from 
overwriting the project-specific data for other users.

• Displays an extra column in the Project window that identifies the computer that has the 
bin locked. 

• Uses bold text to identify bins that are locked by other users.

• Creates a folder at the top level of the shared workspace called Unity Attic. This folder 
contains backup files for each project on the shared volume.

n Depending on the number of users sharing a workspace, you might want to increase the 
number of files that your Avid editing application stores in the Unity Attic folder.

The following illustration shows the Project window for a shared project.
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Bins tab in the Project window, showing a bin that is locked for editing (bold text, top left), the name of the 
computer that currently has the bin locked (top right), and folders for each computer that accesses the 
project (bottom)

Opening a Shared Project

To open an existing project on the shared volume:

1. Start your Avid editing application.

2. In the Select Project dialog box, navigate to the project on Avid Unity. 

3. Double-click a Bin icon to open one of the bins.

The bin appears with a Bin Lock Status button. You can click the red (locked) or green 
(unlocked) Bin Lock Status button to view a history file that shows which computers 
and users have modified the bin and the date and time of the modifications. 

The Bin Lock Status button. When the button is green (top), the bin is unlocked. When the button is red 
(bottom) the bin is locked.
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When a bin is unlocked, you have permission to make changes. You should not make 
changes to a locked bin. See “Considerations for Working with Shared Bins and 
Projects” on page 71.

n The Bin Lock Status button does not appear if the bin is not on Avid Unity.

Working with Locks and Shared Bins

Your Avid editing application uses a locking mechanism to help you keep track of who is 
currently working in a shared bin. Only one user can write to the bin, but multiple users can 
read the files in the bin.

The user who opens the bin first controls the lock and obtains write access to the bin. Bold 
text in the Project window also identifies bins that are locked by another user. When the 
person who controls the lock closes the bin, it becomes available for another user to open 
and control the lock.

If one user has the lock and another user has the same bin open, when the first user closes the 
bin, the second user must close and reopen the bin to control the lock.

You can instruct your Avid editing application to keep a bin locked even after you close it.

You can click the red or green Bin Lock Status button in the bin to view a history file that 
shows which computers and users have modified the bin.

To open a bin without controlling the lock:

t Alt+double-click (Windows) or Option+double-click (Macintosh) the bin in the Project 
window.

To permanently lock a bin:

1. Select one or more bins in the Project window.

2. Right-click the Bin icon, and select Lock Project Bin. 

An asterisk (Windows) or diamond (Macintosh) appears next to the user name in the 
Project window. In this case, the bin remains locked even after you close it. 

To unlock the bin:

t Right-click the bin in the Project window, and select Unlock Project Bin.

n The Lock Project Bin and Unlock Project Bin commands are also available from the Clip 
menu.
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Considerations for Working with Shared Bins and Projects

Suggestions for Improving Performance When Working with Shared Bins

The following information is provided to improve performance when working with shared 
bins in an Avid Unity environment.

• Do not use the same name for your editing system machine name and your user name. 
Do not use the same name for security objects such as machine names, user names, 
group names, and domain names. If any two security objects have the same name, 
Windows might become confused and sharing might not work properly.

• Do not use the same prefix for machine names in a shared environment. No full name 
can be a prefix of another name. If one of the systems has a machine name that is the full 
name, and others in the environment have the prefix as part of their machine name, 
problems can occur. For example, if an editing system has a machine name ABC and 
additional editing systems in the shared environment have machine names ABCnn, 
ABCxx, the following problems could occur:

- When the system with the machine name ABC is writing to a directory, the systems 
whose machine names have the same prefix (ABCnn and ABCxx) might not be able 
to access the directory.

- When the system with the machine name ABC is rendering, systems whose 
machine names have the same prefix (ABCnn and ABCxx) might be unable to 
launch.

Avid recommends that you do not use a common prefix for machine names. If you 
must use a common prefix, make sure all the names are the same length (ABC01, 
ABC02, ABC03, etc.).

• Do not use Windows Explorer to examine, copy, or manipulate shared bin files or shared 
project folders or their contents when you use those files or folders. If you do, when you 
attempt to access those shared bins or projects you might experience delays 
accompanied by a progress dialog that says, “Filesystem busy, retrying (MESSAGE).” 

If the busy condition persists, a failure message appears. Make sure that you are not 
using Windows Explorer for the shared bins you are trying to access, and then try the 
operation again.

• When you have an environment where more than five users are sharing bins on Avid 
Unity, Avid recommends using an Avid Interplay server in the workgroup environment.

• When an Avid Interplay server is available in an Avid Unity system in the workgroup 
environment, Avid does not recommend sharing bins or projects. Use the Avid Interplay 
server and the Interplay Window to share media. All editing systems in a workgroup 
environment that includes an Avid Interplay server must have the Avid Unity client 
software installed. The Media Tool might become unreliable if an editor in the Avid 
Unity workgroup environment does not have the Avid Unity client software installed.
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Limitations When Working with Shared Bins and Projects

If an editor other than the creator deletes a media file, other editors cannot see that media file 
go offline immediately. If an editor tries to play that file, a “media file not found” message 
might appear in a monitor window, and an access violation error might occur.

Each editing application maintains a PMR file in its machine name folder inside the OMFI 
MediaFiles folder or the Avid MediaFiles folder. The PMR file lists all the online media 
files. Every editing application consults all the PMR files in all the machine name folders to 
find out which media files are online. Whenever a media file is created, its name is 
immediately added to the creating editor application's PMR file, and whenever a media file 
is deleted by its creator, its name is immediately removed from the PMR file.

However, if an editing application other than the creator deletes a media file, the PMR file 
that contains the deleted file is NOT updated immediately. Once the creating editor 
encounters an event that causes its PMR to be updated, then all editing systems know that 
the deleted media file has gone offline.

There are several ways to force an editing application to update its PMR. The simplest is to 
switch to the desktop and back.

Avid recommends that you institute policies where media files are deleted by the editor who 
created them, or if necessary, the deleting editors notify the editor who created the media 
files that a deletion has occurred. This editor can then switch to the desktop and back, and all 
other editors can see the deleted file go offline.

Restrictions and Limitations for Locked Bins

The following restrictions apply to bins that are locked by another user:

• You cannot select a locked bin for operations such as capture, title creation, and import. 
This helps to minimize the problems of modifying a locked bin. 

• You cannot drag an item to a locked bin.

• If you drag an item from a locked bin to a writable bin, the Avid system creates a 
duplicate (not a copy) of the selection in the writable bin. The original item is not 
removed from the locked bin. This operation is the equivalent of duplicating a selection 
and then drag the duplicate to another bin.

• You cannot move a bin that is locked by another user.

• If you modify a locked bin, your Avid editing application does not let you save the bin to 
the same name, but it lets you save the bin to another name. However, this causes 
duplicate bin IDs and might cause system-level conflicts with the contents of the two 
bins. Your Avid editing application sees the duplicate contents of these bins and resolves 
the conflicts by newest modifications. 
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Avoid creating duplicate bins when you modify a locked bin. If you do create a 
duplicate bin, you should manually merge the changes into the original bin and delete 
the duplicate bin. 

c The lock does not prevent you from deleting the media in a locked bin if you have write 
access to the workspace. It ensures only that you don’t overwrite changes to the bin.

Limitation When Using the Shared Bin Lock Icon

Occasionally, when two editors attempt to open a shared bin at the same time, both editors 
get the green lock icon. However, only one editor really has the lock, and that editor's 
machine name appears beside the bin name in both Project windows.

Both editors can modify their copies of the bin, but only the editor that controls the lock, as 
indicated in the Project window, can save that bin. The other editor is warned that the bin is 
locked but is allowed to save a copy of the changed bin.

Avid recommends that you use the “Save Bin Copy As...” button and continue working.

Drive Filtering in Networked Workflows

The Drive Filtering and Indexing tab of the Media Creation Settings dialog box includes 
three options:

• Filter by Resolution

• Filter by System Drive

• Filter by Launch Drive

Depending on the version of your Avid editing system, the drive filtering options could be on 
or off by default. Avid recommends that all drive filtering options should be on by default. 

n Any project brought into a networked workflow that was created with any of the filtering 
selections off might have problems with networked media creation, such as “Audio and/or 
Video Mixdown” and “SendToPlayback,” because their Media Creation Settings are still 
configured for standalone usage.

There are several ways to work around this issue. First, adjust the drive filtering settings 
when you switch environments. You can open the Media Creation Setting and switch the 
drive filtering settings or create multiple Media Creation Settings and switch the active 
setting whenever you shift environments. If you always work in an environment that differs 
from the defaults, you can create a Media Creation setting that fits your workflow and add it 
to your Site Settings so you create new projects with the desired defaults. 
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Creating New Workspaces
Workspaces are locations to store and segregate data. You can allow users to access some or 
all of the Workspaces, and you can assign permissions for how each user can access the data 
in a Workspace.

n If you have created Storage Groups but you have not created any Workspaces, the Create 
Workspace dialog box opens by default when you select the Workspaces list.

To create a new Workspace:

1. From the Management Console home page, do one of the following:

t Click Workspaces in the ISIS Setup icon, located in the System section.

t Click Workspaces in the pop up navigation menu.

The Workspaces tool opens.

2. Click the New button.

The Create Workspace dialog box opens.

3. In the Name text box, type a name for the Workspace.

n For more information about entering text in name fields, see “Entering Text” in the Help for 
Avid Unity.

If there is already a Workspace with the name entered in the Name text box, an error 
message tells you to type a new name.

4. (Option) Click the Protection menu and select the available Workspace protection 
option.

n The protection type available for the Workspace depends upon the protection type specified 
for the Storage Group it is assigned to. For more information on types of protection, see 
“Storage Group Protection” in the Help for Avid Unity.

5. Click the Storage Group menu, and select the Storage Group in which you want to 
create the Workspace.

The Storage Group name appears in the Storage Group text box.

6. Type a size for the Workspace in the Capacity text box. The minimum size (1.0) is listed 
in the Capacity text box, and the maximum size is listed next to the Capacity text box.

If all storage in the Storage Group is allocated to existing Workspaces, you can make an 
existing Workspace smaller. 

7. (Option) In the Warning Event Trigger text box, do one of the following:
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t To set a warning event trigger based on percentage of used storage, type in a 
percentage value and select ‘%’.

t To set a warning event trigger based on gigabytes (GB) of unused storage, type in a 
gigabyte value and select ‘GB’.

8. (Option) In the Error Event Trigger text box, do one of the following:

t To set an error event trigger based on percentage of used storage, type in a 
percentage value and select ‘%’.

t To set an error event trigger based on gigabytes (GB) of unused storage, type in a 
gigabyte value and select ‘GB’.

9. In the User Access area, set the User and User Group access privileges. 

10. Click the Apply button to create a new Workspace containing the selected Storage 
Group and users.

The new Workspace appears in the Workspace dialog box, and the Create Workspace 
dialog box refreshes to allow you to create a new Workspace.

11. (Option) Repeat steps 3–10 to create new Workspaces.

12. Click the Close button to close the Create Workspace dialog box to return to the 
Workspaces tool.

The new Workspace appears in the Workspaces list.

Mounting and Unmounting Workspaces
Your Avid Unity user account must have access to at least one workspace. For information 
on workspace access, see “Creating Client Accounts for Users” in the Avid Unity ISIS 
Administration Guide.

When you have one or more workspaces mounted and the connection to the System Director 
is subsequently lost, a message in the taskbar (for Windows systems) or the dock (for 
Macintosh systems) indicates the workspace is unavailable.

The Client Manager then automatically attempts to reestablish the connection with the 
System Director. When the connection is successfully reestablished, a message in the 
taskbar or dock informs you of the connection state.

To mount an Avid Unity ISIS workspace on your system:

1. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for workspaces that 
are already mounted. You can filter the Workspaces list by Workspace name.

2. Do one of the following:
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t Click (mount) in the Online column for the selected workspace.

t Click to select a workspace, then right-click, and select Mount.

t (Option) Right-click, and select “Mount to drive” from the menu.

n Selecting this option will override the current drive mapping option settings for the selected 
workspace. For more information on drive letter assignments, see “Configuring Workspace 
Drive Letter Assignments” on page 77.

The Client Manager mounts the selected workspace on your client and the Online icon 
for the mounted workspace changes to green. The Workspaces list displays the drive the 
workspace is mounted to. If you use letterless drive mappings, the Workspaces list 
displays “UNC path” next to the Online icon.

3. (Option) If you want the selected workspace remounted the next time you log in, do one 
of the following:

t Click (enable) in the Auto column for the mounted workspace.

t Right-click, and select “Enable auto mount.”

The next time you log in to your client system, the Client Manager automatically 
mounts the selected workspace.

To mount multiple Avid Unity ISIS workspaces on your system:

1. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for workspaces that 
are already mounted. You can filter the Workspaces list by Workspace name.

2. Do one of the following:

t Select multiple non-contiguous workspaces with Control+click.

t Select a range of contiguous workspaces by clicking on the first workspace row in 
the range, then Shift+clicking on the last.

t Select all workspaces by right-clicking in the Workspaces list and selecting “Select 
all”.

t Select all workspaces by pressing Control+A.

3. Right-click, and select Mount.

The Client Manager mounts the selected workspaces on your client and the Online icons 
for the mounted workspaces change to green. The Workspaces list displays the drives 
the workspaces are mounted to. If you use letterless drive mappings, the Workspaces list 
displays “UNC path” next to the Online icons.

4. (Option) If you want the selected workspaces remounted the next time you log in, 
right-click, and select “Enable auto mount”.
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The next time you log in to your client system, the Client Manager will automatically 
mount the selected workspaces.

To unmount an Avid Unity ISIS workspace on your system:

1. Make sure your Avid application is not running.

2. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for workspaces that 
are already mounted. You can filter the Workspaces list by Workspace name.

3. Do one of the following:

t Click the green icon in the Workspaces list to unmount the selected workspace.

t Click to select a workspace, then right-click, and select Unmount.

The Client Manager unmounts the workspace from your client, and the green icon is 
removed from the Online field for this workspace.

To unmount multiple Avid Unity ISIS workspaces on your system:

1. Make sure your Avid application is not running.

2. Open the Client Manager.

The Workspaces list opens. The Online field displays a green ball for workspaces that 
are already mounted. You can filter the Workspaces list by Workspace name.

3. Do one of the following:

t Select multiple non-contiguous workspaces with Control+click.

t Select a range of contiguous workspaces by clicking on the first workspace row in 
the range, then Shift+clicking on the last.

t Select all workspaces by right-clicking in the Workspaces list and selecting “Select 
all”.

t Select all workspaces by pressing Control+A.

4. Right-click, and select Unmount.

The Client Manager unmounts the workspaces from your client, and the green icons are 
removed from the Online field for those workspaces.

Configuring Workspace Drive Letter Assignments

The Client Manager allows you to configure the drive letter used when mounting Avid Unity 
ISIS workspaces. This allows you to prevent workspaces from being assigned drive letters 
you want reserved for other uses.

n The Client Manager skips fixed drives and drive letters that are already in use.
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If your system requires using Universal Naming Convention (UNC) paths for all mounted 
workspaces rather than drive letters, you can use Client Manager to set this as the default 
mapping for workspaces.

To configure the drive letter for mounting workspaces:

1. Open the Client Manager.

The Client Manager opens.

2. Select a workspace from the Workspace list.

3. Right-click the selected workspace, and select “Mount to drive” from the menu.

The Mount To dialog box opens.

4. Click the Choose drive letter menu, and select the drive letter you want to use for 
mounting workspaces.

5. Click OK.

Option Description

UNC (Letterless) Uses a Universal Naming Convention (UNC) path for the 
mounted workspace instead of a drive letter.

Any drive Mounts the workspace to the next available drive letter, working 
backward from drive Z:

Specific drive Mounts the workspace to the selected available drive letter.
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Since film-based media is large, it requires high bandwidth and fast disk access. You must 
ensure that you have storage that is large and fast enough for high throughput so that you can 
play your sequence in realtime. (Typically, 2K data takes up over 1 TB per hour of footage.) 

n The Avid DS Support Center web site provides a complete list of storages supported for 
film-based media, and indicates which types of storage provide realtime capability.

If you need to transfer or share projects and media for offline-to-online production between 
Avid systems, you can set up shared storage with Avid Media Composer. MXF sequences 
offlined on an HD-capable Avid Media Composer can be previewed directly in Avid DS 
using the real-time proxy resolution (film proxy mode).

Before you begin working on your projects, you must plan out your storage solutions 
carefully so that you can share media between Avid applications—see “Sharing Media” in 
the Avid DS Help. 

Checklist: Configuring Avid DS on Avid Unity

Each Avid DS workstation connected to Avid Unity MediaNetwork™ or ISIS requires its 
own workspace. This workspace is then added to the storage configuration in each Avid DS 
workstation. For more information on configuring the workspaces and setting permissions 
on the Avid Unity, refer to your Avid Unity documentation.

n A different configuration is required if you are working within an Avid Interplay 
environment—refer to the Avid Editors on Interplay Workflow Guide.

Step Refer to

 Determine the best configuration for your workgroup. “Planning your Storage Locations” in 
the Help for Avid DS.
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 Install all Avid DS client workstations.

c Do not install any Avid DS software components (such 
as the indexing services) directly on Avid Unity.

“Installing your Avid DS 
Environment” in the Help for Avid DS.

 Install Avid Unity client software on each Avid DS workstation 
that is connected to Avid Unity.

Avid Unity documentation.

 Install the latest updates for the Avid Unity software (if any).

Follow the online instructions to install this software update, then 
reboot your workstation.

Avid Download Center 
www.avid.com/support/downloadcente
r/index.asp

 On the Avid Unity, create a video workspace and an audio 
workspace for each Avid DS workstation 
(the RP workstation does not need a workspace).

Create a workspace for the video storage - 
\\server_name\workspace_name\video

Create a workspace for the audio storage - 
\\server_name\workspace_name\audio

Avid Unity documentation.

 If you need to share media with other Avid editing systems 
(Media Composer, Symphony), create additional workspaces 
where they can place media that will be shared with Avid DS 
(audio and video can be stored in the same folder). 

n These folders should only contain media that needs to be 
conformed and used by Avid DS, as there is no need to 
index all the offline media on an Avid editing system.

To share MXF media, create the workspace using the following 
convention:

\\server_name\workspace_name\Avid MediaFiles\MXF\

Step Refer to

http://www.avid.com/support/downloadcenter/index.asp
http://www.avid.com/support/downloadcenter/index.asp
http://www.avid.com/support/downloadcenter/index.asp
http://www.avid.com/support/downloadcenter/index.asp
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To share OMFI media, create the workspace using the following 
convention:

\\server_name\workspace_name\OMFI 
MediaFiles\VideoStorage
\\server_name\workspace_name\OMFI 
MediaFiles\AudioStorage

Make sure to use the correct syntax:

• Include a space between OMFI and MediaFiles

• Don’t include a space for MediaFiles, VideoStorage, and 
AudioStorage

• Use the correct uppercase and lowercase letters.

 Use the Administration Tool to assign the permissions on each 
workspace. If some workstations need to share media, you can 
assign permissions for these workstations on the appropriate 
workspaces. (You should also give the RP workstations 
permission to each workspace).

Avid Unity documentation.

 Set up the Avid Unity Connection Manager on each Avid DS 
workstation to auto-launch.

The Connection Manager should always be left active on the 
Avid DS workstations. This utility will automatically map letters 
(or UNC paths in recent releases) and authenticate the specific 
user accounts listed in the Avid Unity Engine.

 Each client workstation needs to mount the required workspaces. “Mounting and Unmounting 
Workspaces” on page 75.

 In Avid DS, use the Storage Configuration tool to add a Unity 
storage connection to your local indexing service. 

Important: Do NOT use a drive letter or mapped drive letter, 
instead browse the network to the Avid Unity server, using only a 
UNC path to access your media folder on Avid Unity.

“Defining your Storage Areas within 
the Media Indexing Service” on 
page 83.

 Place your media in the designated workspaces. “Placing High-Resolution Media on 
the Storage Device” on page 82.

Step Refer to
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Placing High-Resolution Media on the Storage 
Device

High-resolution digital footage that comes either from digital video cameras, film scanning 
processes or CGI applications (e.g. R3D, ARI, DPX, TIF), should be placed onto a fast, 
high-capacity storage device connected to your workstation. This allows you to link to these 
source files and still get real-time playback in Avid DS.

If this media is being shared with other Avid systems, you can place these master files on a 
shared storage, such as Avid Unity and link to it. 

n For a list of storages that support real-time playback, refer to the Avid DS Support Center. 
You can also place your media on a shared storage and link to it, but you may not get 
real-time playback unless you process the media.

If you are working with different types of high-resolution media (e.g. R3D, ARI, DPX, TIF), 
make sure that they are each placed in different folders.

t For local storage. Place your high-resolution files in an appropriate folder under the 
\VideoStorage folder on the storage device. For example, 

\\workstation_name\VideoStorage\DPX\Casino\...

t For shared storage. Place the high-resolution files on a workspace on Avid Unity. For 
example,

\\UnityServer_name\workspace_name\Avid MediaFiles\DPX\Casino\...

Installing and Configuring the ARRI Plug-in

Download the plug-in from the ARRI web site, and install it on your Avid DS workstation.

To enable grouping of the ARRI file type in Avid DS:

1. Start Avid DS.

2. Select File > User Preferences.

3. Select the Avid Explorer tab.

4. In the File Grouping, Available list, select ARI, and click the Add button to move it to 
the Selected list.

5. Click OK.
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Opening the Media Storage Configuration Tool 
outside Avid DS

Before you begin working on any projects, you must set up your storage. The Media Storage 
Configuration tool can be accessed inside or outside Avid DS.

To open the media storage configuration tool outside Avid DS:

1. On your desktop, select Start > All Programs > Avid > Avid DS v10.x > Tools > Avid 
DS Support Console.

The support console and all the various tools are displayed.

2. Double-click UMMDTest.exe.

3. Select File > Open Service.

A dialog box displays for you to enter the workstation whose storage you want to 
configure. 

4. If you are on the proper workstation then leave the machine name blank and click OK.

If you need to configure the storage for another workstation in this workgroup, then 
enter the name of that workstation.

n Warning: There is no security when configuring another workstation’s storage in this way. 
Therefore, make sure that no one else is using that workstation or they will automatically be 
disconnected when you log in.

5. Select File > Configure.

The Media Storage Configuration - Current Project dialog box displays the media 
indexing services that were automatically configured for your workstation when 
Avid DS was installed.

Defining your Storage Areas within the Media 
Indexing Service

You must define all storage areas that you need to access inside a configuration called a 
media indexing service. The Avid DS media indexer scans all storages defined for each 
workstation and indexes the media for quick and efficient access. 

You cannot leave the Avid DS local media indexing service list empty, otherwise Avid DS 
will report missing audio and video storages every time you start the application. Configure 
both audio and video storages and name them clearly.
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n If you are configuring the media indexing service on the controller, see “Accessing Storage 
on another Workstation” in the Avid DS Help. The procedure describes how to include 
storage areas on other Avid DS workstations in the workgroup, so that workstations can 
access each other’s media.

To define your storage areas in the media indexing service:

1. In Avid DS, select Data Management > Configure Storages.

n If you are not running Avid DS, see “Opening the Media Storage Configuration Tool outside 
Avid DS” on page 83.

The Media Storage Configuration - Current Project dialog box displays the media 
indexing services that were automatically configured for your workstation when 
Avid DS was installed. 

2. Select your workstation’s media indexing service, and click the Change button.

The Media Indexing Service dialog box displays.

Your workstation’s 
media indexing 
service is 
indicated by the 
computer name
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3. Leave the workstation name as it is and click the Change button.

The list of storage areas that have already been defined in this indexing service displays. 
Each storage area is uniquely identified by the workstation name and folder where the 
media resides.

4. To add a new storage, click the Add button.

5. The Available Storage Types dialog box, select Avid Media Storage and click OK.

6. Enter the full Windows path name (\\workstation_name\folder_name) where the storage 
area is located, or use the browse (...) button to find it. For example, 
\\DSStorage4\Video. 

If you are connecting to a folder on an Avid Unity, then click the browse (...) button and 
locate the Avid Unity workspace folder. For example, 
\\UnityServer_name\workspace\folder_name. 
Do NOT use a drive letter.

Actual path to storage

Avid DS shared 
storage name
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7. If this storage is for sharing MXF media with another Avid editing system such as 
Media Composer, then select Prevent purge of media on this storage. This makes the 
storage “read-only”.

8. Select the media type that you will store in this folder:

n If there are different media types in your storage, you must add a storage configuration for 
each different type (e.g. generic audio, generic video, MXF audio, MXF video, etc.)

For this storage folder Select this option(s)

Video media imported or generated media by 
Avid DS (read/write).

generic video (.gen)

Audio media imported or generated media by 
Avid DS (read/write).

generic audio (.wav) 

Media that is going to be read-only, but not 
overwritten. e.g. OMFI media that will be used by 
other Avid editing systems.

None

For MXF media: Folders that contain MXF media must be defined separately within your 
media indexing service.

n You need to set up separate MXF folders for Avid DS and any other Avid editing 
systems— see “Sharing MXF Media” in the Avid DS Help.
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9. From the Disk Controller Type list, select the card that is installed in your workstation.

10. From the Disk Storage Type list, select the storage type that you are using.

The disk options set the appropriate bandwidth for Avid DS to use when transferring 
data to the storage. Choose the appropriate options for your storage device to obtain the 
best performance for real-time effects.

n If your storage device does not appear in the list, it may be because it was installed after 
Avid DS was installed. To make sure that it appears in the list, restart Avid DS so that the 
software detects the device.

11. Click OK.

The storage area is added to the Media Storage Configuration list.

12. Continue to add storage areas for all folders to which you need access. 

MXF audio (purgeable) — Read Only MXF audio files (.mxf)

MXF video (purgeable) — Read Only MXF video files (.mxf)

MXF audio (non-purgeable) • MXF audio files (.mxf)

• Prevent purge of media on this storage

MXF video (non-purgeable) • MXF video files (.mxf)

• Prevent purge of media on this storage

For this storage folder Select this option(s)

Storage areas will
be listed here as

they get added

Avid DS shared
storage name
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If there are different media types in your storage, you must add a storage configuration 
for each different type (e.g. generic audio, generic video, MXF audio, MXF video, etc.)

13. Storages are accessed and indexed in the order in which they are listed. Use the Move 
Up or Move Down buttons to change the order of priority.

14. Click Close and then OK to return to the Media Storage Configuration - Workstation 
dialog box.

15. Click Close and then OK to return to the Media Storage Configuration - Workstation 
dialog box.

16. Click the Close button to save the configuration for the media indexing service.

n By default, the media indexer sets any new storage areas to automatically have full 
read/write access by any user on the network. To restrict access to your media, you can 
change the share permissions through Windows—see “Sharing Folders and Setting 
Permissions” in the Avid DS Help.

The first time that you configure your storage, the media indexer will need to index the 
media on your storage device. This may take a while depending on the amount of media 
on your storage.

17. Once your storages have been indexed, you should stop and restart the media 
indexer—see “Stopping and Starting your Avid Indexing Services” in the Avid DS Help.

Avid DS shared
storage name
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As there are a number of different ways to work with film-based projects, it is recommended 
that you first read “Film Workflows” on page 15 and follow the workflow that best meets 
your project requirements. You should also read the material in “Color Management in Avid 
DS” on page 121 to better understand how and where LUTs are applied.

Depending on your system configuration, many high-resolution formats are playable in real 
time—for a specific list of these formats, see the Avid DS support web at  www.avid.com. 
When editing high-resolution projects where real-time playback is not achievable, you can 
use the proxy mode to apply effects and view the results in HD 4:2:2 or HD 4:4:4.

Opening a Film-based Project in Avid DS

Avid DS can work with HD and 2K/4K files, including a large number of sequence formats 
for various film resolutions and aspect ratios.

To set your project settings accurately when you open a project in Avid DS, you must gather 
the following information from either the film-scanning facility, the camera operator, or the 
production director:

• The original film format of your media (e.g. 1080, RED, Full Aperture, DPX, Cineon). 

• The quality at which your film master was scanned or transferred. The most popular is 
the 10-bit format and the most frequently used resolution is 2K. 

• The frame rate (fps) at which your film master was scanned or transferred.

• The format required for final delivery. 

• A corresponding LUT for your footage. This will be required when you import your 
media into Avid DS.

To create a film-based project:

1. In the Open Project dialog box that displays when you start Avid DS, click the New 
Project button.

The New Project dialog box displays. You can click the Help button at any time to get a 
full description of all the parameters in this dialog box.

2. Enter a Project Name.

http://aviddssupport.avid.com/index.htm?section=configurations/ds_10_supported_formats.htm
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3. Keep the default project Location as this is where all your Avid DS projects reside.

4. There are a number of film resolutions and apertures for HD or film that you can choose 
from.

Select the specific film Format at which your material was acquired. The menu options 
are as follows—Media Format > Resolution > Frame rate.

For example:

FILM > RED > 2:1 (2K) > 23.97 frames/s

HD RGB 4:4:4 > 1080i > 59.94 fields/s

If you are going to output your project at a different resolution then what it was 
originally shot at, then you can set the project with the new output format. Note 
however, that if your media format is not the same as your sequence format, your media 
will not be playable in realtime in Avid DS until you process your sequence.

n There are some third-party applications available on the Internet that can read the 
properties of high-resolution files (i.e. DPX, R3D, TIF) to give you the exact dimensions.

5. When you select the format, the frame details are set automatically.

Verify that the Frame Size is showing the correct dimensions. If not, you will need to 
choose another Format.
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6. Select the LUT depending on the delivery format of this sequence. 

For example, if the material you are editing and finishing is for HD Television, then the 
Sequence LUT will be ITU 601/709.

If you are working with media from only one source and been provided a specific LUT 
file for this media, you can import it now—see “Importing External LUTs” on page 132.

If you will be using media from different sources, then we recommend that you select 
the LUT that is most appropriate for the final output.

7. For the Storage Settings:

t Set the Resolution for capturing/linking video media to Full. 

t Set the Color Space to RGB 4:4:4.



5  Editing Film-based Projects in Avid DS

92

t Set the Bit Depth to 10-bits. This is typically the format at which film is scanned.

8. Select Use the closest media available, to allow Avid DS to display media of mixed 
resolutions and frame rates in your sequence.

9. Set the Processing Precision to a bit-depth that will give you the best quality for your 
processed effects. To preserve the quality of the bit-depth of 10-bit material, choose 
16-bits. For more information on bit depth, see “Bit Depth” in the Avid DS Help.

If you selected the ITU 601/709 LUT, then select the 32 Bits float option for Processing. 
This ensures that the LUT can be reversed transparently so that you can view your 
media without your LUT if necessary.

c Although Avid DS can support higher bit depths during processing, the caches may be 
stored at a lower bit depth depending on your resolution and color space settings. Note 
that, using a higher precision bit depth generates smoother effects during processing, 
and still produces better quality output for lower bit depth outputs. Optionally, you 
could set the Precision bit depth to the same setting as the Storage bit-depth. Then, if 
you want to process a specific effect at a higher-quality bit depth, you can change the 
Precision bit depth within the Processing dialog box, or in the Options property page of 
the effect.

10. For the Audio Settings, set the Sample Rate and Bit Depth at which you will output your 
audio media.

11. Leave the conversion settings at default.

12. Click OK to save project preferences.

Avid DS displays the timeline where you can now begin working on a sequence.

A project folder is created under the location specified earlier. This is where all your 
sequences will reside.

Conforming a Film Sequence using an AFE

AFE (Avid File Exchange) files are an efficient way to transfer projects and bins from an 
offline to an Avid DS online finishing system. AFE files let you transfer one or more bins, 
their contents, and information about the contents, including master clips, subclips, titles, 
and sequences.

To load the AFE:

1. From your offline editing system, take the AFE and other project files that you may 
require (e.g. EDL, ALE) for the sequence that you are conforming, and copy them to the 
local project folder that was established when you created your project in Avid DS.

e.g. C:\DS Projects\DS v.x\Casino\...
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2. Open a new project in Avid DS in the format in which you intend to output your final 
sequence.

3. Navigate to the folder where you placed offline files, and double-click the AFE.

The loaded bin displays in the lower area of the screen.

4. When conforming R3D files, it is recommended that you log them by deselecting Create 
Linked Clips for File Sources. You can then capture the R3D media either from the Avid 
Explorer or from the Timeline.

5. Double-click the bin that contains the sequence that you want to conform.

The contents of the bin are displayed.

6. Select Create Associated clips and Use Alternate Video Sources, and then click 
Configure.

The Choose Alternate Video Sources dialog opens so that you can select your DPX, 
R3D or other high-resolution files.

7. Proceed to “Linking to High-Resolution Files during the Conform Session” on page 98.
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Conforming a Film Sequence using an EDL

An edit decision list (EDL) is a detailed list of the edits contained in a sequence, including 
all the timecode and supported effects information required to re-create the sequence in an 
online videotape suite. Avid DS accommodates EDLs from many different systems.

In a tape-based workflow, you can log the events in the Avid Explorer, and/or recreate the 
list of events on the timeline. You can then capture the media from either the Avid Explorer 
or the timeline—see “Batch Capturing” in the Help.

Before conforming your EDL, check if there are any layers to be composited. Offline editors 
often create multiple EDLs since the EDL format does not support more than one video 
track.

During the conform process, you can set up the appropriate heads and tails values for each 
clip. This is important if you need additional material at the beginning and end of each clip 
to do minor changes during the final stage of the edit. You can also configure the audio 
channel patching for each tape.

If the proofing session is successful, you can then remove the video track you added and 
continue to add effects and finishing touches to the original sequence.

To open an EDL:

1. From your offline editing system, take the AFE and other project files that you may 
require (e.g. EDL, ALE) for the sequence that you are conforming, and copy them to the 
local project folder that was established when you created your project in Avid DS.

e.g. C:\DS Projects\DS v.x\Casino\...

2. Open a new project in Avid DS in the format in which you intend to output your final 
sequence.

3. Select View > Single-instance Views > EDL.

4. In the EDL view, click the Load EDL button to load a new EDL.

5. In the Open dialog box, browse to the folder where you placed the offline files, and 
select the EDL. 

If you know the system from which the EDL was generated, select the appropriate File 
Type.
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6. Click the Open button.

The selected EDL is displayed in the EDL view. The EDL view lets you import an EDL 
file produced on any external system, and capture material based on the edits in that 
EDL. For more information about the EDL view, click the Help button.

If you selected the wrong file type, you are prompted to convert the file to the 
appropriate type.

7. Click the Conform EDL button.

Record in-pointConform EDL
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8. In the EDL Conform dialog box, select whether you want to create Logs and/or 
Timeline Clips.

9. If your digital master is in DPX, R3D, or ARI file format, select Use Alternate Video 
Sources and click Configure.

Proceed to “Linking to High-Resolution Files during the Conform Session” on page 98.

Linking to High-Resolution Files

By creating links to media files that are not stored on a remote storage device, you can work 
with media files without having to capture them to your local storage. These files, called 
linked clips, can reside anywhere on the network until you’re ready to output your sequence.

Some projects may require you to work with images at varying resolutions (sizes). When 
you capture these files, you must convert the material to the working resolution of the 
current sequence. By linking to the material instead, you can keep the material at its original 
resolution regardless of the sequence’s frame size. Once you have completed your edits, you 
can process the linked material, which creates a cache file of the image area that is visible in 
the viewer.
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Linking clips is also useful when more than one person needs access to the same file. You 
can capture the file as a linked clip, drop it into your sequence, and continue to use it as a 
reference while another person continues to work on the source media file. Changes made to 
the original file automatically appear in the linked clip, both in the Avid Explorer and on the 
timeline. You can also use the Copy-Link function to make a copy of the original media and 
then link to it—see “Copying and Linking Media” in the Help for Avid DS.

n If another person tries to modify a file that is linked to a clip in an open project, they will not 
be able to save that file due to a sharing violation. You must close the project that contains 
the linked clip for them to be able to save the original file.

Once you are ready to output the sequence, simply process the clip on the timeline. If you 
process the material, a cache file is created. Once a cache is created, Avid DS no longer 
refers to the source media file, but uses this cache file during playback. Any further changes 
to the source file do not appear in the linked clip on the timeline. Like any other cache 
however, the cache for the linked clip can be purged, which relinks the clip to the source file.

n If the original file is removed from its location, you will receive a “Media not available” 
message when you playback the portion of the sequence that uses that clip. 

• If you are conforming a sequence—see “Linking to High-Resolution Files during the 
Conform Session” on page 98.

• If you are building a new sequence in Avid DS—see “Creating Linked Clips” on 
page 97.

Creating Linked Clips

When you link to media on your storage, linked clips will appear in the Avid Explorer 
similar to master clips. Since no actual media has been captured, their file type icons will be 
underlined in red. 

Depending on the type of media you are linking to, your system hardware, or the storage 
where your media resides, some linked clips do not require processing and can be played 
back in real time (such as .gen, .omfi, .mxf, .dpx, or .cin files). If you cannot view your 
media in realtime when they are placed on the timeline, you will need to process. Processing 
the clips will create media caches on your storage which will be used instead of the original 
linked media.

If the Media Not Found message appears in the viewer when using linked clips, it is possible 
that the file has been moved or that Avid DS has lost the connection to the linked file. To 
re-establish the link, see “Relinking a Clip” in the Help for Avid DS.
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To create a linked clip:

1. In the Avid Explorer, open a bin and select the file (s) you want to capture as linked 
clips. To select a series of files, click the first file, hold down the Shift key, and click the 
last file. To select multiple files, hold down the Ctrl key and click each file name.

n If you select a sequential list of still files of the same type (such as all .DPX or all .TIF), you 
will be asked if you want to combine the files into one master clip or capture individual clips. 
Working with one master clip makes editing much easier.

2. Right-click a file and select Capture Settings.

The Capture Settings dialog box opens.

3. Select the settings that apply to the files that you want to capture. See “Capturing 
Material from File” in the Help for Avid DS.

n Since linked files are brought into Avid DS at their original resolutions, there is no need to 
convert them to the current sequence’s resolution. As a result, the Media Conversion modes 
are not applicable when the Link option is selected.

4. Close the Capture Settings dialog box.

5. Right-click the selected files and select Link.

An Import dialog box opens and the first file (first frame of the transfer) is displayed in 
the viewer. For more information on the options in this dialog box, click Help.

6. Optional. If you are working with film-based material, make sure you select the 
appropriate LUT for your footage. By default, Avid DS selects an appropriate LUT for 
the file type you are working with. However, if you have a LUT that was provided 
together with your footage, then you should use this LUT instead.

7. Click Ok to begin the import.

As the material is linked, clips appear in the selected bin. The clip icons are underlined 
in red to indicate that they are linked clips. Although no media has actually been 
captured, when they are placed on the timeline, the media will still be referenced.

n You can view additional information about the linked clip by right-clicking on the clip, and 
selecting Clip properties. On the Format Specific tab, click the File Info button.

Linking to High-Resolution Files during the Conform Session

Once you have opened your AFE or EDL, you can select the DPX or R3D files that you need 
to use for the sequence you are conforming. 

If you have a folder containing different media types, Avid DS will ask you which type of 
media you want to use for the current conform. 
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n If your sequence contains several types of media, you will have to conform it once per type 
of media, and replace them manually on the final sequence.

To find the DPX or R3D files:

1. In the Choose Alternate Video Sources dialog, select Quick browse.

2. Click Select Root Folder and browse to the folder where the files are located on your 
video storage. 

3. Select the folder that needs to be scanned and click Select.

All subfolders under your selected folder will also be scanned.

When you scan your files, Avid DS retrieves the metadata in the files (i.e. timecode, 
KeyKode, tapename) and does the following:

If... Then...

The DPX files contain the tape source 
information (i.e. tape name and 
timecode)

A direct association is made between the file’s 
timecodes/tapenames, and the edited 
sequence’s timecodes/tapenames.

The DPX files only contain timecodes The folder in which the file is located is used 
as the EDL/AFE “tape name”.

The DPX files only contain film source 
info (i.e. KeyKode), or you want to 
KeyKode rather than the timecode

In this case, you must also specify an ALE file 
to allow Avid DS to create the association 
between the scanned file’s KeyKode, and the 
edited sequence’s timecodes/tapenames. (The 
ALE can come from the film house, 
MetaFuze or Avid Media Composer).
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4. (Optional) If you want to use an ALE to make the relationship between the 
corresponding AFE/EDL timecode/KeyKode edits, click the option for Select ALE File, 
and browse to the folder where the ALE file is located.

5. (Optional) If you are using RED or ARRI media that has an associated “look” file 
holding additional color information (e.g. .RLX, .XML), then select the Look options: 
Use Look from AAF/AFE/ALE.

6. Click Scan.

Media type File Location

RED If you have an RLX file, then place it in the RLX folder 
under your project folder.

If you have an RSX file, then place it in the same folder 
as your RED files.

ARRI XML files are located in the LUT or XML folder in the 
path where Avid DS is installed. (This folder was created 
when the ARRI plug-in was installed.)
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Avid DS can only conform media of one type at a time. If you have selected a root folder 
than contains more than one type of media, you will be prompted to select the media 
type. The following are the choice of files that you can conform:

The folder is scanned, collecting the metadata that it contains, to display the timecode 
and/or KeyKode associated to each file referenced in the EDL/AFE. 

7. Click OK. 

An Import dialog box opens and the first file (first frame of the transfer) is displayed in 
the viewer. For more information on the options in this dialog box, click Help.

8. Proceed to one of the sections below depending on whether you conformed from an 
ALE or EDL:

t “If you conformed from an AFE:” on page 102

t “If you conformed from an EDL:” on page 102

Media Type Description

R3D (RSX/Metadata) Conform RED media using the RSX file (if it exists), or using the 
metadata in the raw media.

R3D (Custom) Conform RED media using settings of your choice. In this case, a RED 
property editor will display to allow you to choose the color values.

ARI Conform ARRI media.

DPX Conform DPX files.
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If you conformed from an AFE:

1. After all files are successfully scanned and linked, open the bin file in the AFE view.

2. Select a sequence and drop it onto the timeline.

3. Copy the master clips to your project folder.

The linked clips will be indicated in the Avid DS Explorer with a red underline. 

Linked files will be real-time for DPX formats if:

- The resolution of the DPX files is supported for realtime playback on your system 
configuration—see the Avid DS support website at  www.avid.com.

- The DPX files are on your local videostorage that is large and fast enough to 
support high throughput.

- The format of the DPX files exactly match the format of the current sequence.

- The current sequence storage bit-depth is set to 10.

- The data in the DPX files are correctly aligned. This should almost always be the 
case. If not, the FixDPX utility can fix any misaligned data DPX files—see 
“Aligning your DPX Files” on page 103.

If you conformed from an EDL:

t In the EDL Conform dialog, click the Conform button.

The log/linked clips are created for the DPX files.

http://aviddssupport.avid.com/index.htm?section=configurations/ds_10_supported_formats.htm
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n Audio is ignored when conforming DPX files. You will need to import the audio separately.

Aligning your DPX Files

If Avid DS gives you a message that your DPX files cannot be read, it may be due to 
misaligned sectors in the DPX files. This can easily be realigned using the FixDPX utility.

To align your DPX files:

1. If the sequence using the DPX files is currently open, exit Avid DS, or switch to another 
project.

2. Click the Start button and select Programs > Avid Products > Avid DS > Tools > 
FixDPX.

3. In the FixDPX dialog, click the File... button to browse for a specific file that you want 
to fix.

If you want to fix several files, then click the Folder... button to select the folder name.

4. Click Fix it! to begin.

The FixDPX utility will display a summary of the files that were or were not fixed.

5. Click Done to exit.

Capturing High Resolution Media from Tape

HDCAM-SR is commonly used for HDTV television production. However, HD resolutions 
are now also used more and more for film work, especially in 4:4:4 RGB color space. The 
4:4:4 refers to an encoding technique that holds onto all of the image's red, green, and blue 
color data for superior color fidelity, unlike the traditional 4:2:2 YUV mode, which discards 
half of the color data. Although this method does not support resolutions as high as 
film-scanned DPX files (2K, 4K), HDCAM-SR does allow for fairly high quality resolution 
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(upto 1920 x 1080 HD), and with the latest digital film cameras, material can also be shot 
directly in RGB 4:4:4. Also, Telecines now perform high-quality transfer directly to HD in 
real-time, which is much faster and economical than a typical film scanner.

To ensure the highest quality of the master tape, transfer your film reel to HD format in 
4:4:4, which offers the best uncompressed color quality currently available on video. The 
film should also be transferred as 16:9 so that the conform process will not only be 
frame-accurate, but also pixel-accurate in the sense that the effects will match the same 
aspect ratio (titles, shapes, etc.).

When working in HD, you can capture all the media and edit directly in Avid DS—see 
“Logging and Capturing Clips from Tape” on page 104.

Alternatively, you can do your offline editing in Avid Media Composer, and conform and 
finish your project in Avid DS. For this workflow, see “Conforming HD Video Sequences” 
in the Help for Avid DS.

Logging and Capturing Clips from Tape

When capturing from tape you have the choice of capturing media as you preview the tape, 
or logging the in and out points to create empty master clips that can be captured at a later 
time.

To log and capture clips from a tape:

1. Do one of the following:

2. Configure the external device, specify the capture quality, and other perform other tasks 
listed in  “Preparing to Capture Material” in the Help for Avid DS.

3. Click the Tape button.

4. Click the Log/Capture mode button. It toggles between the following modes:

Option Do this

From the NLE toolbar just above 
the timeline

Click the Media IO button and select Capture Tool.

From the main menu Select View > Single-Instance Views > Capture Tool.
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5. From the Deck list, select a deck preset.

6. (Optional) Set a custom Preroll for the deck.

This setting temporarily overrides the setting in the deck template but does not change 
it.

7. Click the Check button.

If the communication between the external device and your system is operating 
properly, nothing happens. If there is a problem, a message box appears, stating the 
possible cause of the problem.

You can verify that the external device is operating within normal parameters by 
checking the five items in the External Device Status area, located beneath the transport 
controls. See  “Transport Controls” in the Help for Avid DS.

8. From the source name list, select the tape’s name.

If the tape is new, click the New Tape button and enter a name for the tape. The tape 
name is added to the Tape Library.

c It is very important to assign a unique name to every tape because Avid DS uses it to 
identify the captured media.

9. In the Clip Name text box, enter a name to prefix all captured clips.

10. From the Target list, select a location to hold the clips. 

Button 
Mode To Do this

Capture clips Set the Capture mode and specify the exact in-points and 
out-points. When you click the Capture button, the deck will 
roll and the capture the media between the selected in and 
out-points.

Log clips Set the Log mode and specify the exact in-points and 
out-points. When you click the Capture button, an empty 
master clip will be logged in your bin.

Option Description

Project Root Creates master clips in the folder with the project name (the 
project folder).

Main Explorer 
Location

Creates master clips in a bin you selected in the Avid Explorer.
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The most recently activated bin within the project root becomes the capture target. An 
icon in the title bar marks a bin as the Capture Target.

n You cannot create master clips outside the current project. Avid DS checks the path to make 
sure the folder is within the project folder.

11. If you are working with logarithmic media (such as film-based material), you will need 
to select a LUT in order to linearize your media for Avid DS. The LUT is used to 
preserve the color data of the material when it is captured into Avid DS.

Typically, you need to apply a LUT that corresponds to the camera that shot the footage. 

If you do not have details on which camera was used, then the sequence LUT (selected 
when you opened your project/sequence), will be used by default.

12. To select a different LUT when capturing your media, select User Defined LUT from 
the LUT drop-down list.

13. Click the LUT button.

The RGB LUT dialog box opens. For descriptions of the parameters in this dialog box, 
click the help button.

14. Select or customize the LUT by doing one of the following:

15. Click OK to save your settings and close the RGB LUT dialog box.

16. Click the Timeline/Deck Control button to set it to operate the Deck controls. It toggles 
between Timeline and Deck mode.

Auto-Source Creates master clips in a folder with the same name as the tape 
name.

Option Description

To Do this

Choose a predefined LUT. Select the appropriate LUT from the drop-down list. 
For HD RGB 4:4:4 sequences, you can use the ITU 
601/709 LUT.

Choose a standard camera LUT or create 
a custom LUT.

Select From File from the LUT Creation drop-down 
list, and click the Create LUT button. 
Browse to the /DS_v10.x/Luts/Lut presets folder 
and select the appropriate camera LUT—see 
Industry LUT Presets Available in Avid DS in the 
Help.
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17. Click the Video button to capture the video channel of the material.

18. Click the Audio button to capture one or more audio channels of the material.

19. To record additional material before the in-point and after the out-point, type the 
appropriate number of frames in the Heads and Tails text boxes.

20. Use the transport controls to play or shuttle the tape to the point where you want to start 
the capture and click the Mark In button. 

The timecode of the in-point you selected is displayed in the In timecode box.

21. Play or shuttle the tape to advance to the point where you want to end the capture and 
click the Mark Out button.

The out-point is displayed in the Out timecode box. The Duration timecode box displays 
the length of material to be captured.

n Tip: If you already know the in and out timecodes, you can type them directly in the In or 
Out timecode boxes. You can also enter a value for the duration and Avid DS will calculate 
the out-point.

You can use the numeric keypad to enter in-points and out-points. Begin typing the timecode 
and an entry box is displayed. When you finish typing, press the I key to set an in-point or the 
O key to set an out-point. Or type a duration and press the D key. To go to a particular 
location on the tape, type the timecode and press Enter.

22. You can add locators with comments while capturing. See “Adding Locators While 
Capturing” in the Help for Avid DS.

23. Click the Start/Stop Capture button. 

As the material is logged, or logged and captured, clips appear in the Avid Explorer 
according to the in and out points that you specified.

Mark In

In timecode box

Mark Out

Out timecode box
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Logged video clips appear with an image of the Avid DS clapboard icon, since they do 
not have any media. Both video and audio clip icons are also red to show that no media 
has been captured. You can later capture these clips in one batch directly from the Avid 
Explorer.

While capturing you can add locators that will be linked to a specific timecode.

n If Avid DS is unable to capture the material on the first attempt, it will try again. If it fails 
again, Avid DS will attempt the capture a third time with an additional preroll of five 
seconds. If the capture fails again, an error message is displayed with a possible explanation 
for the problem.

If you encounter problems capturing material from tape, you should deactivate the viewer 
using the Viewer button in the status bar and try capturing again. When capturing full 
resolution HD material at 29.97 and 30 frames per second, the viewer is automatically 
deactivated.

c If any frames are skipped during the capture, the capture stops, and an error message 
is displayed. Clips are created for the material that was captured up to the point at 
which frames were dropped.

In the Thumbnails view of a bin, video and audio clips 
without media are displayed with red icons.

In the Details view of a bin, video and audio clips 
without media are preceded by a red icon.
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If Avid DS detects any problems during capture, the Capture Error Log is displayed. 
The Capture Error Log dialog box displays the clip that could not be captured, including 
tape source name, in-point, and out-point. It also gives you a brief description of the 
type of error that occurred.

a. To save this log as an .html file, click the Save As button.

b. In the Save As dialog box, navigate to an appropriate folder, type a name for the log 
and click the Save button.

The log is saved as an .html file and can be viewed in any HTML browser.

n Avid DS stops a capture session if it detects any timecode breaks on the source tape. It 
creates a master clip from the in-point to the timecode break. The capture session may stop a 
frame or two after the actual timecode break. If this happens, you may have to cut or trim 
some of the unusable frames from your clip.

To resume capture, enter new in and out-points in the In/Out timecode boxes and click the 
Start/Stop Capture button.

If there is insufficient material for the deck to preroll before capturing, you will not be able 
to capture the material. In this case, use the Live capture option to capture the material.

Capturing Film-based Media from File

You can capture digital film types such as DPX and R3D files.

If the series of digital files were provided by a film scanning facility, use the accompanying 
LUT file that was applied during the transfer as the Masterclip LUT.

When capturing this media, you will need to use the LUT from the digital film camera or 
one that was provided to you from the film transfer facility. This LUT known as the 
Masterclip LUT, needs to be imported when you set the capture settings. If you do not have 
a masterclip LUT, the sequence LUT that you selected when you opened your 
project/sequence will be used by default.

To capture film-based media from file:

1. Right-click the file(s) that want to capture and select Capture Settings.

2. Set the appropriate options—see “Video Capture Settings” in the Help for Avid DS.

3. Right-click the file(s) and select Capture.

The dialog box that opens depends on the type of file that you are capturing.

- DPX files—see “DPX Import Dialog Box” in the Help for Avid DS.

- R3D files—see “RED Import Dialog Box”in the Help for Avid DS.



5  Editing Film-based Projects in Avid DS

110

4. Set your masterclip LUT by doing one of the following:

5. Click OK. 

As the material is captured, the clips appear in the target bin.

Viewing High-Resolution Sequences

Avid DS allows you to playback SD and HD sequences in realtime in the Avid DS viewer or 
on an external monitor. When working with sequences that are higher than HD resolution, 
your system may not have sufficient bandwidth to output to an external monitor. In such a 
case, you have two options:

• Use the Realtime Proxy mode: Avid DS converts the sequence format to a lower-sized 
HD resolution that still provides excellent visual quality for editing and previewing your 
sequence in a video monitor. For more details, see “Film Proxy Mode” on page 112.

• Use the Graphics-link mode: You can redirect your output through the graphics card to a 
second computer monitor. Even with high-resolution 2K sequences, Avid DS is capable 
of 10-bit 4:4:4 RGB color-managed display on either a computer monitor, or an external 
monitor.

n Only NVIDIA graphics cards with sufficient memory support this mode. For details on which 
cards are supported, see the Avid DS support website at  www.avid.com.

Using Avid DS Graphics-Link with an External Monitor

If your Avid DS system is equiped with an appropriate NVIDIA graphics cards (Quadro 
FX-4600, FX-4800, or FX-5600) you will be given the option to play back high-resolution 
sequences (HD or higher) on an external monitor. Using the GPU processor and the second 
output of the graphics card, Avid DS is capable of 10-bit 4:4:4 RGB color-managed display 
on either a computer monitor, or an external monitor such as DreamColor, Cine-tal or Barco.

To import a LUT that was provided with 
your media

See “Importing External LUTs” on page 132.

To use a industry-standard LUT provided 
by Avid DS

Select the appropriate LUT from the drop-down list. 
For DPX, you can use the ITU 601/709 LUT. For 
R3D, you can use the RED LOG LUT.

Choose a standard camera LUT or create 
a custom LUT.

Select From File from the LUT Creation drop-down 
list, and click the Create LUT button. 
Browse to the /DS_v10.x/Luts/Lut presets folder 
and select the appropriate camera LUT—see .

http://aviddssupport.avid.com/index.htm?section=configurations/ds_10_supported_formats.htm
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To use the graphics card for output, you need to use Avid DS Graphics-Link (This option is 
available via an icon on your desktop). Avid DS Dual-Link and Avid DS Graphics-Link 
cannot be run at the same time. To change between these different modes, Avid DS must be 
closed and re-opened in the desired mode of operation. 

To use the Avid DS Graphics-Link option:

1. Save your sequence and close Avid DS Dual-Link.

2. Open Avid DS (Graphics-Link) from the desktop.

n While using Avid DS in the Graphics-Link (GL) mode, the dual-link card will still be used for 
audio playback, but all forms of capture will be disabled (even if the capture tool is 
available).

When viewing images on the external monitor, the sequence format is always 
maintained, regardless of the size of the connected monitor. Therefore, if the resolution 
of your monitor is smaller than the sequence resolution, the output will be reformatted 
in real time to fit the monitor’s aspect ratio. The output settings can be changed via the 
Sequence Preferences dialog with the choice of None (Centers the image), 1080p 
padding (pad around the sides), or 1080p CenterCrop (do a center crop).

n If your workstation has the supported hardware, sufficient memory and processing power, 
you may be able to view your high-resolution sequences in realtime.

You can also analyse the pixels in your image using the waveform monitor and 
histogram options on the secondary monitor view using the GL mode. 

To display the waveform monitor or histogram on the secondary monitor:

1. Move your mouse over to the secondary monitor view and click on it. 

This viewer is now in focus and you can use the following keys on the main area of the 
keyboard:

To Press

Enable/disable the waveform monitor S

Show RGB value of each pixel X (for row)
C (for column)

When viewing colors in the waveform monitor, use the mouse to point 
and click on the area of the image that you want to analyse. The 
coordinates of the pixel and the RGB values will be displayed in the 
bottom left corner [x, y, R, G, B].

Enable/disable the Histogram H
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2. To return the focus to your Avid DS Viewer on the primary monitor , move your mouse 
over to the viewer and click on it.

Film Proxy Mode

When editing high-resolution sequences (higher than HD), you have a choice of displaying 
and processing either in full resolution or real-time proxy resolution. The proxy is a 
lower-sized HD resolution that provides excellent visual quality for editing and previewing 
your sequence in a video monitor.

With proxy resolution, the correct aspect ratio is preserved in the Avid DS viewer as well as 
in the external HD monitor. Even an SD monitor can be used when working with 23.97, 
29.97 and 25-fps sequences. In addition, color space is automatically taken into account by 
Avid DS to make the use of these proxies as transparent as possible.

n When working in full resolution, the results of the processing can only be seen in the Avid DS 
viewer, as the external monitor is disabled. If your system has a graphics card that supports 
high-resolution formats, you can redirect your output to the external monitor—see “Using 
Avid DS Graphics-Link with an External Monitor” on page 110.

To work more quickly and efficiently, you can apply effects in the lower, real-time proxy 
resolution. In this mode, real-time effects do not need to be processed. If any effects do 
require processing, the resulting caches are also generated in real-time proxy resolution to 
save disk space.

n If any effects were previously processed in full resolution, then Avid DS will use these caches 
instead of the proxy 4:2:2 caches.

When you are ready to output your final sequence, you can switch back to full resolution to 
process your effects. Processing in full resolution has the advantage of highly accurate 
processing using 4:4:4 RGB values.

View a histogram of individual Red, Green or Blue channel R, G or B

When viewing colors in the histogram, the black and white level limits 
are set according to the sequence format. These are indicated by the 
two vertical lines on the left and right of your screen. The minimum 
and maximum range values are also indicated next to these lines.

Change color of the lines in the histogram display [ or ]

Lighten or darken the lines in the waveform monitor/histogram display + or -

To Press
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When working in film proxy mode, note the following:

• You can work in either RGB 4:4:4 or YUV 4:2:2 proxy modes. If you are applying 
effects that modify color and you are outputting to RGB 4:4:4, then set the Resolution to 
4:4:4.

• Proxy modes are determined by the type of sequence in which you are working. For 
example, when working with R3D files, the RGB 4:4:4 film proxy mode is used. 

• You cannot enable viewer LUTs in YUV 4:2:2. However, you can use the LUTs effects 
on the Timeline as an effect. Do note that if you are using it to make color modifications, 
it is a good idea to work in a 4:4:4 proxy mode for an accurate color display.

• When in a shared collaborative environment using an Avid Unity, the Avid DNxHD 
proxies can easily be shared between Avid Media Composer HD and Avid DS systems. 
Avid DNxHD compression ratios are also available to you when you use proxy mode. 
For a description of these ratios—see “Avid DNxHD Compressions” in the Help for the 
Media Composer family.

Enabling Film Proxy Mode

Real-time proxy mode is only available on an Avid DS workstation that has the appropriate 
hardware. Otherwise, you can work in Full resolution which still gives you real-time 
playback of your media in the viewer, but not the external monitor.

To set your sequence preferences to work in proxy mode:

1. Select File > Sequence Preferences.

2. Set the Resolution to Real-time Proxy so that you can edit and add effects in real-time.

3. On Avid DS workstation, you can change the Compression to one of the Avid DNxHD 
compression formats.

This will save you space on your storage device while you are editing your sequence.

4. Set Downconversion of HD/SD output to the appropriate setting so that you can feed 
your output to an external monitor and view the results.

In the Avid DS viewer, the real-time proxy mode compensates for change in aspect 
ratio. For the external monitor output, you have the flexibility to either see a cropped 
version of the frames, or a centered and padded version. Internally, Avid DS still holds 
the entire frame.

5. Click OK to set the preferences.
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Editing and Applying Effects in Film Proxy Mode

To work more quickly and efficiently, you can apply effects in the lower, real-time proxy 
resolution without having to process real-time effects do not need to be processed. If any 
effects do require processing, the resulting caches are also generated in real-time proxy 
resolution to save disk space. If any effects were previously processed in full resolution 
before the switch to the proxy mode, Avid DS will use these caches.

When you are ready to output your final sequence, you can switch back to full resolution to 
process your effects.

To edit and apply effects in proxy mode:

1. Load your sequence or clips onto the timeline.

n If you cannot get realtime playback for your media, you can process your timeline. This 
generates media on your local storage based on the format of your sequence.

2. Perform the necessary edits, color correction, and addition of effects to your sequence.

While applying effects such as Keyers or creating mattes, toggle between Proxy and full 
resolution modes by clicking the button with the green dot above the viewer.

3. If are applying a LUTs effect on the Timeline—see “Applying a LUT Effect” on 
page 134.

4. Switch back to full resolution mode and process the effects—see  “Processing Effects” 
in the Help for Avid DS.

5. When ready to output, see “Outputting Film Sequences” on page 114.

Outputting Film Sequences

Avid DS supports output mastering of film-based projects to any of the original transfer 
formats.

You can output the film sequence to tape or to a digital file format such as Cineon or DPX. 
The delivery depends on how the output will be displayed. For example, for HD TV 
broadcast, you should output the final sequence to tape. 

By default, the Sequence LUT is used when outputting to tape or to file. This ensures that 
the color information used when editing and applying effects in your sequence remains the 
same during output. 
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Ouputting to Multiple Formats

Outputting your sequence to multiple formats is known as Universal Mastering. If you are 
working in an HD sequence, you can easily deliver the same sequence to multiple formats 
such as film or NTSC formats. In the case of a film output, it is possible to output a final 
series of film-resolution images (2-4 K) for a film recorder. 

To deliver to multiple formats:

1. Save the sequence after you are finished editing and applying special effects.

2. Create a new sequence making sure that you are using the same frame rate as the 
sequence you just saved. 

3. In Avid DS, select the sequence and drag it on the timeline.

4. Output the sequence using the applicable settings.

Outputting DPX Files

In the case of a film output, it is possible to output a final series of DPX images for film 
recorder compatibility. All color information from the sequence LUT is also encoded within 
the DPX files.

To output a sequence to DPX or Cineon files:

1. Select View > Single-Instance Views > Output Tool.

2. Select the material to output. You can choose the entire timeline or specific in/out 
timecodes.

3. Click the To File button.

4. For File Type, select the file format which you want to export (DPX or Cineon).

The DPX Export dialog box opens.

5. For the LUT, Avid DS will use the Sequence LUT that was set when the sequence was 
created. You may change this if necessary.

6. If you want to save a timecode on each frame in the file, select Export Timecode, and set 
the appropriate timecode start time.
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7. Click OK to save the settings.

8. In the Output Tool window, keep the Output Resolution at the defaults.

9. For the Output Options, select the appropriate Codec (if applicable). 

10. Select the Preserve Alpha option if the sequence includes an alpha channel that you 
want to keep in the output file. 

This is useful if you plan to reuse the matte information in future compositing or 
graphics projects. However, not all file formats support alpha channels. 

11. To resize your file, select Use Advanced Settings.

Click the Help button for more information on the parameters in this dialog.

12. Click the Output button to begin the export.

13. Select a folder in which to save your material, enter a name for the file, and click Save. 

The material is processed, if necessary, exported to file, and placed in the selected 
folder. 

14. Close the Output Tool dialog box.
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Outputting to Tape

When you output to tape, the image size must match the resolution set in your Sequence 
Preferences. 

To output to tape:

1. Do one of the following:

t From the NLE Tools toolbar above the timeline, click the Media IO button and 
select Output Tool.

t Select View > Single-Instance Views > Output Tool.

The Output Tool opens.

For information about options in the Output Tool, click Help.

2. Configure the external device and perform other necessary pre-output tasks. See 
“Preparing for Output” in the Help for Avid DS.

3. Click the To Tape button.

4. Select the Deck.

The device that is currently active will display in the Deck list. You can select a another 
device preset from the list.
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5. Click the Check button.

If the link between the external device and your system is operating properly, nothing 
occurs. If there is a problem, a message box appears, stating the possible cause of the 
problem.

You can also verify that the external device is operating within normal parameters by 
checking the five items in the External Device Status area, located beneath the transport 
controls. A green or red light beside each item displays its status. Items that are grayed 
out are inactive.

6. Select the Edit Mode, either Auto (Insert) or Assemble.

This setting temporarily overrides the setting in the deck template but does not change 
it. For more information about Edit Mode, see “Configuring the External Device for 
Output” in the Help for Avid DS.

7. (Optional) Set a custom preroll for the deck.

This setting also temporarily overrides the setting in the deck template but does not 
change it.

8. Make sure the Timeline/Deck button is set to Deck.

9. Click the track buttons (V, A1, A2, and so on) for the video and audio tracks you want to 
output.

10. If you are experiencing any frame delays in audio when you output your sequence to 
tape, enter the number of frames in the Audio Propagation Delay text box.

11. If you need to output your sequence to a lower resolution format than the current 
sequence setting, click the Convert button. 

Select the required output formats. The options that are available depend on the current 
video format. For a list of the available formats, see “Downconverted Output Formats 
and Sync Sources” in the Help for Avid DS. 

12. If you have not selected the Use Timeline Timecodes for Edits option, specify the 
position on the tape where you want the program to start recording. Use the transport 
controls to locate the position or type a timecode in the I (In) field. See “Selecting an 
Area to Output” in the Help for Avid DS.

n If you are insert editing your material, your tape must be properly striped with timecode 
before attempting to output your material.

13. (Optional) Click the Preview button to view your sequence before outputting to tape.

14. Click the Insert button. If you set the Edit mode to Assemble, then click the Assemble 
button.

The selected media in your sequence is output to tape.
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Linking Back to MXF Media on the Avid Offline Editing System

You can share MXF master clips captured or generated on Avid DS with other Avid editing 
systems. For HD media, you can share MXF DNxHD media only with other Avid systems 
that support it. To make this media available for use by Avid offline editing systems, you 
need to set up your storage areas accordingly.

To share MXF master clips created on Avid DS, follow this basic workflow:

1. Make sure any storage devices or Avid Unity workspaces are configured correctly.

2. On the Avid DS system:

a. Create a project. In the New Sequence dialog box, select the proper capture settings: 
MXF storages (one for audio and one for video), desired compression, and so on. 
MXF storage can be shared (in an Avid Unity environment) or local (and later 
transferred).

n If you are going to capture audio from a multi-stream file, make sure to select the option 
“Import audio into separate audio tracks” in the New Sequence dialog box.

b. Capture and edit the media.

c. Export an AAF file—see “Outputting a Sequence to Avid Media Composer” in the 
Help for Avid DS.

3. If your media is not on a shared Unity storage, you will need to transfer media to the 
Avid editing system. Do one of the following:

- If you are transferring media over a network, copy the MXF audio storage and the 
MXF video storage to the local drive.

- If you are transferring media on a removable drive, connect the drive. 

4. On the Avid editing system, open a project with a matching frame rate.

5. Import one or more AAF files.

The Avid editing system creates a master clip for each AAF file.

6. Select the new master clips and select Clip > Relink.

The Relink dialog box opens.

7. Deselect the option Relink only to media from the current project, accept the other 
defaults, and click OK.

The master clips are relinked with the MXF media.



5  Editing Film-based Projects in Avid DS

120

n You can use the Media Tool to create master clips, but this method does not always work, for 
example, when a clip from Avid DS includes alpha.

Media Composer Macintosh systems, and other Macintosh-based Avid editors, cannot use 
MXF media created by Avid DS, due to a 31-character file name limit. This situation occurs 
when an Avid DS system creates a storage on a Unity volume to share with other Avid 
editing systems. This problem does not affect Windows systems.



6 Color Management in Avid DS

When high-resolution files are transferred through the Telecine process to tape or scanned to 
DPX files, the storage of color data can be compromised. Furthermore, the different types of 
monitors used in post-production sites when editing and finishing clips can display 
inconsistent color data or information.

Proper color management requires that the monitors are calibrated to give editors and artists 
a uniform view of the footage being used. Color management in Avid DS ensures that the 
color information from acquisition (capture) to delivery (output) is accurate, consistent, and 
undistorted. Additionally, it helps guarantee that the colors of the output, even when footage 
is acquired from different sources, is standardized across all display devices such as CRT 
and LCD monitors or projectors. This guarantee is accomplished with the use of Lookup 
Tables (LUTs).

Before you begin using LUTs in Avid DS, do the following: 

• Profile all monitors being used at the site to get the existing color data being displayed, 
and then calibrate the monitors according to the site’s workflow. This preliminary 
practice ensures consistent color display on all monitors.

• Clearly understand the type of final output that the client wants as this determines the 
LUT file that will be applied. For example, the client may want the final output to be 
broadcast on television, projected in the cinema, or both.

Lookup Tables (LUTs)

A LUT is a file that contains a conversion table used to map an input color value to an output 
color value.

In Avid DS, LUTs are used for the following reasons:

• To ensure a standardized color output value across different devices such as computer 
monitors, broadcast monitors, and film projectors.

• To offer flexibility in editing and post-production when working with media from 
different sources or shot with different cameras.

• To convert logarithmic media files to linear format prior to editing and applying effects. 
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• To determine how the color data of the final image will be displayed.

• For creative or artistic purposes to obtain a particular “look and feel” to a scene.

Avid DS supports two different types of LUT formats:

• 1D LUT: A 1-dimensional lookup table maps each input channel value to an output 
channel value on a per-channel basis (independently for each channel R, G, and B). 
LUT formats from Apple, Autodesk, Avid, and Nucoda are supported.

• 3D LUT: A 3-dimensional lookup table maps any given color value (R,G,B) to an output 
color value (R, G, B). Mistika, Thomson Luther, Kodak KDM, Iridias formats are 
supported.

Since high-resolution media can originate from a traditional film reel or from more recent 
technology such as a digital camera, there are a number of ways to preserve the color values 
in this media. There are three common acquisition methods:

Film Transferred to HD Tape

After the initial chemical development stage of the original color negative, footage 
originating from traditional film cameras can be transferred through Telecine onto a tape in 
HD format. The media from film has a LUT file that is determined by the color management 
and calibration process during the transfer process from film to tape.

Example: Footage for television is shot and transferred to a tape in HD RGB 4:4:4 format. 
The LUT is delivered with the footage.

Film Scanned to High-Resolution Files

Film-reel footage from a camera is scanned at a film-scanning facility to a series of 
logarithmic-based files. The facility delivers a series of file-based media such as DPX with 
an accompanying LUT that was used for color calibration and the calculation of how the 
film scanner interpreted the film stock’s density and color data.

Example: Footage is sent to a film-scanning facility from which a series of DPX or Cineon 
files are produced. These files are then packaged and sent to the post-production site for 
editorial and special effects work. The LUT is delivered together with the series of files.

High-Resolution Files from a Digital Camera

Digital footage comes directly from the digital camera in a series of linear-based files. This 
media has a corresponding LUT. For example, R3D files from a RED ONE camera will have 
their own LUT.
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Example: Footage is shot using the RED camera and stored as compressed linear-based 
native R3D files. An RLX file, generated at the time of acquisition, can also be loaded to 
provide additional color information of the new footage. (This RLX file can be imported at 
the same time you import the RED media.) 

Industry LUT Presets Available in Avid DS

Avid DS provides a list of industry LUT presets that you can use when starting a new 
sequence or capturing media. Refer to this table for the default values of the Black and 
White points and the Gamma. For example, if you start a new sequence in 8-bit and you 
select ITU 601/709, color values of 16 are mapped to black in Avid DS.

LUT 
Presets Description

Default Black 
point
(8-bit/10-bit)

Default 
White point
(8bit/10bit)

Default 
Gamma

Linear Creates a linear curve letting 
you adjust the black and white 
points only. 

The gamma value is always 1 
and cannot be adjusted.

0/0 255/1023 1

Linear Video Creates a linear curve letting 
you adjust the black and white 
points only which by default 
are set to the standard video 
levels.

16/64 235/940 1

ITU 601/709 Used with both SD and HD 
workflows.

SD uses 601 values, while HD 
uses 709 values.

16/64 235/940 2.2

DCI Gamma Similar to ITU 601/709, it 
creates a straight gamma 2.6 
but without a linear breakpoint 
or linear segment.

Used for the DCI workflow.

0/0 255/1023 2.6

0 Input

O
ut

pu
t

255

White

Black

0 16 Input

O
ut

pu
t

235

White

Black

0 16 Input
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ut
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t

235

White

Black

0 Input
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ut

pu
t

255

White

Black
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Custom or Camera LUT Presets

Avid DS also provides custom LUTs that are optimized to work with specific industry 
cameras such as the RED, Viper, and Panavision cameras. For example, the REDLOG LUT 
has been optimized for the RED Camera sensor and is the best choice for preserving most of 
the color data in the R3D file during capture in Avid DS. These custom/camera LUTs are 
found in the /DS_v10.x/Luts/Lut presets folder and can be used if one has not been 
provided with your footage.

The following table describes the custom/camera LUTs that are available in Avid DS:

Printing 
Density

Used mostly with Cineon or 
DPX files that derive from the 
film scanning process.

n This LUT automatically 
clamps the high white 
values. If you prefer to 
use the unclamped 
version, refer to the 
“Custom or Camera 
LUT Presets” on 
page 124.

23/95 171/685 1.66

sRGB The gamma is similar to ITU 
601/709.

Used mostly when working 
with standard and CRT 
monitors, for example to 
create movies for the web.

0/0 255/1023 2.2

Legacy 
Graphics

Creates a linear curve letting 
you adjust the black and white 
points as well the black and 
white gain values.

0/0 255/1023 2.2

LUT 
Presets Description

Default Black 
point
(8-bit/10-bit)

Default 
White point
(8bit/10bit)

Default 
Gamma

0 Input

O
ut

pu
t

17123

White

Black

0 Input

O
ut
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t

255

White

Black

0 Input
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ut
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t

255

White

Black
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External Monitoring LUT Presets

If you are using an external broadcast monitor that accepts LUTs, you can upload external 
monitor presets from the /DS_v10.x/Luts/External Monitoring Luts folder. These LUTS 
should be applied if you want to view the image with its true color settings. This LUT 
converts linear back to log for viewing purposes.

The following table describes the external monitor LUTs available in Avid DS:

Custom LUT Description

Viper Normalizes images shot using the Thomson Viper Camera. This LUT is used only when the 
camera is in RGB 4:4:4 filmstream mode. 

Note that this LUT linearizes the logarithmic color data from the Viper Camera without 
affecting the white balance. Use the color correction effect to balance the white color value in 
the image.

RED LOG Provided by the Red One Camera. R3D files are already in a linear-based format, however this 
LUT optimizes the visual quality of color data when a 16-bit image is stored in 10-bit.

Printing Density 
unclamp

The Printing Density LUT is provided with the film print stock. It is used mostly with Cineon 
or DPX files that derive from the film scanning process.

The Printing Density Unclamp is the unclamped version and is used so the LUT can be 
reversed transparently.

PDLog985 Uses the Printing Density Linear to Logarithmic function with the black point at 95 and the 
white point at 985.

It can be used for Cineon or DPX files that are derived from the film scanning process.

Because this LUT has a wide dynamic range, set the Processing Precision option to 32-bit float 
when creating a new project or sequence. 

Panalog Provided by the Panavision Camera. It is used to convert a 14-bit image to a 10-bit log file.

Similar to the PDLog985 LUT, the Panalog LUT has a wide dynamic range so set the 
Processing Precision option to 32-bit float when creating a new project or sequence.

External Monitor LUT Description

Viper2ITU709_viewer Converts Viper output colors (in the Viper LUT file) to ITU709 on the external 
monitor.

RedLog2ITU709_viewer Converts RedLog output colors (in the RedLog LUT file) to ITU709 on the 
external monitor.
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The Avid DS Color Management Pipeline

It is important to understand the color management pipeline in Avid DS, and where and 
when you need to apply LUTs. The following section provides an overview of the process.

As shown in the diagram, there are different stages in the workflow where a LUT can be set. 
For the most part, Avid DS applies an appropriate LUT, however you do have the flexibility 
to change the default LUT when you create a new sequence, at capture, during the editing 
stage, and at output.

PDLog9852ITU709 Converts PDLog985 output colors (in the PDLog985 LUT file) to ITU709 on the 
external monitor.

PD2ITU709_viewer Converts Printing Density output colors (in the Printing Density LUT file) to 
ITU709 on the external monitor.

Panalog2ITU709_viewer Converts Panalog output colors (in the Panalog LUT file) to ITU709 on the 
external monitor.

External Monitor LUT Description

Set the Sequence LUT

1

MEDIA

Apply a Masterclip LUT
to linearize media

Capture/Link
Media

2

STORAGE

When storing media,
an internal “storage
LUT” is used to 
convert linearized 
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Edit Sequence

3
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are generated using the 
Sequence LUT
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applied to view the 
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for the external monitor

Output Sequence

Sequence
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Step 1: Open a New Project/Sequence

Before you start a project, you should know the delivery format of the final output. This is 
key in determining the LUT that you will set when you start a project. In Avid DS, this is 
known as the Sequence LUT. For example, if the material you are editing and finishing is for 
HD television, then the Sequence LUT should be ITU 601-709. If you are delivering for film 
projection, then you can use the Printing Density LUTs (clamped or unclamped versions).

n By default, the LUT set for the project is used for all sequences within that project. However, 
you can change the LUT for individual sequences within the project.

When you are editing in Avid DS, the Sequence LUT is used for the following:

• Encoding the color information that is displayed on the external monitor.

• Generating caches when applying and processing effects in the sequence.

• Outputting to tape.

For more information, see “Opening a Film-based Project in Avid DS” on page 89.

Step 2: Capture/Link Media

Any media that is captured, must be converted to a linear representation so that it can be 
used in Avid DS. When capturing media, you need to know how your media originated so 
that you can use the appropriate LUT when capturing or linking to that media. The LUT that 
accompanies the footage is known as the Masterclip LUT in Avid DS. It defines the mapping 
of the logarithmic values representing each pixel’s color values to a linear color space value.

If you have been given a LUT with your media, then it needs to be applied when you capture 
or link to the media so that the original color data of the captured material is preserved. 
When using media from different cameras or sources, make sure that you are using the 
correct LUT with the correct media during capture. 

Although RGB 4:4:4 media is linearized at capture time, it is still stored as 
logarithmic-based data. An internal storage LUT, controlled by Avid DS, is used to convert 
the linear-based media to logarithmic-based media for storage. 

n The only exception is when capturing R3D files. You can select RED LOG storage LUT that 
should be used via the RED Import Dialog Box. R3D files are already in a linear-based 
format, however this LUT optimizes the visual quality of color data for a 16-bit image that 
needs to be stored in 10-bit.
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Step 3: Edit the Sequence

When editing the sequence, there are three places where you can apply a LUT:

• On the Avid DS viewer

• On an external broadcasting monitor

• On the timeline as an effect

The Avid DS Viewer and the Viewer LUT

When editing a sequence, you need to keep in mind that Avid DS works in linear color 
space. Most computer monitors expect sRGB gamma which is why a Viewer LUT is 
required to convert linear images to the viewer gamma settings. As a result, you may not be 
seeing the colors intended for final delivery and you will need to apply a LUT on the 
Avid DS viewer. By default, sRGB is used, however, you can change the Viewer LUT 
according to your monitor characteristics. 

n The Viewer LUT does not affect or encode the final output. The Sequence LUT will still be 
used at output.

For more information, see “Industry LUT Presets Available in Avid DS” on page 123 and 
“Enabling a LUT to the Avid DS Viewer” on page 134.

The External Broadcast Monitor LUT

Most post-production sites use an external broadcast monitor to view the final output. 
External monitors have their own LUTs to convert images coming from Avid DS into the 
color space of the external monitor. This LUT converts linear back to log for viewing 
purposes. It is applied on the external monitor only and not processed by the Avid DS 
system.

Avid DS provides external monitor LUT presets that you can load on your external monitor 
using a USB key or a similar hardware device. (Consult your external monitor’s 
documentation for procedures for uploading LUTs.) These LUTS can be found in the 
/DS_v10.x/Luts/External Monitoring Luts folder. For descriptions of these LUTs, see 
“External Monitoring LUT Presets” on page 125.

The LUT Effect

If you are an Avid DS colorist and prefer to color correct on logarithmic-based media, the 
color management process in Avid DS provides this flexibility by letting you apply the LUT 
effect from the image effects library.
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Typically, when a LUT is applied during capture, logarithmic media from a camera or file is 
linearized. This is because compositing, titling, and the application of effects in Avid DS 
requires that the media be linear. 

If you want to work in logarithmic space, when color correcting for example, you can 
manually apply a LUT effect to convert to logarithmic and then back to linear to complete 
the editorial. However, you can convert the clips back to apply special effects, or for color 
correction work. For more information, see “Applying a LUT Effect” on page 134.

Step 4: Output the Sequence

You can output the finished sequence to tape or digital files such as DPX or Cineon. By 
default, Avid DS uses the Sequence LUT that you set when you started the sequence for the 
following reasons:

• The sequence has been using this LUT to encode the media and generate caches when 
working on the timeline. 

• The Sequence LUT ensures that the stored color information is correct and properly 
displayed on an external monitor or film projector. 

When outputting to tape, the Sequence LUT is automatically used. When outputting to file, 
you can apply any LUT. For more information, see “Outputting Film Sequences” on 
page 114.

n You can also apply a 3D LUT when you are outputting to Cineon and DPX files.
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7 Using Lookup Tables

A Lookup Table (LUT) is used to map input color values to output color values. A full 
description of LUTs and how they are used in the Avid DS color management pipeline is 
provided in “Color Management in Avid DS” on page 121.

Customizing LUTs

When you start a new sequence, it is recommended that you customize LUT files only when 
you need to change the Black and White points, the Gamma, and the Black and White gain 
values of the media. It is crucial that you understand these properties and their relationship 
to each other.

Example: If you are using the ITU 601/709 LUT, Avid DS maps the color values of 64 in 
10-bit to black. If you want to use a color value of 67 as black, then you can nudge the value 
to 67 to make sure that black is properly represented.

Note the following:

• By default, R, G, and B values are locked. 

• For a Linear LUT, you can adjust only the White Point and the Black Point. For a Log 
LUT, you can also adjust Gamma, Film Gamma, and Softclip.

To customize a LUT:

1. In the Video Settings section of the New Sequence Dialog box, select User Defined for 
the LUT option.

2. Click the LUT button.

The RGB LUT dialog box displays.

3. From the LUT Creation drop-down list, select the appropriate conversion format.
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4. Click the Create LUT button.

A new LUT is created and is displayed in the Select LUT list. It is symbolized by the 
asterisk until the page is closed at which point they get saved and the asterisk no longer 
displays.

5. Edit the values as necessary.

For descriptions of the parameters in this dialog box, see “RGB LUT” in the Help for 
Avid DS.

6. Click OK to save the settings.

The LUT is listed in the LUT drop down list in the Video Settings box.

7. Proceed to set up the new project or sequence.

Importing External LUTs

You can import a LUT file that has been supplied for use specifically with the media you are 
working with in Avid DS. A LUT file can be provided by the camera operator, the director of 
photography, the film scanning facility, or even a colorist. 
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n When importing R3D files, you can load an RLX file that is generated at the time of 
aquisition to provide additional color information of the footage. 

To select an external LUT file:

1. Depending on whether you are starting a new project or capturing a file, do one of the 
following:

2. Navigate to the location of the LUT file.

3. Select the file and click OK.

The LUT file is displayed in Select LUT list. The asterisk indicates that it is a new file 
and will disappear after the dialog box is closed.

Saving and Exporting a LUT File

You can save and export the LUT file that you have applied during your work. This LUT file 
can be saved or sent to another editor or colorist who is working on the same footage.

To export a LUT:

1. Make sure you are either in the New Project or the New Sequence dialog box.

2. In the Video Settings section, select User Defined for the LUT option.

3. Click the LUT button.

4. In the RGB LUT window, click Export LUT.

5. Navigate to the location where you want to save the LUT.

6. Enter a name for the file and click Save.

Two files are saved: The *.lut file, which is used for the Log to Lin conversion and the 
*_inv.lut, which is the inverse LUT that can be used for the Lin to Log conversion.

If you are... Do this

Opening a new project or sequence In the Video Settings section, select User Defined 
for the LUT option. Click the LUT button

Capturing a file From the LUT Creation drop-down list, select 
From File. Click the Create LUT button.
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Enabling a LUT to the Avid DS Viewer

If you are using an external broadcast monitor to view the final output of your sequence, it 
will display colors that are determined by the Sequence LUT, the LUT file that was set when 
you started the sequence. You can apply a LUT on the Avid DS viewer for viewing purposes. 
For example, if the Sequence LUT is Printing Density, the image on the Avid DS viewer 
may look dull with little or no contrast. You can apply a LUT to view the clips in the color 
space used by the monitor (sRGB or ITU-601/709).

If you are unsure of which LUT to use, it is recommended that you use the sRGB LUT as 
this is the color space that is used by the Avid DS viewers and monitors. You can also use the 
ITU-601/709 as its values are close to sRGB. If you are working in a 4:4:4 sequence, the 
sRGB LUT is enabled by default.

n The viewer LUT does not encode or affect the final output. 

To apply a viewer LUT:

1. Make sure that the position indicator is placed on the correct clip on the timeline, 
right-click the viewer and select Viewer Properties.

2. Right-click the viewer and select Viewer Properties. 

The Viewer Properties property editor displays.

3. In the Display tab, click the Viewer LUT button.

The RGB LUT dialog box displays.

4. Select the LUT that you want to use to view the clip.

To disable the viewer LUT:

1. Make sure that the position indicator is placed on the correct clip on the timeline, 
right-click the viewer and select Viewer Properties.

2. Right-click the viewer and select Viewer Properties. 

The Viewer Properties property editor displays.

3. Select Disable Viewer LUT.

Applying a LUT Effect

The LUT and 3D LUT effects are available from the Avid DS Image Effects Library.You can 
apply these effects for artistic purposes in order to achieve a certain look and feel to a scene. 
The 3D LUT is specifically applied to simulate film emulsion properties.

They can be applied to clips, tracks, or the timeline. 
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To select a 3D LUT Effect:

1. In the Avid Explorer, navigate to the Image Effects folder and locate the LUT Effect.

2. Drag the effect to the clip, track, or the Effects tree which you want to apply the effect.

The effect is applied and the Luts Effects property editor opens.

3. Click the Lin2Log tab and click Enable the selection of the LUT.

4. From the Select LUT drop-down list, select the appropriate LUT that will be used to 
feed the 3D LUT with the correct log data.

It is recommended that you select the same LUT that you used when capturing media. 

5. Optional: Select Show Input Histogram to view the change in the histogram when the 
3D LUT is imported and loaded.

6. Click the 3D LUT property page.

7. Select Enable.

To apply the effect to Refer to

Clip  “Applying Effects to Clips” in the Help for Avid DS.

Track “Applying Effests to Tracks” in the Help for Avid DS.

Timeline “Applying Effects to the Timeline Effect Track” in the Help for 
Avid DS.
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8. Click the Import 3D LUT button.

9. Navigate to the location of the 3D LUT and click Open to load the table.

The table is loaded and the histogram will change accordingly. You can select and 
deselect the Show Input Histogram option to view the difference.

10. Go to the Log2Lin tab and select Enable.

11. From the Select LUT drop-down list, select the output LUT.

Generating 3D LUTs

The Avid DS 3D LUT Generator is a tool that lets you easily generate a 3D LUT based on 
the color differences between the original image and the newly-created image generated 
from a color grading system or an external LUT engine. 

Using a Color Grading System

2
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SYSTEM
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Generates the 
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Image is captured 
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Using an External LUT Engine

To generate and load a 3D LUT:

1. Go to Start > All Programs > Avid > Avid DS v10.x > Tools > Avid DS 3D LUT 
Generator.

2. Click the Generate Image button and navigate to a location to save the image.

3. Select the type of image.

It is recommended that you use the .dpx format. Avoid using lossy compression formats 
such as .jpg.

4. Send the image for processing by an external grading system or LUT engine.

Once it’s processed, it can be imported.

5. Launch the Avid DS 3D LUT Generator.

6. Click the Resulting Image button.

7. Select the Size of the LUT. 

Note that a larger LUT size effect will take a much longer time to process on the 
Avid DS Timeline, but the results will be more precise.

8. Click the Create 3D LUT button and select a format.

9. Click OK.

The resulting image 
is recorded
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You can now view a comparison between the input and resulting image using the newly 
created 3D LUT. 



8 Using Avid MetaFuze

Avid ® Metafuze™ provides a complete offline-to-finish file-based workflow when used in 
conjunction with Avid Media Composer® and Avid DS. Metafuze allows the generation of 
MXF media from DPX, R3D, TIF, JPG, AVI and QuickTime files, which can be offlined in 
Avid Media Composer, and conformed for finishing in Avid DS. 

Film and High-Resolution Workflows using 
MetaFuze

Single-frame files generated from digital video cameras, film scanning processes or CGI 
applications, need to be converted to playable media so that they can be read by an Avid 
editing application like Avid DS or Avid Media Composer. Avid MetaFuze merges 
consecutive single-frame files (with metadata contained as part of the format) and raw data 
files from a digital camera into an MXF file. 

Avid MetaFuze supports different files including R3D, DPX, TIF, and JPG. It can also 
transcode QuickTime and AVI sequences into MXF files.

n Any file type supported by Avid DS or third-party parsers can be read by Avid MetaFuze. 
Still-file parsers can be written for both MetaFuze and Avid DS using the parser SDK which 
is available as part of the Avid DS SDK.

The illustration below shows a typical example of a file-based workflow for editing film 
footage on an Avid Media Composer or Avid DS.
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This workflow shows you how to carry out editing and finishing on footage that is already in 
digital file format. 

Step 1: Group high-res files into MXF files

High-resolution digital files could originate from digital cameras, film-scanning facilities, or 
CGI applications. The files include formats such as R3D, DPX, or TIF. 

If you need to work with high-res file formats that cannot be read by Media Composer (such 
as DPX/ARI), start by using Avid MetaFuze to transcode these files to a lower SD or HD 
resolution. MetaFuze merges consecutive single-frame files into an MXF file that can be 
read by Avid Media Composer®. (Any metadata originally contained in the file will also be 
included; or for non-metadata formats like TIF, metadata can be added.) 

Media Composer can link to and output RED footage in HD RGB 4:2:2 or 4:4:4. However, 
if you need to output at a higher resolution than HD, you should transcode the RED files 
using MetaFuze and do the offline edit using MXF files. When you conform your Media 
Composer sequence in Avid DS, you will be able to link to the original RED footage to do 
the finishing and output.

n MetaFuze read various file types supported third-party parsers.

Step 2: Edit sequence by linking to HD or high-res media

Link directly to RED or MXF media to edit your sequence on an Avid Media Composer. 
From here, you can output directly to HD or SD. However, should you need to output back 
to high-res media (2K or higher), export the sequence as an AFE for finishing on Avid DS. 

Avid Media Composer
3

2

Avid DS 

AFE

Avid MetaFuze1

4

R3D

HD 4:4:4
HD 4:2:2
NTSC
PAL
QuickTime

DPX
CINEON
(2K, 4K)

TIFCG

DPX

MXF

4
ARI
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Step 3: Conform AFE for finishing in Avid DS

On Avid DS, you can conform the AFE and connect to the original DPX/R3D/TIF files.

In the case of DPX files, necessary information such as KeyKode™ (key number) and 
timecode is inserted as metadata into the DPX file during the scanning process. If the DPX 
files do not contain the timecode information, the ALE is required in order to make the 
necessary correspondence to the associated DPX files. The ALE is usually supplied by the 
film-scanning facility or output by MetaFuze/Avid Media Composer.

n The transcoded MXF file used in Media Composer is not required for the finishing process 
but it could be imported onto a separate video track in Avid DS and used as part of the 
conform check process.

Depending on your system configuration, many high-resolution formats are playable in real 
time — for a specific list of these formats, see the Avid DS support web at  www.avid.com. 
When editing high-resolution projects where real-time playback is not achievable, you can 
use the proxy mode to apply effects and view the results in HD 4:2:2 or HD 4:4:4.

Step 4: Output to tape or file

In Media Composer, you can output any SD or HD formats as required.

In Avid DS, for a film out, you can output the final sequence to master as a series of DPX or 
Cineon™ images (with an appropriate LUT) for recording to film. 

Opening a Project in MetaFuze

When you start the MetaFuze application, it automatically opens a new empty project. A 
project in MetaFuze organizes and displays all the elements that are related to the project 
such as, source file folders, the groups of files created from scanned folders, and the 
information required to create MXF media files. 

If you are starting a new project, you can proceed to “Scanning your Folders” on page 143.

To open an existing project:

1. Select File > Open Project.

2. Select the name of the project that you want to open.

The selected project opens and displays the project components.

http://aviddssupport.avid.com/index.htm?section=configurations/ds_10_supported_formats.htm
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Customizing the MetaFuze Window

The views and toolbars within MetaFuze can be moved to a different position within the 
window, or can be “torn off” and dragged outside of the main window.

In addition, the columns in the Groups view can be rearranged or removed as necessary.

1

2

3

Element Description

1 View Click and drag a view by its title bar. The other views will rearrange to accomodate the 
new position for this view.

2 Toolbar Click the double lines on a toolbar to drag it to a new position. The other views will 
rearrange to accomodate the new position for the toolbar.

3 Presets for Group 
view

You can customize the group view according to the information that you want to display 
in the columns. Add or remove columns as necessary and save the choices by clicking 
the Save Preset button. The new preset view will display in the Column Preset list.
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To move a view within the main window:

1. Select a view or toolbar that you want to move. 

To select a view, click its title bar. To select a toolbar, click the extreme left where you 
see the vertical dotted line.

2. Drag the view to any position within the window where you would like to place it.

The cursor position determines the destination. If another view exists in that location, it 
will automatically move over. Release your mouse to drop the selection into place.

n Some views can be undocked from the main window by clicking and dragging their title bar 
outside the main window. Doing this creates a new window that you can stretch out if you 
need to see the values more clearly. It also gives you more viewing space for the other views 
in the main window.

The changes that you make to the window display are automatically saved and reloaded 
each time you open MetaFuze.

To change column headings in the Group view:

t Select a column heading and drag it left or right to a new position. Release your mouse 
button to drop the selected column into place. 

or

t Click the Add/Remove Columns button.

Select/deselect any columns that you want to display, and click OK.

Any changes that you make to the column display can be saved by clicking the Save 
Preset button. You can save your settings under a new preset file name or modify an 
existing one. 

Scanning your Folders

MetaFuze is designed to scan specified folders and create groups of files based on similar 
file types found in these folders. The scan process groups together any files that have 
consecutive filenames, key numbers, or timecodes. The image resolution (same width and 
height), is also taken into account.

Once the groups have been formed, they can be selected for transcoding. 

To scan your folders:

1. Select Actions > Scan Folders.

2. Browse to the folder where your files are located. 
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The folders can be on your local workstation or on remote storage. (To locate folders on 
a remote storage, you might need to use the full pathname, for example, 
\\<machine_name>\<folder_name>.)

3. In the list of available folders, select a folder name, and click the Add Folder button to 
add the folder to the Selected paths list. 

Select a path in the list and then click the Focus button to refocus your Available folders to this path.

4. Select and add as many folders as you want.

5. Option. You can reorder the selected paths using the Up and Down Arrow keys.

6. Option. To remove a folder from the list of selected paths, select the path and click the X 
button.

7. Click the Options button, and specify the criteria by which you want to group your 
scanned files — see “Scan Folders Dialog Box” on page 165.

8. By default, the Filename is always considered as one of the criteria. Select the Timecode 
and/or Key number options if you’d like to use this data as well.

9. You can change the priority order of the criteria by clicking the Up or Down Arrow 
keys.

10. If you want to specify the type of files to search for, then click the File Types button. 

Select only the file types that you need. This filters out any unwanted file types and 
makes the scanning process much faster.

11. Select the other options as necessary.
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12. Click the Scan button to begin scanning your files.

MetaFuze scans the list of selected paths and forms groups based on the options you 
have selected. 

Once the scan is complete, the main screen displays the list of groups that have been 
found in the selected paths. After groups have been found, you can proceed to transcode 
your files.

n If you have selected the Show scanned information option, the Scan Details dialog box 
opens when all folders have been scanned.

13. To save the scanned group information, select File > Save project.

Enter a project name that will be easily recognized when you export your MXF data for 
use in other applications.

Transcoding your Files

MetaFuze converts groups of scanned files into playable Avid MXF media. You can create 
several MXF files and export an ALE of these files so that you can easily import them in one 
step from your editing system.

You can also create an ALE for each format in the selected transcodes with just one press of 
the 'Export ALE' button. The ALEs will all have the same name but will be appended with a 
suffix relative to the formats.

As MetaFuze transcodes the files, it also embeds the required metadata for tape source, 
timecode, and key number, so that you can later relink to the original source media for 
finishing on an editing system such as Avid DS. 

Metadata can also be added to MXF files that do not originally contain this information (for 
example, TIF files). Some of this metadata can be applied as an overlay on the image, much 
in the same way a telecine transfer would provide window burn-ins of the timecode and key 
number. Finally, when transcoding, you can also specify a format and a codec to be used to 
generate the media.
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1 2

5

3

4

6

Element Description

1 Source viewer Displays the source image.

2 Output viewer Displays the image according to the selected output settings.

3 Splitbar Click the splitbar and drag it right or left to enlarge/shrink viewer sizes. To 
reset size, right-click on any viewer and select Auto-adjust.

4 Group view Displays all the scanned and/or transcoded files.

5 Scanned group Click the + button on any group name to expand the tree and list the 
individual files within the group.

6 Detail view Displays the properties of the object selected in the Group view.
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n An XML command script can also be used in the Avid MetaFuze console mode to 
automatically create a list of files for transcoding. For more information, see “Transcoding 
your Files in a Batch” on page 156.

If you have scanned your files, the Group view at the bottom of the main window displays all 
groups that have been found. The Group view shows data columns for all possible objects — 
a group, single-frame file, or transcode job. However, when you select an object, the Detail 
view on the right will display only the fields that are pertinent to the selected object. You can 
customize the group view by adding or removing columns — see “Customizing the 
MetaFuze Window” on page 142.

To transcode a group:

1. In the Group view, select a group.

2. Preview the sequence of files in the group using the play controls just below the viewers.

The Source viewer displays the original images.

3. In the Detail view, you can experiment with the Format and Conversion Mode options to 
set the best image format and aspect ratio for your output MXF — see “Detail View” on 
page 171 for definitions of the different settings.

The Output viewer shows you how the image will appear based on the transcoding 
settings in the Details view.

4. If you need to select a LUT for your files, click the LUT field in the Detail view. 

MetaFuze provides a choice of common industry LUTs that you can use. You also have 
the option to import a LUT that was provided with your footage — see “Importing a 
LUT” on page 154.

n  R3D files have the LUT information encoded in the files themselves. MetaFuze also 
automatically reads any associated RSX file settings associated to the R3D files. In addition 
to this, you can also import an RLX file which may contain other image settings for the 
files—see “Importing Other Image Settings” on page 156.

5. You can also select information to burn-in on the frames — see “Burning-in Information 
on the Frames” on page 151.

6. If you have media that is to be used for stereoscopic display, you will need to scan your 
left and right image file groups separately — see “Transcoding Files for Stereoscopic 
Editing” on page 149.

7. When you are ready to convert a group into a single MXF file, click the New Transcode 
button, or use one of the keyboard shortcuts described below.

A new job is created for transcoding based on the settings in the parent scanned group. 
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There are some fields that are critical to your overall conform workflow, such as key 
number, tape name, TC start, film type. If you change the settings of these fields in the 
transcode job, an icon will appear next to them to warn that they are different from the 
properties of the original scanned group.

The following shortcut keys are available when selecting groups and creating transcode 
jobs:

n You can also create a new transcode job from another transcode job. Simply select the 
transcode job, change any detail settings, and then click the New Transcode button. The new 
job will inherit the settings from the original transcode job.

8. Select this new transcode job, and in the Detail view, set the necessary transcode 
options—see “Detail View” on page 171.

9. In the Detail view, click on the Folder option, and specify a location where the 
transcoded MXF media is to be saved.

If you will be using this media on an Avid Media Composer workstation, you can save 
the media directly to a shared media folder. Select the appropriate drive, and make sure 
that you save the media in a path name \Avid Media Files\MXF\1\. This is the specific 
path required by Avid Media Composer when you are importing MXF media.

10. Click the Transcode button to begin the transcoding, or use one of the keyboard 
shortcuts described below.

The following shortcut keys are available when selecting transcode jobs and generating 
MXF files:

Option Keyboard shortcut

To select or deselect more than one group Ctrl-click

To select all groups Ctrl-A

To create new transcode jobs for the entire selection Ctrl-T

Option Keyboard shortcut

To select all transcode jobs Ctrl-Shift-A

To select and generate MXF files for all remaining transcode 
jobs.

Ctrl-Shift-T

To select and regenerate all completed transcode jobs where 
an MXF was already previously generated.

Ctrl-Alt-A
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Depending on the number of frames in the group, this process could take some time to 
complete. The status bar displays a message while the transcoding process is in 
progress.

When you start the transcode process, Metafuze checks for existing MXF files with the 
same name, and prompts you with the following choices:

When the transcoding is complete, the MXF files are available in the output folder that 
you specified. Once a job is transcoded, you cannot change the settings. To create 
another MXF with different settings, you need to create another transcode job.

Deleting Transcoded Jobs

You can select and delete transcode groups whether they have been trancoded or not.

To delete a transcode group(s):

1. Select the transcode group(s) that you want to delete.

2. Press the Delete key.

A message box displays asking you to confirm the deletion.

Transcoding Files for Stereoscopic Editing

Stereoscopic imaging involves construction of three-dimensional depth information from 
two images corresponding to pixels in the left and right eye. MetaFuze can transcode files 
for stereoscopic editorial in Avid Media Composer and Avid DS. 

Option Description

Overwrite If a file with the same name exists, it overwrites the specific 
file.

Overwrite All Overwrites all files with the same name without prompting 
you each time that it encounters a matching file name.

Auto-rename If a file with the same name exists, appends an incremented 
number to the end of the file name. e.g. 
Transcode_1080p001.mxf. 

Auto-rename All Appends an incremented number to the end of the file name 
that already exists, without prompting you each time that it 
encounters a matching file name.

Cancel Cancels the transcode process.
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In MetaFuze, you need to scan your left and right image file groups, and select a suitable 
mode to combine the left and right eye views into a single frame for the transcoding process.

For Avid Media Composer you must use the Over/Under mode with left eye on the top, and 
right eye on the bottom. MetaFuze can also combine left and right eyes in Side by side, 
Anaglyph, and Interlaced modes, which are all supported in Avid DS.

To create a stereoscopic group:

1. Scan the appropriate folders as described in “Scanning your Folders” on page 143.

2. In the Groups view, select the folders for the left and right eyes. (The order in which you 
select your left and right eye groups is important as it determines the order in which the 
frames will be combined for transcoding. For Avid Media Composer editing, make sure 
that you select the left eye group first and then the right.)

n To create a stereo group, the left and right eye groups must be of the same file format (frame 
size and resolution) and have the same duration (number of frames).

3. Click the Create Stereo Group button.

A new group is created containing the left and right eye groups.

n If you need to change the order of the groups within the stereo group, you can break the 
group and start again (Actions > Breakup Stereo Group). Breaking a stereo group simply 
returns the left and right eye groups to the list of standard groups.

4. Select the stereo group and set the necessary options — see “Details of a stereoscopic 
group or transcode job...” on page 176.

5. After you have set the necessary options, click the Transcode button to begin the 
transcoding process.
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Burning-in Information on the Frames

Burn-in data is typically used only for the offline stage of a project. It is useful as it provides 
visual feedback for logging and tracking footage.

In the Detail view, you can select a data field to burn-in on your images. If you want to burn 
in more than one field, however, you need to use the Burn-in Editor.

To open the burn-in editor:

1. Select the scanned group and click the Burn-in button on the toolbar.

The Burn-in Editor opens — see “Burn-in Editor Dialog Box” on page 178 for details 
on the settings in this dialog box.

2. Select a Burn-in Preset from the list.

1 2

5

3

4

Element Description

1 Data list Select the data fields that you want to display.

2 Position Select the horizontal or vertical position for the data.

3 Font Select the font and size for the text.

4 Save button Click Save to save your settings as a preset.

5 Delete button Click Delete to remove a preset.
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If you want to create a new preset, then click the Save button, and enter a preset 
filename.

3. Select a field from the Data column, and click the right arrow to add it to the display 
group.

The field is added to the group and displays in the Output viewer.

4. Change the positioning of the display options as required.

Click any of the Group level columns to change the settings.

5. Continue to add other data fields to the group.

To add a line break, select the <NEW LINE> field from the Data list.

To create a separate group of fields and place it on a different part of the image, select 
the <NEW GROUP> field .

6. Click the Save button to save your settings.

7. Click Close to close the burn-in editor.

Configuring the MetaFuze Transcoder

If you have a multiprocessor system, you can increase the number of processsing threads 
that will be used by MetaFuze when transcoding single-frame files such as DPX, JPG or 
TIF.

To configure the system transcoder:

1. From the main menu, select Options > Transcode Configuration.

2. MetaFuze shows the number of threads available on your system for processing.

3. You can raise the number of threads to the maximum, but keep in mind that the 
processing speed is also limited by the capacity to read and write to the hard disk.
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You also need to save some threads for other processes/applications running on your 
system.

n When transcoding stream files such as AVI, MOV or R3D, the threads will be used to their 
full capacity, therefore you will not be able to use other applications during the transcoding.

Using LUTs in MetaFuze

A Lookup Table (LUT) is a file that contains a conversion table used to map an input color 
value to an output color value. When transcoding your files into playable MXF media, you 
need to set the LUT that came with your footage so that the proper color values are retained 
throughout the online editing process. 

The LUT could come from the film house where the files were scanned, or simply be the 
LUT associated with the type of camera with which the footage was originally shot.

n In the case of R3D files, the LUT information is encoded with the file. If Metafuze locates an 
RSX file of the same name in the same location as the R3D file it will use the last settings and 
apply these to the image. In this version, if you do not wish to use the RSX file either remove 
it, rename it, or change the extension. Note that changing this name will affect other 
applications which use the RSX file as a way to save their settings. If there is no RSX file, 
then Metafuze will use the camera settings.

In addition, you can load a look file known as an RLX and this will overwrite the associated 
modified parameters with the settings in this file. This file can be imported into MetaFuze 
before transcoding your files—see “Importing Other Image Settings” on page 156.

If no settings are available at all then MetaFuze will use the default values supplied by the 
SDK.

If a LUT was provided with the files you are transcoding, then you should import it into 
MetaFuze before transcoding the group.

Setting a LUT

After a folder has been scanned, you can set the LUT that will be used for transcoding the 
scanned files.

To set a LUT:

1. Select the group for which you want to set the LUT.

n This field is only available when you are working with a group of DPX or Cineon files.
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2. In the Detail View, click LUT and select an appropriate LUT from the drop-down list. 

The LUT is loaded and you can preview the color settings in the viewer.

Importing a LUT

If the files you are using have an accompanying LUT either from the film-scanning facility, 
the camera, or the director of photography, then you will need to import it.

To import an LUT:

1. Select the group for which you want to import the LUT.

2. Click the Edit LUTs button at the bottom of the main view.

3. Select Template > From File.

4. Click Create.

5. Browse to the folder where the LUT is located, and click Open.

The LUT is now available as a choice within MetaFuze.

6. Click Close.

Modifying LUTs

You can edit or create LUTs from the industry LUTs that are provided by MetaFuze. 

To edit a LUT:

1. Select the group for which you want to modify the LUT.

2. Click the Edit LUTs button at the bottom of the main view.

n This button is only enabled when you are working with a group of DPX or Cineon files.

3. In the LUT Editor, select a Template type.

4. Click Create.

A new dialog box opens with the settings of the template.
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5. Adjust the values as necessary.

n The Lock option links values to each other. Deselecting this option for an entry lets you set 
the values independently.

6. When you are ready to save the settings, click the Rename button.

7. Enter a new LUT Name and click OK.

The new LUT is added to the list and will be used for the group that you have selected.

n These values can be associated with any group within the current project.

8. Click Close.

Exporting a LUT

You can save the LUT settings and export them for use with other MetaFuze groups or 
external applications.

To export a LUT:

1. Select the group whose LUT settings you want to export.

2. Click the Edit LUTs button at the bottom of the main view.

3. Select the LUT that you want to export.

4. Click the Export button.

5. Select the folder where you want to place the file, and click Save.

6. Click Close.
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Importing Other Image Settings

When transcoding R3D files, you can apply additional settings to enhance the “look” of your 
file. This is done via an RLX file which contains settings that are very similar to a LUT.

To import an RLX file:

1. Select the transcode group to which you want to apply the settings.

2. In the Detail View, click Import Settings and browse to the folder where your RLX file 
is located. 

3. Select the file and click Open.

The RLX file is loaded and you can preview the color settings in the viewer.

Transcoding your Files in a Batch

You can automate the transcoding process by creating a batch XML file that lists all the 
groups to be transcoded.

Creating an XML Batch File to Transcode Files

Before you create the XML batch file, you need to have already scanned your folders and 
created the necessary transcode jobs. An XML batch file needs to be created for each 
transcode job. When the batch file is executed, the transcode job is converted into an MXF 
file. 

To create the XML batch file:

1. In the Group view, select the transcode job that you want to convert.

2. In the Detail view on the right side of the screen, set the necessary transcode options — 
see “Create XML Batch Dialog Box” on page 177.

3. Click the Create XML Batch button.

The Create XML Batch dialog box opens.
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4. In the Script Name textbox, type the name of the XML batch file that you want to create.

5. In the Script Output Folder textbox, type the path where the XML batch file will be 
created.

6. Click OK.

This creates an .xml batch file using a list of all the files in the transcode job that you 
have selected. When this batch file is run, the MXF is generated based on the settings 
for this job.

n An .XSD reference file is also created, which is useful when using a third-party XML 
validation tool. The XSD file is used to validate the syntax of your batch file. 

7. Once you have created your batch file using MetaFuze, you can edit the XML file using 
a text editor and change your <filelist> as necessary. For an example of an XML file, see 
“XML Batch File Example” on page 159. 

8. When you execute the batch transcode command — see “Running a Transcode Batch 
File” on page 157. Your XML file will be validated against the XSD to check for the 
syntax and format.

To create an XML file with a third-party application:

1. Generate the .xml and .xsd with MetaFuze.

2. Open the .xml file with Liquid XML Studio from Liquid Technologies (you can 
download the freeware from http://www.liquid-technologies.com/).

3. Edit your file with Liquid Studio.

4. Use the Validate function in Liquid Studio to validate your .xml file against the .xsd.

5. Option. Open the .xsd with Liquid Studio to find the correct enumeration values.

Once you have a valid .xml file, it can be interpreted by MetaFuze.

Running a Transcode Batch File

When you execute the batch transcode command, your XML file will first be validated 
against the XSD to check for the syntax and format. If there are no errors, an MXF file is 
generated based on the job settings in the XML file.

To run the batch transcode:

1. Click the Start button and select Run.

The Run dialog box opens.

2. Type cmd, and then click OK.

A Windows console opens.
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3. Navigate to C:\Program Files\Avid\MetaFuze.

4. At the prompt, type: Metafuze “pathname:BatchFile.xml” where pathname is the folder 
where the batch file is located.

When the command has completed executing, the output files are listed at the end.
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XML Batch File Example

A MetaFuze XML batch file contains the same settings found in the Detail view of 
MetaFuze—see “Detail View” on page 171. The following is an example of an XML batch 
file:

<?xml version='x.0' encoding='UTF-8'?>

<MetaFuze_BatchTranscode 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="MetaFuzeBatchTranscode.xsd" >

   <Configuration>

      <Local>2</Local>

      <Remote>2</Remote>

   </Configuration>

- <Group>

- <FileList>

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368842.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368843.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368844.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368845.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368846.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368847.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368848.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368849.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368850.dpx</File> 
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  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368851.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368852.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368853.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368854.dpx</File> 

  <File>H:\Public\GraphicsFiles\Still 
Seq\DPX\253\154_213C-2_B_03\368855.dpx</File> 

  </FileList>

- <Transcode>

         <Version>x.0</Version>

         <File>Z:\Project_Documents\VT009_A_09_13_08_04_S01.mxf</File>

         <ClipName>VT009_A_09_13_08_04_S01</ClipName>

         <ProjectName>09</ProjectName>

         <TapeName>SPIRIT-4K DATACINE </TapeName>

         <TC_Start>09:13:08:04</TC_Start>

         <DropFrame>false</DropFrame>

         <FilmType>35.4</FilmType>

         <KN_Start>KU828579-6839+07</KN_Start>

         <Frames>64</Frames>

         <Width>2048</Width>

         <Height>1165</Height>

         <PixelRatio>1.0000</PixelRatio>

         <UseFilmInfo>false</UseFilmInfo>

         <UseTapeInfo>true</UseTapeInfo>

         <OutputVideoFormat>1080_24P</OutputVideoFormat>
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         <OutputConversionMode>ANAMORPHIC</OutputConversionMode>

         <OutputCompression>DNxHD 36</OutputCompression>

      </Transcode> 

</Group>

  </MetaFuze_BatchTranscode>

Exporting an ALE from MetaFuze

If you have created multiple MXF files that you want to edit on your Avid Media Composer 
workstation, you can export an edit list of all these clips via an ALE file.

If the selected transcodes have different frame rates, then an ALE is generated for each 
different format that is detected. These ALEs will all have the same name but will be 
appended with a suffix relative to the formats. 

When the ALE file is generated, it will also include source information that was found in the 
files, such as the timecode, keycode, frame rate, and tape name. However, no sequences or 
effects are exported. 

To export an ALE:

1. Use Ctrl-click to select all the transcoded files that you want to include in your ALE.

2. Click the Export ALE button.

3. Save the file(s) in an appropriate location.

A confirmation message box displays when one or more files will overwrite an already 
existing one. You may choose to:

Option Description

Overwrite If a file with the same name exists, it overwrites the specific 
file.

Overwrite All Overwrites all files with the same name without prompting 
you each time that it encounters a matching file name.

Auto-rename If a file with the same name exists, appends an incremented 
number to the end of the file name. e.g. ALE001. 

Auto-rename All Appends an incremented number to the end of the file name 
that already exists, without prompting you each time that it 
encounters a matching file name.
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Importing MXF Files into Avid Media Composer

To import MXF files into Avid Media Composer, you can import the ALE created by 
MetaFuze and link to the associated MXF files. On the other hand, you can simply open a 
bin via the Media Tool and select the MXF files one at a time. Either way, you need to make 
sure that all your transcoded MXF files are located in the Avid MediaFiles folder as required 
by Avid Media Composer (drive letter:\Avid MediaFiles\MXF\1).

Importing MXF Files via an ALE

When you import the ALE into Avid Media Composer, it displays a log of all the master 
clips for which you can import MXF media. You will then need to set certain options to link 
to the master clips.

To import an ALE file using bins:

1. In Avid Media Composer, right-click the bin, and select Import.

2. Browse to the folder where the ALE file is located, select the file, and click Open.

The bin displays all master clips that have been imported.

3. In the bin, right-click the master clip(s), and select Relink. 

4. In the Relink dialog box, deselect the following:

- Relink only to media from the current project 

- Match case when comparing tape names.

5. Continue setting the options and click OK.

The MXF files are relinked to the associated master clips. 

6. Proceed to edit.

Importing MXF Files

The Media tool displays all captured video and audio data files stored on the media drives. It 
also displays media that is stored on local drives directly connected to the Avid editing 
system and on unmanaged shared storage. You can use it to import the MXF files that were 
transcoded in MetaFuze.

Cancel Cancels the export ALE operation.

Option Description



Importing MXF Files into Avid Media Composer

163

To import an MXF file using the Media Tool:

1. In Avid Media Composer, select Tools > Media Tool.

2. In the Media Tool Display window, select the Media Drive where the Avid MediaFiles 
folder is located. 

For example, Video U320 (G:).

The list of Projects will include the name of the MetaFuze project in which you 
transcoded your files. (Avid Media Composer finds this name in the metadata of the 
MXF file).

3. Select the name of the MetaFuze project associated with the transcoded MXF files that 
you want to import.

4. Make sure that only Master Clips is selected and click OK.

Master clips are created in the Media Tool window for any MXF files associated with 
that project.

5. Drag the clip(s) to a bin and proceed with your editing.
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Scan Folders Dialog Box

The following table describes the options available in the Scan Folders dialog box.

Option Description

Available folders Lets you browse to the folder where your source files are located. The 
folders can be on your local workstation or on a remote storage. (For 
remote storage, you might need to use the full pathname, e.g. 
\\<machine_name>\<folder_name>). Press the Enter key after typing in 
the path name.

Selected paths Shows the folders that will be scanned. You can change the order of these 
folders using the Up and Down arrow buttons. You can also remove a 
folder from the list using the X button. The “eye” icon lets you show all 
subfolder for any selected path. Simply select a path in the list, and then 
click this button to refocus your Available folders view to this path.

Options Click this button to show or hide the Options area.

Grouping Determines the criteria to be used when grouping the files. Use the up or 
down arrow buttons to set the order of the criteria.

Key Number Use the key number as the grouping criteria.

Timecode Use the timecode as the grouping criteria.

Filename Use the filename. This option is always used.
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No merge Searches for file patterns for each item in the selected paths list, as well 
as their subfolder levels. Unique groupings are formed for each level.

Based on the paths circled in the above example, 15 searches are done.

Merge across subfolders For each item in the selected paths list, searches for file patterns down 
through all the subfolders. Unique groupings are formed for each 
selected path in your list.

Based on the paths circled in the above example, 2 searches are done.

Option Description
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Group View

The Group view shows data columns for all possible objects—a group, single-frame file, or 
transcode job. When you select an object, only the fields that are pertinent to the selected 
object will display under the appropriate columns (and in the Detail view on the right).

The following table describes the information columns available in the Group view.

Merge all Searches for file patterns and forms groupings across all folders in your 
list of selected paths. 

Based on the paths circled in the above example, 1 search is done.

n For all the preceding merge options, duplicate files are discarded in each grouping and only 
the most recent is kept. 

Include subfolders Scans all subfolders in the list of selected paths as shown in the preceding 
examples.

If this option is not selected, only the files at the top level of the selected 
paths are scanned and grouped. 

File Types Opens a dialog box where you can select only the files that you want to 
scan. This can drastically improve the time it takes to scan your folders.

Show scanned 
information

Displays file details on all groups found, including any duplicate files. 
This option is useful for analyzing the scan results of a given group.

Scan Begin the scanning process.

Option Description
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* A single asterisk beside a value indicates that a pattern has been found 
against this criteria item. However, since it was not the top item of 
priority in your grouping options, the files might not actually be 
contiguous for this criteria.

** A double asterisk beside a tape name indicates that the information has 
been generated by MetaFuze based on your entry.

Some column headings have a little arrow at the top right. Click on the 
arrow to sort the column in ascending or descending order.

Column Description

Name Name of the group.

Folder Name of folder where this group was found.

Clip Name Indicates the name of the MXF file that will be generated. By default, the 
name will be taken from the first file in the group, but you can enter a 
name (using the Detail view) that is more relevant. 

n If you will be using Avid Media Composer for offlining, you MUST 
enter a unique name for the clip.

Project Indicates the name of the MetaFuze project. You should enter a name that 
is meaningful, or corresponds to the name of your project on the Avid 
editing system.

Stereoscopic Mode Indicates a mode used to combine left and right eye views.

Set Film Info For a standard transcode, indicates if the film information metadata 
should be embedded in the MXF.

Transcode Audio Select the checkbox to generate MXF files containing the audio portion 
of the input files.

n One MXF is generated per audio channel. If you have 
multichannel audio, then you will get as many audio MXF files as 
you have channels.

n Stereoscopic groups and their resulting transcodes do not support 
audio transcoding, therefore, all fields in the audio coloumns are 
greyed out for stereoscopic transcodes.
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Wav file Select the checkbox if you want to generate a WAV file containing the 
audio portion of the input files. The .wav files will be saved in a WAV 
subfolder under the same folder where the MXF files are output.

Film Type Displays the film type found in the source media. If this metadata is not 
found, then the default is set to 35 mm 4 perfs.

KN Start The key number found in the first file of the group .

If key number metadata was found in the source file, then this field 
cannot be changed. If the key number was not found in the source file, 
you will be able to enter a key number if necessary.

Set Tape Info This option is always selected. Tape information metadata is 
automatically embedded in the MXF.

Tape Name The source tape name. For some file types, this name can be changed if 
necessary. Be careful when changing the name as doing so will not allow 
you to relink to the source media during the finishing process.

TC Start The timecode found in the first file of the group.

If timecode metadata was found in the source file, then this field cannot 
be changed. If the timecode was not found in the source file, you will be 
able to enter timecode if necessary.

TC End Displays the timecode found in the last file of the group.

Burn-in Lets you select metadata for burn-in. If you want to burn-in more than 
one field, see “Burning-in Information on the Frames” on page 151.

Format Lets you set the format for the output sequence. The format 
automatically determines the frame rate, frame size, field dominance, 
aspect ratio, and pixel ratio for the media. 

For this version, you can choose between 720p and 1080p HD formats.

n If frame rate metadata was found in the source file, then the 
choices for the output format will be based on this frame rate.

Compression Lets you select the appropriate compression ratio to be used during 
conversion.

Uncompressed No compression.

Column Description
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DNxHD Avid DNxHD is a 8- and 10-bit HD encoding technology that delivers 
mastering-quality HD media with storage bandwidth and capacity 
requirements similar to those of uncompressed standard-definition (SD) 
files. Avid DNxHD operates in a 4:2:2 color space at much lower, more 
efficient data rates. 

The options available here depend on the Format chosen for the MXF 
output file.

Also, note that 8-bit compression is not available for source media that is 
10-bit.

Conversion mode Lets you select the aspect ratio that will be used during conversion. When 
converting between film/HD and NTSC formats, you must make sure 
that the aspect ratio is respected. Film/HD uses the aspect ratio of 16:9, 
while NTSC/PAL uses 4:3.

Choose the mode that will be used for final output.

Anamorphic If your images are 16:9, they are stretched vertically to fit into a 4:3 
NTSC frame.

Letterbox Use this option to the preserve aspect ratio when going converting from 
HD to NTSC. If your images are 16:9, they are placed in the center of the 
4:3 NTSC frame and black bars are added to the top and/or bottom of the 
image. 

Choose the appropriate letterbox option.

Pillars Select this option is to preserve the aspect ratio when going from NTSC 
to HD. The 4:3 image is placed in the center of the 16:9 HD frame and 
black bars are added to the left and right sides of the image.

LUT Enter the type of Lookup Table to be associated with these files. (Only 
available for DPX and Cineon file types.)

Nb of frames Indicates the number of sequential frames found.

Frame Info Shows the key number.

Nb of Duplicates Indicates the number of duplicate frames found.

Status Indicates if this job has been transcoded or not.

Eye Enter the appropriate text to indicate the left or right eye frames. This 
may be useful as burn-in data to provide visual cues on the footage.

Scene Enter the name for the scene. This may be useful for burn-in.

Column Description
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Detail View

This view is available after your folders have been scanned and groups have been created 
based on patterns found in your files. You can select any group, file, or transcode job in the 
Group view, and the corresponding object details will be shown in the Detail view.

n The detail view can be undocked from the main view by clicking the maximize view button in 
the top right corner. Doing this lets you stretch out the box if you need to see the values more 
clearly. It also gives you more viewing space for the other window displays.

The details of transcode jobs are based on settings in the scanned parent group. You can 
change these settings depending on the output format required for the MXF file. There are 
some fields that are critical to your overall digital intermediate workflow, such as key 
number, tape name, TC start, film type. If you change the settings of these fields in the 
transcode job, an icon will appear next to them to warn that they are different from the 
properties of the original scanned group.

Comment Enter any comments about the scene or footage. This may be useful for 
burn-in.

Chroma Select the level to filter the noise of the chroma component.

Debayer Select the amount of detail correction in the debayering process.

OLPF Select the OLPF (Optical Low Pass Filtering) level.

This value can be set before capturing or linking.

ISO Set the sensitivity of film light. The lower the number the lower the 
sensitivity of the film.

Resolution The resolution quality of the image being extracted by the RED parser. 

The higher the resolution, the slower the encoding process.

Import Settings You may use Avid DS or a third-party tool to simulate the “look” of your 
images. These settings (such as black levels, brightness, etc.), can be 
saved to a file, and applied within MetaFuze to the entire group of images 
when generating the MXF file. Such an example is the .RLX file which 
contains metadata for R3D files.

Simply specify the name and location of this file here.

Column Description
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Refer to the following topics for details on the object you have selected:

• “Details of a group...” on page 172

• “Details of a file...” on page 174

• “Details of a transcode job...” on page 174

• “Details of a stereoscopic group or transcode job...” on page 176

• “Details of R3D groups or transcode jobs...” on page 177

Details of a group...

Field Name Description

Name Name of the group.

Folder Name of the source folder where this group was found.

Project Lets you enter a name for this project. This name should be 
meaningful or correspond to the name of your project in your Avid 
editing application.

Film Type Displays the film type found in the source media. If this metadata is 
not found, then the default is set to 35 mm 4 perfs.

KN Start The key number found in the first file of the group.

If key number metadata was found in the source file, then this field 
cannot be changed. If the key number was not found in the source file, 
you will be able to enter a key number if necessary.

Tape Name The source tape name. For some file types, this name can be changed 
if necessary. Be careful when changing the name as doing so will not 
allow you to relink to the source media during the finishing process.

TC Start The timecode found in the first file of the group.

If timecode metadata was found in the source file, then this field 
cannot be changed. If the timecode was not found in the source file, 
you will be able to enter timecode if necessary.

TC End The timecode found in the last file of the group. 

Burn-in Lets you select metadata for burn-in. If you want to burn-in more than 
one field, see “Burning-in Information on the Frames” on page 151.
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Format Lets you set the format for the output sequence. The format 
automatically determines the frame rate, frame size, field dominance, 
aspect ratio, and pixel ratio for the media. 

For this version, you can choose between 720p and 1080p HD 
formats.

n If frame rate metadata was found in the source file, then the 
choices for the output format will be based on this frame rate.

Conversion mode Lets you select the aspect ratio that will be used during conversion. 
When converting between film/HD and NTSC formats, you must 
make sure that the aspect ratio is respected. Film/HD uses the aspect 
ratio of 16:9, while NTSC/PAL uses 4:3.

Choose the mode that will be used for final output.

Anamorphic If your images are 16:9, they are stretched vertically to fit into a 4:3 
NTSC frame.

Letterbox Use this option to the preserve aspect ratio when going converting 
from HD to NTSC. If your images are 16:9, they are placed in the 
center of the 4:3 NTSC frame and black bars are added to the top 
and/or bottom of the image. 

Choose the appropriate letterbox option.

Pillars Use this option is to preserve the aspect ratio when going from NTSC 
to HD. The 4:3 image is placed in the center of the 16:9 HD frame 
and black bars are added to the left and right sides of the image.

LUT The type of Lookup Table associated with these files. Only available 
for DPX file types.

Nb of Frames Number of sequential frames found.

Eye Enter the appropriate text to indicate the left or right eye frames. This 
may be useful as burn-in data to provide visual cues on the footage.

Scene Enter the name for the scene. This may be useful for burn-in.

Comment Enter any comments about the scene or footage. This may be useful 
for burn-in.

Field Name Description
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Details of a file...

Details of a transcode job...

Field Name Description

Name Displays the name of the selected file.

Folder Displays the name of the source folder where this file was found.

Frame Info Displays the key number (if applicable), or the frame number.

Field Name Description

Name Displays the name given to the transcode job.

Folder Lets you specify the destination folder for the MXF file.

If you will be using this media on a Avid Media Composer 
workstation, you can save the media directly to a shared media folder. 
Select the appropriate drive, and make sure that you save the media in 
a path name \Avid Media Files\MXF\1\. This is the specific path 
required by Avid Media Composer when you are importing MXF 
media.

Clip name Lets you enter the name of the MXF file that will be created from this 
transcode job.

Project Lets you enter a name for this project. This name should be 
meaningful or correspond to the name of your project in your Avid 
editing application.

Set Film Info Select the checkbox to include film information metadata in MXF 
file.

Transcode Audio Select the checkbox to generate MXF files containing the audio 
portion of the input files.

n One MXF is generated per audio channel. If you have 
multichannel audio, then you will get as many audio MXF files 
as you have channels.

Wav file Select the checkbox if you want to generate a WAV file containing the 
audio portion of the input files. The .wav files will be saved in a WAV 
subfolder under the same folder where the MXF files are output.
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Film Type Displays the film type found in the source media. If this metadata is 
not found, then the default is set to 35 mm 4 perfs.

KN Start The key number found in the first file of the group .

If key number metadata was found in the source file, then this field 
cannot be changed. If the key number was not found in the source file, 
you will be able to enter a key number if necessary.

Set Tape Info This option is always selected. Tape information metadata is 
automatically embedded in the MXF.

Tape Name The source tape name. For some file types, this name can be changed 
if necessary.

TC Start The timecode found in the first file of the group. The start timecode 
can be changed if necessary, and the end timecode will automatically 
be adjusted.

TC End The timecode found in the last file of the group.

Burn-in Lets you select metadata for burn-in. If you want to burn-in more than 
one field, see “Burning-in Information on the Frames” on page 151.

Format The format automatically determines the frame rate, frame size, field 
dominance, aspect ratio, and pixel ratio for the media. If frame rate 
metadata was found in the source file, then the choices for the output 
format will be based on this frame rate. If a frame rate was not 
detected in the source media (e.g. for PNG files), then you can choose 
an appropriate format for the output sequence. 

At this time, you can only choose between 720p and 1080p HD 
formats. When Metafuze detects source media with a bit depth higher 
than 8-bit, the Format column will also provide an option for 10-bit.

Compression Lets you set the appropriate compression ratio.

Uncompressed No compression. Capable of handling 8- and 10-bit files.

DNxHD Avid DNxHD is a 8- and 10-bit HD encoding technology that delivers 
mastering-quality HD media with storage bandwidth and capacity 
requirements similar to those of uncompressed standard-definition 
(SD) files. Avid DNxHD operates in a 4:2:2 color space at much 
lower, more efficient data rates. 

The options available here depend on the Format chosen for the MXF 
output file.

Field Name Description
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Details of a stereoscopic group or transcode job...

The following additional options are available when you select groups or transcode jobs that 
have stereoscopic files—see “Transcoding Files for Stereoscopic Editing” on page 149.

Conversion mode Lets you select the aspect ratio that will be used during conversion. 
When converting between film/HD and NTSC formats, you must 
make sure that the aspect ratio is respected. Film/HD uses the aspect 
ratio of 16:9, while NTSC/PAL uses 4:3.

Choose the mode that will be used for final output.

Anamorphic If your images are 16:9, they are stretched vertically to fit into a 4:3 
NTSC frame.

Letterbox Use this option to the preserve aspect ratio when going converting 
from HD to NTSC. If your images are 16:9, they are placed in the 
center of the 4:3 NTSC frame and black bars are added to the top 
and/or bottom of the image. 

Choose the appropriate letterbox option.

Pillars Select this option to preserve the aspect ratio when going from NTSC 
to HD. The 4:3 image is placed in the center of the 16:9 HD frame 
and black bars are added to the left and right sides of the image.

LUT Enter the type of Lookup Table to be associated with these files. 
(Only available for DPX file types.)

Status Indicates if the job has been transcoded or not.

Eye Enter the appropriate text to indicate the left or right eye frames. This 
may be useful as burn-in data to provide visual cues on the footage.

Scene Enter the name for the scene. This may be useful for burn-in.

Comment Enter any comments about the scene or footage. This may be useful 
for burn-in.

Field Name Description

Field Name Description

Stereoscopic Mode Select a mode to combine the left and right eye views into a single 
frame for the transcoding process.

Interlaced Interleaves every alternate line from the left and right eye images into 
a single frame.
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Details of R3D groups or transcode jobs...

The following additional options are available when you select groups or transcode jobs that 
have R3D files.

Create XML Batch Dialog Box

The following table describes the XML batch file options available in the Batch Transcode 
dialog box.

Over/Under Places the left and right eye images one above the other in a 
horizontal split frame.

Side by Side Places the left and right eye images side by side in a vertical split 
frame.

Anaglyphic Each left and right eye image is made up of two color layers which 
are superimposed to create a stereoscopic depth effect that can be 
viewed with two-color 3D glasses.

Field Name Description

Field Name Description

Chroma Select the level to filter the noise of the chroma component.

Debayer Select the amount of detail correction in the debayering process.

OLPF Select the OLPF (Optical Low Pass Filtering) level.

This value can be set before capturing or linking.

ISO Set the sensitivity of film light. The lower the number the lower the 
sensitivity of the film.

Black Level Adjust the black level.

Resolution The resolution quality of the image being extracted by the RED 
parser. 

The higher the resolution, the slower the encoding process.

Import Settings Load an existing RLX file. Use the browse button to find and load the 
file.



9  Avid MetaFuze Reference

178

Burn-in Editor Dialog Box

The following table describes the options available in the Burn-in Editor dialog box.

Field Name Description

Script Name Enter the name for the XML file that is to be created.

Script Output Folder Enter the path where the files will be placed.

XML Schema (*.xsd) Creates a file, called MetafuzeBatchTranscode.xsd, containing 
XML-based schema. 

This file can be used by a third-party tool to validate the format and 
syntax of your .xml batch files when executing the batch transcode 
command.

Field Name Description

Burn-in Preset The name of the file where the settings are stored.

Save button Click this button to create a new preset, or save changes to a selected 
preset.

Delete button Click this button to delete a selected preset.

Import Import a burn-in preset file (.xml).

Export Export a burn-in preset file (.xml).

Data A list of data fields that can be burned-in on your images.

NEW LINE - inserts a line break between data fields.

NEW GROUP - creates a new group of data fields.

Group columns:

Name Name of the selected data field.

 % Y Percentage offset on the Y axis.

 % X Percentage offset on the X axis.

Horizontal Horizontal position of group.

Vertical Vertical position of group.

Font Font type to use for display.
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Transcode Configuration Options

If you have a multiprocessor machine, you can set the number of threads that can be used by 
MetaFuze. 

Increasing the number of processing threads generally provides greater performance, but it 
may decrease the power of other applications that are running simultaneously.

n When transcoding stream files such as AVI, MOV or R3D, the threads will be used to their 
full capacity, therefore you will not be able to use other applications during the transcoding.

Size Font size to use for display.

Separator Symbol to use for separation between data fields.

Luminance Controls the luminance of the burn-in text. The range is between 0 and 
100 where 0 is full black text and 100 is full white text. 
Default setting: 100.

Field Name Description

Field Name Description

Local Number of Threads Set the number of processing threads to be 
used when reading/writing files locally.

Remote Number of Threads Set the number of processing threads to be 
used when reading/writing files remotely.
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Numerics
1080p/23.976 projects

converting NTSC sequence from 24p 45
16:9 format 27
2:3 pulldown

transferring film to video with 31
23.976p projects

converting NTSC sequence to 720p/23.976 46
24-fps film

transferring to NTSC video 31
transferring to PAL video 32

24p and 25p projects
creating 37
displaying media while editing 41
planning 15

24p media
described 15
stored and displayed 41

24p projects
converting NTSC sequence to 1080p/23.976 45

25p media
described 15
stored and displayed 41

2K files, importing 12
3D LUT Generator 136
60 fps

editing 720p project 47
720p/23.976 projects

converting NTSC sequence from 23.976p 46

A
Adding

workspaces 74
AMA

QuickTime 52
Audio

media for shoots 27
timecode for shoots 27
transfer options 32

audio
transfer from film 103

Audio transfer
Info tab 32

Automounting workspaces 76, 76
Avid Unity
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configuring storage in Avid DS 85
sharing bins and projects 67

Avid Unity workspaces 67

B
Best-light transfers

defined 27
Bins

setting Reformat value 47
shared, locking and unlocking 70
shared, performance suggestions 71
sharing on Avid Unity 67

bit depth
for film 92

Burn-in code 27

C
Camera roll keypunch 27
capturing

heads and tails 107
oversized images 96
timecode breaks 109

Cineon files
importing 12

Client Manager
configuring drive letter assignments 77
mounting workspaces 75
unmounting workspaces 75

Clip parameters
RED 56

clips
linked 96

color space
for film and HD projects 91

Configuring drive letters (Client Manager) 77
Copying

RED files 50
Create Workspace dialog box 74
Creating

projects 37
workspaces 74

D
Deinterlacing 41
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Dialog boxes
Create Workspace 74

Displaying 24p and 25p media
during a digital cut 41
while editing 41

DPX files
importing 12
storage 82

Drive filtering
in networked workflows 73

Drive letter assignments
configuring 77

Drives
filtering 73

E
EDL (Edit Decision List)

loading 94
external device

checking status 118

F
Film

project workflow 15, 15
selecting options 37
shoot specifications 27
transferring to NTSC 31
transferring to PAL 32

film
audio transfer 103
bit-depth, setting 92
formats 89
outputting sequence 114
project, creating 89
quality settings 92
storage 65, 79
storage, project considerations 79
working in proxy mode 112

film master 89
film proxy 79
Film speed

slowing to 23.976 fps 31
Film Type for shoots 27
Film Wind for shoots 27
Film-to-tape transfer
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guidelines for 27
options for 27

Filtering drives 73
Format display in the Project window

described 43

G
Guidelines

for film-to-tape transfers 27

H
handles

setting for capture 107
HD media

offline formats for 43
heads

adding preroll and post-roll for capture 107

I
importing

2K files 12
DPX files 12
files by reference 96
images, oversized 96
linked clips 96

K
Keypunch

camera roll 27

L
Letterless drive mapping (Client Manager) 78
linked clips

creating 96
linking QuickTime files through AMA 52
Locking and unlocking

shared bins 70
Logging

automatic, during film transfer 27
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M
Maintaining synchronized sound 32
Modify command

changing sequence format 44
Mounting workspaces 75
MXF (Material Exchange Format) files

sharing files created on Avid DS 63, 119

N
New Project button (Select Project dialog box) 37
NTSC (National Television System Committee) video

transferring 24-fps film to 31
numeric keypad, using during capture 107

O
One-light transfers 27
Opening

shared projects 69
output

checking external device status 118
selecting channels, tracks, and clips 118
to tape, procedure 117

oversized images, importing 96

P
PAL (Phase Alternating Line) video

transferring film to 32
PAL Method 1

described 32
PAL Method 2

described 32
post-roll

recording 107
preroll

insufficient material for capture 109
setting custom (Capture Tool) 105
setting custom (Output Tool) 118

Progressive media
described 15

project
for film 89

Project settings
audio transfer 32
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Project window
Format display, using 43
Info tab, using 32

Projects
24p and 25p 15
changing formats 43
creating new 37
shared, opening 69
sharing on Avid Unity 67

proxy
film 79
real-time 79

proxy mode
for film 112
preferences settings 113

Pulldown
described 31

Q
Quality of film-to-tape transfer 27
QuickTime

AMA 52

R
real-time proxy

resolution 110, 112
setting 113
using 112

RED
clip parameters 56
source settings 56
transcoding clip 62
transferring files 50

Reformat attribute 47
Reformatting

setting Reformat value 47
resolution

proxy 110, 112
real-time proxy 110, 112
setting real-time proxy 113

RGB 4:4:4
color space 91
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S
sequence, outputting film 114
Settings

audio transfer 32
Sixteen by nine (16:9) format 27
Slate information for shoots 27
Slowing film speed 31
Sound roll

cues for shoots 27
Source settings

RED 56
Specifications

for film shoots 27
storage

adding 85
Avid Unity 85
for film 65, 79, 79

Storing 24p and 25p media 41
Sync

methods for shoots 27
Synchronized sound

maintaining 32

T
tails

adding for capture 107
Telecine

transfer quality 27
timecode

breaks, during capture 109
Timed (scene-by-scene) transfers 27
tools

3D LUT Generator 136
Transcode

RED clip 62
Transferring film to tape

aids to 27
in NTSC format 31
in PAL format 32
quality options 27
without sound (PAL) 32

U
UNC paths (Client Manager) 78
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Universal Naming Convention
See UNC paths (Client Manager)

Unmounting workspaces 75

W
Workflows

film source 15, 15
Workspaces

adding 74
Avid Unity 67
creating 74
mounting 75
UNC paths 78
unmounting 75

Workspaces list
letterless drive mapping 78

Workspaces list (Client Manager)
automounting 76
configuring drive letter assignments 77
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